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Copyright Notices

©2004-2009 U.S. Screen Print & Inkjet Technology,  
Tempe, Arizona. All Rights Reserved.

 

No part of this publication may be reproduced mechanically or electronically or in any form without the 
prior written permission of U.S. Screen Print & Inkjet Technology (U.S. Screen). The information in this 
Manual is for informational use only, is subject to change without notice and should not be construed as a 
commitment by U.S. Screen.

U.S. Screen assumes no responsibility or liability for any errors or inaccuracies that may appear in this 
document. T-Jet®, T-Jet® Blazer Express, Fast T-Jet® Blazer Express, Blazer PRO, Fast T-Jet Blazer 
PRO, FastINK™, FastRIP™, FastARTIST™, FastBRIGHT™ and FastFILMS™ are trademarks, 
trade names or registered trademarks of U.S. Screen Print & Inkjet Technology, Tempe, Arizona. 
All trademarks, trade names and copyrights are acknowledged for software and sample shirt images. 
PostScript®, Adobe® Photoshop® and Adobe® Illustrator® are registered trademarks of Adobe Inc. Apple 
and Macintosh are trademarks of Apple Corp. CorelDRAW® is a registered trademark of the Corel 
Corporation. Epson™ is a trademark of Epson Corporation. Windows®, Windows XP, Windows Vista and 
Windows 2000 are trademarks or registered trademarks of Microsoft Corporation.

Federal copyright laws permit you to make a backup of any Software included with your Fast T-Jet Blazer 
Pro for archival purposes only. Any other duplication of this Software, including copies offered through 
sale, loan, rental or gift is a violation of law and subject to both criminal and civil penalties.

We strive to continuously make improvements to our Inkjet-to-Garment printing system and we reserve 
the right to make product changes and improvements. This manual contains the latest and most accurate 
information as of its publication date. Some product photos or descriptions within this Manual may vary 
slightly from the currently shipped machine.

U.S. Screen Print & Inkjet Technology
Home of the U.S. Screen Printing Institute

a division of U. S. Graphic Arts, Inc. 
1901 E. 5th Street 

Tempe, AZ 85281 USA

Printed in the U.S.A.
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A Letter from the 

Developer

Dear Valued Customer,

I want to personally thank you for purchasing a new T-Jet 
Blazer Series Inkjet-to-Garment printer. We have made a major 
investment in hardware and ink development to make inkjet 
printing directly onto a shirt a reality.

With the T-Jet Blazer Series, FastINK and readily available 
software technology, you will be able to print high quality, 
vibrant images on T-Shirts and other garments in a matter 
of minutes. Our T-Jet printers are ushering in a new level of 
sophistication for the garment decorating industry.

I appreciate any comments or feedback you have on our 
machine and hope you enjoy using it as much as I have enjoyed 
developing it!

Best Regards,

Scott Fresener 
CEO
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Basic Safety 
Instructions

Please read this entire Manual before 
attempting to Print.

Follow all warnings on and about the printer.•	

Use the proper power source type indicated on the printer’s label and in •	
this manual.

Connect all equipment to grounded outlets. Use the included surge •	
protector power strip included with each machine. Do NOT plug other 
items into this surge protector. 

Place the printer where the power outlet is easily seen.•	

Do not allow the power cord to be damaged.•	

If you are using an extension cord, ensure the extension cord’s power  •	
ampere rate does not exceed that of the printer’s cord.

Keep electromagnetic devices and other potential sources of magnetic •	
fields away from your printer.

Do not use the printer in locations that have high humidity (40 - 60% •	
humidity recommended), shocks, vibrations, debris or dust.

Leave enough space around the printer for proper ventilation.•	

Do not leave the printer near heat sources such as radiators or heat vents.•	

Do not leave the printer in direct sunlight.•	

Place the printer on a stable surface that extends beyond the length •	
and width of the printer supports. The printer will not work properly if it 
is tilted or leaning.

When packing and moving the printer, do not set the Blazer PRO on its •	
side or 
upside down. This may cause the ink to spill. The Blazer EXPRESS can 
be tilted to fit through small doorways when crated (see page 7).

Turn the printer OFF before cleaning the exterior. Clean with a damp •	
cloth and avoid 
spilling any liquid on the printer. We recommend using brushed aluminum 
wipes and stainless steel cleaner 
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Caution:
Do not unplug the printer to turn it OFF. Use the UI Power Button first, then •	
the main breaker switch on the back. 

Do not unplug the printer until the Main Power Switch has been turned OFF. •	

Do not block any of the printer’s vents or insert foreign object into its slots. •	

Do not attempt to service the printer yourself beyond the troubleshooting •	
techniques covered in this manual.

Keep the machine on a level surface. •	

Safety Instructions for Ink Cartridges:
Always keep ink cartridges out of the reach of children.•	

While handling ink, be careful not to spill it on your skin. If ink does get on •	
your skin, wash thoroughly with soap and water. If ink gets in your eyes, 
flush them immediately with water.

Do not put your hand in the printer or touch the ink cartridges while the •	
printer is in operation (except to fill ink).

If you remove the ink cartridges, make sure to place them in individual •	
bags and keep them away from dust, dirt and debris.

Store unused ink cartridges in a cool dark place.•	

Allow ink cartridges to warm to room temperature before using them after •	
storage.

Do not dismantle the ink cartridge.•	

Do not touch the IC chip on the ink cartridges. This will adversely effect •	
normal printing operations.
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Chapter 1

Introduction

Manual Symbols and Icons
Throughout this Manual you will see four symbols used to notify you of warnings, important facts, 
procedures and tips.

WARNING ICON
Where you see this icon, you should take note of the warnings. Failure to follow any of 
the listed procedures could result in severe damage to your machine, large amounts of 
downtime and/or costly repairs, or the possibility of severe bodily injury or death.  

IMPORTANT POINT ICON
This icon is used to denote important points that may affect the proper operation of your 
machine or the viability of its output. Think of this as more than just a helpful hint.

RECOMMENDATION ICON
This icon indicates recommendations from U.S. Screen based on research and 
development and years of experience within the Garment Decorating business. 
Following these helpful Hints, Tips or Reminders will make printing with your T-Jet 
more enjoyable and rewarding.

VIDEO REFERENCE ICON
You will see this icon throughout the manual indicating that there is a online video on 
the subject. Refer to Chapter 16 - Product Support for instructions on logging on to our 
support site and viewing these very helpful videos provided for your convenience. 

 

About the T-Jet Blazer Series Printers
The T-Jet Blazer Series printers are inkjet printers that have been modified to print on almost any type 
of fabric material as well as non-textiles, such as metal, wood and plastics. The ink, however, will not 
work on waterproof nylon and most synthetic materials. In the past, this type of printing was difficult, if 
not impossible to do because there were no inks available that would work on both 100% cotton or 50/50 
cotton/polyester blends AND withstand the rigors of washing.

That all changed with the introduction of FastINK Textile Ink. Designed specifically for these materials, 
FastINK requires only a post-treatment of heat to cure when printed on lighter shirts. It’s even possible 
to print with White ink on dark shirts with the application of a Pretreatment. This ink is so versatile it 
can even be used for printing on non-textiles by applying Fast T-Jet Non-Textile Pretreatment to the item 
before printing and Fast T-Jet Non-Textile Post-Treatment to the item after printing. 
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The T-Jet is based on standard inkjet technology, with the Epson 4880 being the heart of the system. This 
means you can expect your printer to be reliable AND versatile. The T-Jet Blazer Series printers are also 
fast, printing a standard t-shirt-sized image in under two minutes. Whether it’s a shirt, a towel, mouse 
pads, tote bags, bibs or baseball caps, the possibilities are endless.

WARNING
Read and understand this entire manual before attempting to 
Print on any garment.

The Basics
You probably can’t wait to get started and we share your enthusiasm for the garment decoration process. 
However, before you print that first shirt, there are a few basics that need to be covered.

The T-Jet Blazer Series Printers print best on 100% cotton. Printing on dark-colored 50% cotton/50% 
polyester blends with White ink is NOT recommended because you will notice a discoloration of your 
image. Red garments will turn your Whites Pink and even Yellow shirts will tint your image. Print only 
on pastels or White garments when using White ink and blended fabrics. Images without White will 
not be affected. In addition, when printing on 100% polyester or other synthetic materials, you may not 
achieve the same print brightness.

Your printer is ONLY compatible with Windows XP, 2000 or Vista Operating Systems and the latest 
versions of both FastARTIST and FastRIP are included as part of your kit. FastARTIST is a Windows 
based graphics application that will make preparing an image for print as simple as a click of the mouse. 
With a one-click Underbase Wizard and simple clipping features, FastARTIST can help ease the transition 
into graphics design if you are not familiar with other applications.

For avid users of Photoshop, CorelDRAW, Illustrator etc., you may choose to work within the application 
of choice and still set up the image properly for printing. However, the final design MUST be imported 
into FastARTIST for output if you will be printing with white ink. Only upon importing an image into 
FastARTIST, will you be able to utilize the one-click Underbase Wizard. Even if you are utilizing an eight 
color system with NO White, we recommend you import your image in to FastARTIST for printing to 
ensure optimal results.

Macintosh Users can still create an image in their favorite graphics application; they will just have to 
transfer it to a PC for printing.

Every image MUST print to FastRIP for final output. FastRIP works as the Queue and Print Manager, 
allowing you to not only select different Print Modes and other attributes, but also archive print jobs for 
future reprints. 
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Maintenance
Although the T-Jet is “simply” an inkjet printer, the number one technical issue is a lack of maintenance 
of the machine. There are three main areas of concern:

Printing on t-shirts is not the same as printing on paper. A shirt gives off much more lint which •	
must be cleaned up regularly.

The EPSON print engine was originally designed for use with EPSON ink. Our textile ink has •	
much more pigment and will build up on the components if not maintained daily.

The amount of ink deposited on fabrics is far greater than on paper. This means all ink supply lines •	
must be feeding properly as well as all excess ink must be cleaned up daily to prevent build-up.

When printing on dark shirts, you must apply a Pretreatment. This solution can settle inside the •	
printer and cause numerous problems, therefore we recommend you pretreat shirts as far away 
from the printer as possible (i.e. in another room).

If you adhere to the required maintenance schedule, printing with the T-Jet Blazer Series will be a joy. 
Refer to Chapter 14 - Daily, Weekly and Monthly Maintenance and do not skip a day, week or month.
 

Poor Artwork
With so many graphics programs readily available, everyone is an artist. Poor quality artwork will be one 
of your biggest concerns because there is no magic to transform a low resolution, low quality piece of 
artwork into a great looking print. Therefore, it is important you spend some time learning as much as you 
can about graphic art programs and some of the simple methods that can be used to improve the quality of 
customer supplied artwork.

 

Important Support Information
The T-Jet Blazer Series Printers are sold through a world-wide dealer network and, in some cases, direct 
from U.S. Screen. Support for your printer is provided free of charge.

However, if you purchased your printer from an international dealer outside of the US, you should 
contact your factory trained and certified dealer FIRST. If the dealer is unable to find a solution to your 
problem, please feel free to contact U.S. Screen Technical Support for assistance. Refer to Chapter 17 - 
Product Support for additional support information.

If you purchased your T-Jet from one of our authorized U.S. dealers, you may want to call your dealer for 
initial support, but DO NOT feel you have to go to the dealer first. Our dealers are trained and certified, 
but for the most up-to-date support, contact U.S. Screen Print and Inkjet Technology. 
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U.S. Screen Support Information

Toll Free 			   +1 888-MYTJETS (698-5387)
Technical Support 		  +1 480-929-2937 
Corp. Office	     		  +1 480-929-0640 
Fax	 	     		  +1 480-929-0766 
E-mail: 			   support@usscreen.com
Internet: 			   www.myt-jet.com. Click on the Support tab.

Support hours: 		  7:00am to 6:00pm Monday through Friday  
                			    

All times are Mountain Standard Time USA
Please Note: Arizona does not observe “Daylight Savings Time.”

About the Garment Decorating 
Business and Where to Learn More
You are entering a fantastic business, one where you can make a lot of money in a short period of time. 
But, like any business, there will be ups and downs. You will need to learn about the industry such as 
trade standards, copyright and trademark laws, how to price your work, how to deal with customers and 
much more. Learning the business and marketing side is often harder than the actual printing of shirts.

There are many valuable resources which can help you, including websites, trade magazines, books, 
videos and trade shows. Please visit 
www.screenprinters.net for the latest “How To” training materials.

 

The Book
One of the most valuable books on the industry is How To Print T-Shirts for Fun 
and Profit. Written by Scott and Pat Fresener, it is the “Bible” of the industry. 
Even though this book is geared toward learning the screen printing process, it also 
contains excellent sections on the business aspects of garment decoration, including 
marketing and selling your creations, the law, creating graphics, and best of all, a 
comprehensive Suppliers Directory. This book is revised and updated as of 2008!
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Computer Graphics DVDs
One of the hardest things to learn for the computer 
novice is computer graphics. There are a number 
of excellent DVDs explaining computer graphics 
and how to use Adobe Photoshop , CorelDRAW or 
Adobe Illustrator. These DVDs focus mainly on the 
Screen Printing process, however they also feature 
excellent sections on how to create designs, how to 
deal with poor quality artwork and more. 

Business and Marketing DVD’s
Since the business and marketing side is often complex and sometimes frustrating, there 
is an excellent DVD called Business and Marketing that covers all aspects of running a 
successful garment decorating enterprise. There is also a good set of DVDs on marketing 
and selling, called the Marketing Toolbox.

Internet
The number one website for the industry is www.screenprinters.net. There you will find a wealth of 
articles, industry links, a Buyer’s Guide and open Forums.

 

Trade Shows and Trade Magazines
There are a number of good trade magazines and dozens of trade shows 
around the world for garment decorating. Two of the more popular 
resources for the “When’s” and “Where’s” are the website: 
www.screenprinters.net and the book How To Print T-Shirts for Fun and 
Profit. Both contain numerous trade show listings.
 

 

Our Advice
When starting a business, it is often easy to think nothing will go wrong. You need to be positive about 
your venture, but in the beginning, expect the worse. If you take orders for printed shirts before you have 
even received your machine, you might find that deadlines are hard to meet because of the learning curve 
and unexpected problems.

The garment business is one of deadlines. Deadlines may include such things as time-sensitive event 
shirts or for special occasions as well as artwork with “dates” on them. You must always give yourself 
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room for error. Shirt suppliers might not ship on time. You might not have checked your ink inventory 
and end up running out of a color. And, yes, you will ruin a few shirts! Accept this as a fact of life in the 
garment decorating industry. To have the most success, allow extra time to fill orders and don’t make 
commitments that might be hard to keep.

There is nothing more rewarding than seeing someone wearing one of your creations, but nothing 
more disturbing than working all night to meet a deadline. Anyone who has been in this industry has 
experienced the joy and sorrow of both. Plan ahead and always have a cushion to make sure you meet 
deadlines.
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Chapter 2

SETUP PART 1:  Unpacking 
and Setup of Your Printer

Save the Crate and All Packing 
Materials
Failure to follow this step will VOID YOUR WARRANTY.
Your printer is a very large piece of equipment and it is shipped in a sturdy crate with bracing to hold 
delicate components in place. Unpack your printer with care and please retain all shipping materials, bags, 
boxes and directions received with the printer. These items will be needed for any future transportation of 
the printer. If you need to return or ship a T-Jet without using the original shipping carton/crate, you may 
void the warranty. The crate may be disassembled for storage.
 

Blazer Express SETUP
FOR INFORMATION ON THE BLAZER PRO, SEE THE BLAZER 
PRO SECTION LATER IN THIS CHAPTER. 

Removing from the Crate
The T-Jet Blazer Express is shipped fully assembled in one 
large crate. You should have received and signed a Pre-
Installation Checklist prior to the arrival of your printer. This 
Checklist outlined the importance of room conditions and 
other details necessary for your machine to maintain optimal 
performance levels.

You MUST be very careful transporting your new printer. It 
is very heavy and a delicate piece of equipment. DO NOT 
remove your printer from the crate until it has reached its 
final destination. The exterior crate dimensions are 55” x 42” 
x 33”. This means the unit will need to be tipped 90o and placed on a dolly or rolling cart in order to pass 
through standard 36” doorways. As shipped, the packing material will allow for this and prevent damage 
to your printer as long as the crate is not dropped.

IMPORTANT NOTE: 
The T-Jet Blazer Express and shipping crate, combined, weigh close to 300 pounds. 
Because of the bulk of the machine, this is a MINIMUM TWO PERSON lift. In 
addition, DO NOT attempt to lift the machine from the crate with less than two 
people. Position one person at each end of the Printer Assembly and ensure any 
lifting is done using the four handles.
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Placement of the Blazer Express
When determining where to set up your printer, keep in mind the T-Jet Blazer Express requires an area of 
at least 3.5 ft x 5.25 ft (1 m x 1.6 m) for the printer and workspace around it. Additional space is required 
for drying, pretreating garments, garment staging, etc.

The Blazer Express’ final destination MUST 
BE A STURDY TABLE OR OTHER 
PLATFORM. For operator comfort, we 
recommend the height of the platform be at least 
30”. This table must be able to support the full 
weight of your printer (200 lb. / 91 kg) as well 
as all accessories, such as a Shirt Board, inks 
and garments. The table MUST also be able to 
incorporate the entire “footprint” of the machine 
across its surface. NO PART of the T-Jet Blazer 
EXPRESS should overhang an edge.
 

The table or platform must also provide a stable base which will not transmit vibrations from surrounding 
equipment and which will not be subject to vibrations from movement of the printer during image output. 
Failure to minimize these vibrations will seriously affect final print quality.

A simple and effective solution would be to use the crate in which the Blazer Express was shipped to you. 
Perhaps even drape a table cloth or other material over it to help catch spills. If you don’t wish to use the 
shipping crate, McMaster-Carr Inc. specializes in heavy-duty stands. www.mcmaster.com.

Leveling the Base of the Printer
Your new printer will operate at its best if it sits in a level position. 
Set a box level on the top of the print bed. If the machine is not level, 
determine which side of the printer you will need to adjust. If the 
printer is level, make sure that all of the feet are sitting firmly on the 
table.

To adjust the feet at the base of the printer, using a wrench, loosen 
the lock nut (closest to the top). Next, loosen or tighten the nut below 
(connected to the foot).

Repeat process as necessary until the Blazer EXPRESS sits level and 
sturdy on the table surface.

Tighten the lock nuts on all of the base feet. 

 



Chapter 2 - SETUP PART 1:  Unpacking and Setup of Your Printer 

9
Version 5.5  Revised January, 2009

Placement of the Shirt Board
When placing your Shirt Board within the Pint Bed, take care to align the item carefully. Failure to seat 
the Shirt Board completely in the four Guide Pins can result in an unsteady print surface and errors in 
your output. 

For reference, the Blazer Express standard-sized 
Shirt Board should be placed in the Landscape orientation when 
facing the front of the machine..

 
 

The oversized Shirt Board is to be mounted in the 
Portrait orientation.

Both Shirt Boards have Yellow and Black “This Side Out” 
stickers to assist you with placement. Before operating the 
printer, ensure these labels can be viewed from the Load 
position.
 

Blazer PRO SETUP
FOR INFORMATION ON THE BLAZER EXPRESS, SEE THE 
BLAZER EXPRESS SECTION EARLIER IN THIS CHAPTER.

Unpacking the T-Jet Blazer PRO
The Blazer Pro is shipped fully assembled in one large crate. 
The only additional item you will need to install is the User 
Interface (UI). 

You should have received and signed a Pre-Installation 
Checklist prior to the arrival of your printer. This Checklist 
outlined the importance of room conditions, uncrating and 
assembly and all the other details necessary for your machine 
to maintain optimal performance levels. 

Moving the Blazer PRO
IMPORTANT NOTE: 
The printer and base weigh over 400 pounds. Because of 
the bulk of the machine, this is a FOUR PERSON lift. 
DO NOT attempt to lift the machine from the crate with 
less than four people. Position one person at each of the 
four corners of the machine and make sure that lifting is 
done from the base as identified on the right.

Landscape Portrait

Lift all four 
corners evenly 
from this point
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Casters have been built into the cabinet base, allowing for easy movement to a suitable location within 
your shop. When determining where to set up your printer, keep in mind the T-Jet Blazer Pro requires an 
area of at least 12 ft x 10 ft (3.65 m x 3 m) for the printer and workspace around it. Additional space is 
required for drying, pretreating garments, garment staging, etc.

Note: Remove any obstacles. All doorways and corridors the printer will travel through must be at least 
36 inches (92 cm) wide.
  

Setting the Ground Supports
When the Blazer Pro reaches its final 
destination, manually lower the ground 
supports on all four corners. Using a box 
level (found at any hardware store), check 
the Print Bed to ensure it and the machine 
are level. Each ground support is threaded 
and can be raised or lowered to make any 
needed height adjustments. Once you have 
leveled the machine, tighten each locking 
nut against the bottom of the cabinet base.
 
 
 

Installing the User Interface 
The User Interface (UI) controls basic printer operation and is 
touch sensitive. To install the UI you will need a 5mm Allen 
wrench

1.	 Unpack the User Interface and locate the (2) 5mm hex screws 
for installation.

Position the extension 2.	
bracket along the back of the 
machine as shown. Using 
the Allen wrench, secure 
the extension bracket to the 
printer base. 

3.	 Connect the UI Serial Port Cable to the cabinet 
base. It is located just to the right of the USB port.

Ground Support

Locking Nut
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Placement of the Shirt Boards
The Blazer Pro comes with 3 standard-sized and 2 over-sized 
Shirt Boards. Each Shirt Board is designed to fit on 4 metal 
pegs.  Line two up on one side and then bring the Shirt 
Board down slowly to line the other side up with the pegs.

Refer to Chapter 8 - SETUP PART 6: 
Initialization Utilities for instructions on 
Leveling the Shirt Boards.

 
 

Environmental Controls and Humidity
The following sections refer to both the Blazer PRO and EXPRESS

Your printer should not be exposed to direct sunlight, direct airflow, dusty areas, strong magnetic forces 
or excessively high humidity. The machine does not like to be too dry or too moist with a level of 40% 
to 60% relative humidity being ideal. Since you will be handling wet ink to refill the Bulk System ink 
bottles, you should also protect any carpet or floor covering with mats. 

Like any Hi-Tech electronic device, your inkjet printer does NOT like being in a hot or cold shop or 
a garage without proper air-conditioning controls. If left unattended for days or weeks in a hot dry 
environment, the Print Head WILL clog. Consult Chapter 10 for instructions on installing refillable 
cleaning cartridges if you anticipate not using your machine for an extended period.

For convenience and efficiency, place your printer close to the Heat Press or Dryer you will be using to 
cure the ink. If you have two or three printers set up as a production work station, arrange them around or 
near the heat source.

At night, and when the printer is not in use, cover the machine to protect it 
from airborne dust and debris.
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IMPORTANT POINT
When using White ink, you must apply a 
Pretreatment to the shirts before printing. We 
recommend an affordable sprayer such as a Wagner 
(available at most hardware stores). 

 
DO NOT spray this Pretreatment near your printer. Pretreat shirts 
in a different room if possible, but at a minimum make a cardboard 
enclosure for use during applications. The Pretreatment is sticky 
and can ruin the Print Head as well as damage the Encoder Strip. 
The Encoder Strip is a thin piece of clear plastic with data that is 
read by the Print Head as the unit operates. The Encoder Strip tells 
the Print Head exactly where to print an image. If the Encoder Strip 
becomes dirty or damaged, the printer will get confused, resulting in 
the printing of multiple images, strips of solid ink and other irregular 
printing patterns.

NOTE: If you own a AutoTREAT, pretreating in the same room is possible.

Final Unpacking Instructions
DO NOT try to move the Print Carriage off of the Capping Station. The T-Jet Blazer PRO and Express 
both lock the Print Carriage onto the Capping Station for safe shipping. Forcing the Print Carriage to 
move will damage your printer.

Note: You may find a small amount of ink on the Waste Pad and/or Capping Station during setup. This is 
normal and there is no need to be alarmed. Each printer is run through a series of test print cycles before 
shipping to ensure it is operating properly.

Lift the top cover and release the Green shipping tab lock located at the 
base of the Print Carriage (on the right end of the printer).

NOTE: If transporting the printer, re-lock the green shipping tab.
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Chapter 3

SETUP PART 2: 
The Bulk Ink System 

The T-Jet Blazer printers use a specially designed Bulk Ink System with cartridges that hold about 200 ml 
of ink per color (x8) and allow for easy re-filling as needed. In order to prevent damage or ink leakage, 
your printer was not shipped with the Bulk System installed. To prevent components from drying out, it is 
shipped with cleaning cartridges. You will need to remove these prior to use because these cartridges do 
NOT contain textile ink.

To remove the cleaning cartridges, locate the 
blue levers to the right side of each bank of 
four. Moving these levers to the UP position 
will release the cartridges. With the lever in the 
DOWN position, cartridges will be locked in 
place.

Move both levers to the UP position and remove 
the cleaning cartridges. Store them in a cool, dark 
environment for future use.

Filling the Bulk Ink Cartridges
During initial setup, and whenever your ink cartridges begin to run low, you will have to fill them 
manually. Choose an area where spills will not do much damage and protect the area with newspaper, 
paper towels or a drop cloth. It is recommended that you also wear disposable gloves.

Your printer comes with 8 oz. (250 ml) bottles of Cyan, Magenta, 
Yellow and Black FastINK3, along with 1 liter of FastINK White. 
You will also find 8 continuous flow ink cartridges and 8 funnels. 
One cartridge will be used for each of the  4 colors and 4 cartridges 
will be dedicated for White.

1.	 Fill a cartridge with ink. 
NOTE: We recommend starting with the lightest color and 
ending with the darkest. For this example we will start with 
yellow. To fill a cartridge, refer to the color coding on the 
cartridge for the correct ink to add.

Remove the cap and place the funnel into the top opening. •	
When pouring the ink, lift the funnel out of the hole slightly, 
to allow air to escape and facilitate a smooth flow. 
 

The Bulk System that shipped with your printer may or may not look 
like the one shown here.
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DO NOT overfill the cartridge. There are hash marks on the front of each cartridge denoting 
increments of 50 ml, with the top mark referencing 200 ml. DO NOT add ink beyond this 
mark. As a guide, stickers have been affixed to the front of each Ink Cartridge indicating the 
RECOMMENDED ink levels of between 50 and 150 ml. Top off the ink at the start of every shift 
to keep it as close to the “full” level as possible. 

2.	 Prime the cartridge. 
The Blazer Series printers include a priming pump which will prime 
the ink from the Bulk Ink System container into the cartridge. There is 
a knob on the top that operates the pressure. It is not necessary to 
adjust this knob. The process of priming the cartridges will save a lot 
of ink by reducing the number of Power Cleaning Cycles needed in 
Chapter 8.

•	 Connect the priming pump to the hole in 
the bottom of the cartridge.

Secure the hose to the cartridge by •	
pressing in with your thumb. 

•	 With your other hand, pump the handle until 
ink comes through the line and into the 
reservoir.

Disconnect the pump from the cartridge and •	
pour the ink collected in the pump reservoir 
back into the corresponding Bulk Ink System 
container.

Prepare a glass of warm water. Rinse the •	
pump and reservoir. Pull back the spring 
lock to open the hose and immerse into the 
water. Pump using other hand until water has 
reached the reservoir. Repeat using fresh water until clean. Note: The darker the ink color is, the 
more you may have to rinse.

Re-seat the blue cap in the opening of the newly filled and primed cartridge. Do not tighten •	
completely. Tightening the cap could cause starvation of the ink to the head if the breather caps 
should become clogged. 

Repeat for remaining colors. 3.	
Repeat steps 1 and 2 for each color until all eight Bulk Ink Cartridges have been filled and primed.

Insert the cartridges into the printer.4.	  
There is a blue lever for each set of cartridges. Raise the levers and remove the cleaning cartridges 
(save these for later use). The slots and cartridges are numbered from 1-8. Using these numbers as 
a guide, place the Bulk Ink cartridges into your printer and lower both blue levers to secure them in 
place. The colors CMYK will be placed in slots 1-4, and FastINK Bright White in slots 5-8.
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Ink Care
Keep ink tightly capped in a 50-100°F (19-38° C) area.  FOR BEST RESULTS, SHAKE THE WHITE 
INK BOTTLE(S) STORED ON THE SHELF, WEEKLY FOR ABOUT A MINUTE TO PREVENT 
SETTLING. We recommend at least agitating the colors periodically. The white ink bulk ink bottles 
on the printer will also need to be, at least, gently agitated on a regular basis. Refer to Chapter 12 - 
Advanced Printing with White for more information on white ink care.

If ink settles in the ink system or in the ink lines, slightly agitate and Perform a Head Cleaning cycle one 
to two times per day.  If the printer is not in use for an extended period of time, additional head cleanings 
will be required and possibly a Power Cleaning. For preparing you printer for downtime, refer to Chapter 
15 - Tips and Utilities to Maximize Pint Quality.

See the video online on ink care. Refer to Chapter 17 - Product Support for information on 
how to log on to our support site to view online videos. 

Changing Ink Brands
Your T-Jet Blazer Series printer ships with FastINK 3 and Bright White Textile 
Ink. With a normal inkjet printer, it is a very common practice to change from the 
manufacturer’s brand of ink to third party inks. However, this can result in serious issues 
when using specially formulated textile inks. All textile inks are NOT created equal and 
they must not be mixed. Should you decide to try another brand of textile ink in your 
printer, before doing so you MUST flush out the entire Bulk Ink System using a special 
flushing solution available from U.S. Screen.

Failure to perform this process can result in a mixture of the two brands, creating a chunky mess that 
might be called severe “cholesterol” in the ink tubes. In fact, this mixture will permanently clog the Print 
Head. U.S. Screen is not responsible for any damage to your printer or replacement of the Print Head 
should you use another manufacturer’s ink. If you do experience problems with another manufacturer’s 
ink you must contact THAT manufacturer for any available remedies. 

 

Resetting the Bulk Ink Cartridges
Your Bulk Ink System Cartridges have smart chips built-in that are designed to count the number of 
ink drops dispensed. After a certain amount of ink has been used, a typical inkjet cartridge chip tells 
the printer it is out of ink. However, the system is inefficient when used for a continuous-flow Bulk Ink 
System.

We have equipped each cartridge with a new smart chip, but if you print continuously for a long period 
of time, the chip may still believe the cartridge is low on ink when in reality it is not. ALWAYS KEEP 
INK IN THE CARTRIDGES. IF THE INK GETS TOO LOW, INK STARVATION WILL OCCUR! If the 
printer warns that the cartridge(s) is low on ink, remove the cartridge that is indicating Low Ink and use 
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the Reset Module to change its status. The module’s Red light will blink while it resets the chip. The Red 
light will transition to a SOLID Green when the reset is complete. 

The process of resetting the smart chip is demonstrated in the following three images.

The light on the chip resetter will be solid green when reset is complete.

There are currently 2 types of chip resetters. The second resetter is white and is used the same way as the 
blue. The only difference is the light on the white resetter will blink red while resetting and will shut off 
when complete.

 

NOTE: Resetting your Waste Ink Tank is done the same way. Refer to Chapter 13 - Daily, Weekly and 
Monthly Maintenance for instructions on removing the Waste Ink Tank. 
 
 
 

Non-Genuine Epson Cartridge Message
You may get a message reading “Non-Genuine Epson Cartridge” 
on the LCD display panel. This message means that the printer 
thinks the ink cartridge is empty and needs to be replaced. To 
clear this message refer to Chapter 16 - Troubleshooting.

NON-GENUINE EPSON CARTRIDGE
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Chapter 4

SETUP PART 3: Interacting 
with the Blazer Express

The following steps will cover everything from plugging your new printer in and powering it on to 
connecting it to your computer as well as learning the LCD buttons and User Interface screens. Refer to 
Chapter 5 - SETUP PART 3: Interacting with the Blazer PRO for interacting with the Blazer Pro.
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Overview of Printer Connections 

 
 
Plugging the Unit into AC Power
Plug the printer into its own power source. The T-Jet Blazer Express has a dual voltage power converter 
built in, allowing it to work with 50 or 60 cycle current ranging from 110 volts to 220 volts. 

Insert the AC cord into the unit and plug the opposite end into a power strip with surge protection. Avoid 
plugging multiple items into the same power strip.

For more reliable results, plug the unit into a UPS (Uninterrupted Power Supply) to help prevent ruined 
shirts during power fluctuations. DO NOT plug other high power use items, such as a Heat Press, into the 
same circuit. 

 
 

Powering the Blazer EXPRESS ON and 
OFF 
Always Power On and Off as stated below. Your printer requires a proper startup and shutdown cycle that 
may only run if the following steps are followed correctly. 

Powering On
Power On the Main Switch1.	  
When turning ON your printer, you must first turn on 
the Main Power Switch on the rear of the printer, located 
adjacent the AC cord. Move to the up position. 
 
 

Main Power Switch

Power Switch

AC Power Cord Plug-In

USB Connection

ON

OFF
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2.	 Power On the User Interface 
On the User Interface, wait until the virtual LED labeled 
“Automatic Mode” becomes Red (five seconds) and press 
the Orange Power On button.

The Blazer Express will go through a startup cycle that takes 
a few minutes. 
 
When complete, the printer will be the print status Paper Out 
ROLL/CUT mode, viewable on the LCD Display panel.
 
 

Powering Off
Power Off the User Interface 1.	
Press the Red button on the User Interface

Power Off the Main Power Switch 2.	
Move the main power switch on the back of the printer (located adjacent the AC cord) to the down 
position.

When turning OFF the T-Jet Blazer Express, you must press the Red Power Off button on the User 
Interface before turning OFF the Main Power Switch on the rear of the printer.
 
 

Connecting Your Printer to a Computer
You may only connect the printer to a computer with a USB 2.0 
cable. For best results, use the special gold tipped USB cable 
supplied with the machine. Avoid using a cable that is over 6ft in 
length and do not use a switch box or USB Hub. Failure to follow 
the guidelines can cause communication problems between the 
printer and your PC. Do not overload your USB  ports. Reserve 
one for the printer, one for the dongle (FastARTIST/FastRIP) and 
one for your mouse (if necessary).
 

Your computer must use a Windows Operating System, such as Windows XP or Vista (Windows ME is 
not supported). Your computer must have at least 1GB of RAM (2 GB if using Vista) or you wmay run 
into problems sending jobs. For best results, use a computer with 3 GB of RAM. RAM is inexpensive and 
if you can put more in your computer, it will prevent problems when printing large files.

The virtual LED turns Red after 5 seconds 
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The Universal Serial Bus (USB)  method of communication 
is standard on all newer computers, but a little known fact is that only a 
certain amount of power is supplied to the entire “bus.” If you have several 
items (other than a mouse and the FastARTIST Dongle) plugged into 
different USB ports on your computer, this may cause communication 
issues with the printer.

We recommend using a dedicated computer to control 
your T-Jet Blazer Express. Avoid using extra USB ports for items such as a 
webcam, joystick, additional printer etc.
 

IMPORTANT POINT
Failure to follow the recommended environmental, power, maintenance and 
operating conditions can void your warranty. The T-Jet Blazer Express or PRO 
do NOT like to be in a hot, dry shop with excess dust or being plugged into outlets 
with several other items. Please read and understand the operating conditions and 
maintenance requirements for your investment.
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Chapter 5

SETUP PART 3: Interacting 
with the Blazer PRO

The following steps will cover everything from plugging your new printer in and powering it on to 
connecting it to your computer as well as learning the LCD buttons and User Interface screens. Refer to 
Chapter 4 - Interacting with your Blazer EXPRESS for interacting with the Blazer Express.
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Overview of Printer Connections

Plugging the Unit into AC Power
Plug the printer into its own power source. The T-Jet Blazer Pro has a dual voltage power converter built 
in, allowing it to work with 50 or 60 cycle current, ranging from 110 volts to 220 volts.

Insert the AC cord into the back of the printer (see above photo) and plug the opposite end into a power 
strip with surge protection. Avoid plugging multiple items into the same power strip.

For more reliable results, plug the printer into a UPS (Uninterrupted Power Supply) to help prevent power 
fluctuations while printing. DO NOT plug other high power use items, such as a Heat Press, into the same 
circuit. 

 
 
 
 

Circuit Breaker/
Power Switch

AC Power Cord USB Cable 
Connection

Printer Bed 
Power Cord
DO NOT 
UNPLUG!!!

UI Serial Port 
Connection

ON

OFF
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Powering the Blazer PRO ON and OFF 
Always Power On and Off as stated below. Your printer requires a proper startup and shutdown cycle that 
may only run if the following steps are followed correctly.

Powering On
Power On the Main Power Switch1.	  
Place the Main Power Switch (located adjacent the AC cord) to 
the up position.

2.	 Power On the User Interface 
Five seconds after the main power is turned on, on the 
virtual LED on the User Interface, labeled “Automatic 
Mode” becomes Red. When it becomes Red, it means 
that it is ready to be powered up. 
 
 
Always wait for the virtual dial to become Red, then 
press the Orange Power On button on the User 
Interface.

The Blazer PRO will go through a normal startup cycle that 
will take a few minutes. When the printer has finished starting 
up, it will be in Print status or Paper Out ROLL/Cut Mode on 
the LCD Display. Do not attempt any further procedures until 
the startup cycle is complete.

Powering Off
Power Off the User Interface1.	  
Press the Power Off button (Red) on the User Interface.

Power Off the Main Power Switch2.	  
Place the Main Power Switch (located adjacent the AC cord) to the down position.

When powering OFF, your printer goes through a shut down cycle that seats the head onto the Capping 
Station to help prevent Print Head clogs. DO NOT turn off the unit at the power strip. It WILL NOT go 
through a normal shut down. 

Main Power Switch

The virtual LED turns red after 5 seconds 
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Connecting Your Printer to a Computer
You may only connect the T-Jet Blazer Pro to a computer 
with an available USB 2.0 input. For best results, use the 
special gold tipped USB cable supplied with the machine. 
Avoid using a cable that is over 6ft in length and do not use 
a switch box or USB Hub. Failure to follow these guidelines 
can cause communication problems between the printer and 
your computer.

Do not overload your USB  ports. Reserve one for the 
printer, one for the dongle (FastARTIST/FastRIP) and one 
for your mouse (if necessary).

Your computer must use a Windows Operating System, such as Windows XP or Vista (Windows ME 
is not supported). For best results you should use a computer with at least 2GB of RAM. RAM is 
inexpensive and if you can put more in your computer, it will prevent problems when printing large files.

The Universal Serial Bus – USB – method of communication is standard on 
all newer computers, but a little known fact is that there is only a certain 
amount of power supplied to the entire “bus.” If you have several items 
(other than a mouse and the FastARTIST Dongle) plugged into different 
USB ports on your computer, this may cause communication issues with the 
printer.

We recommend using a dedicated computer to control your T-Jet Blazer Pro. Avoid 
using extra USB ports for items such as a webcam, joystick, other printers etc.

IMPORTANT POINT 
Failure to follow the recommended environmental, power, maintenance and 
operating conditions can void your warranty. The T-Jet Blazer Pro does NOT like 
to be in hot and dry areas with excess dust nor being plugged into outlets with 
several other items. Please read and understand the operating conditions and 
maintenance requirements for your investment.
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Chapter 6

SETUP PART 4: 
Printer Driver Installation

Epson Printer Driver Installation
A Printer Driver is software needed to make any printer function. For the T-Jet Blazer Express and PRO 
to operate properly, you will need to install the latest Epson printer driver(s). We have included these on 
the FastARTIST 2.0 (or previous) compact disc included with your FastARTIST package. You can also 
download these and the most current versions for the Epson Stylus Pro 4880 available at www.epson.com. 
Follow the links under the Drivers & Support section and you will be able to select a driver compatible 
with your Operating System.

NOTICE: 
Windows Vista Users must have Administrator authority to download and install 
any drivers. Additionally, you MUST download the applicable 32 bit OR 64 bit 
driver based on your Operating System, NOT your processor. These drivers are 
NOT interchangeable.
 

Determining the Correct Printer Driver to Install
Some older models of the T-Jet Blazer PRO and EXPRESS may be equipped with the Epson 4800 print 
engine and some with the 4880. Use the table below to determine the correct model for download.

If your Serial Number contains the following as the 4th and 5th digits (PRO) or 5th and 6th
(EXPRESS) after TJB or TJBE, then download the latest driver for your particular model.
BO Download the Epson 4800 Stylus Pro Printer Driver
BX Download the Epson 4800 Stylus Pro Printer Driver
B8 Download the Epson 4880 Stylus Pro Printer Driver
BY Download the Epson 4880 Stylus Pro Printer Driver

 

Printer Driver Installation Steps
The installation process is done the same way, wether you are downloading from Epson.com or installing 
from the included disc. 

1.	 Like any inkjet printer driver installation, you first need to extract the file. Double 
click on the zipped exe file. 
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2.	 A security warning screen will open. Press Run.   
 
 
 
 
 

3.	 Click OK for the 
Self Extractor 
Window 
 
 

4.	 Another Self Extractor Window opens. Where field named, 
“Unzip to Folder” should default to your “C” drive or Local 
disk and unzip in a folder named Epson. Do not change 
anything here unless it defaults to a different location. If it 
reads a different location, press browse and make a folder 
named “Epson” on your local disk. 
 
Click Unzip. 
 

5.	 This window confirms that the files 
were unzipped successfully. 
 
Click OK 
 
 
 
 
 

6.	 When the Epson Printer Utility Setup window 
opens, click OK. 
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7.	 Click Accept to accept the License Agreement. 
 
 
 
 
 
 

8.	 The Utility Setup will begin 
and will start copying  the 
necessary files. 
 
 
 
 
 
 

9.	 A Software Installation warning screen will appear. 
Click Continue Anyway. 
 
 
 
 
 

10.	 The last screen is a screen that will auto-detect your printer. 
Make sure that your T-Jet is connected to the printer using 
the USB cord.

Power on the printer and the Epson Printer Utility will •	
auto detect it and finalize the installation process.

Click the start menu, then click Settings>Printers and •	
Faxes. From here you can manage your printers etc.

The T-Jet Blazer Series are highly modified versions of the Epson 4880 with hundreds of additional parts 
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not provided by Epson. As a result, your T-Jet and any driver software is NOT supported by Epson. All 
support for the Epson driver and internal Epson components will come from U.S. Screen Print & Inkjet 
Technology.

If you have any concerns installing the driver, contact our Support Department and they will gladly walk 
you through the process.
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Chapter 7

SETUP PART 5: 
Learning the LCD and 

User Interface Controls
Whether it’s a Head Cleaning, Nozzle Check, Head Alignment or other maintenance, all Utilities can 
be accessed through the LCD Display Control Panel, located above the white ink cartridges. The LCD 
Display Control Panel is also used to pause and reset print jobs. 

About the LCD Display
Many of the different T-Jet Blazer Series 
Printer Modes (not to be confused with 
Print Modes which are applicable only to 
image output) are commonly referred to 
by the Icons and Phrases that appear in 
the LCD Display. Because of the complex 
nature of the Epson 4880, there are many 
different Modes and Functions available, 
therefore the following list is not all-
inclusive. However, it does detail the major 
items you may encounter in daily operation 
and those which are applicable to Inkjet-to-
Garment printing. For a comprehensive list of all Epson 4880 Functions and Modes, consult the Epson 
User’s Manual that has been included as part of your printer kit.)
 

The LCD Display Buttons
Your LCD display button layout may look different than the image below, but the button layout will apply 
to all versions of the Blazer Express and PRO. 

Service Only Button
This button should not be used unless instructed by one of our technical support representatives. The 
default setting is set to the off (out) position and needs to remain that way.

Blazer Express LCD Display and buttons
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Pause Button
Pressing the Pause Button will pause a print job while printing. Holding down the Pause Button for 3 
seconds will cancel a print job.

Left/Paper Button
This button is used to navigate throughout the LCD screens. It is also used to adjust the “paper” 
setting of the printer.

Down Button
This button is used to navigate through the LCD screens.

Up Button
This button is used to navigate through the LCD screens.

Right/ Clean Button
This button is used to navigate through the LCD screens. It is also used to perform a Head Cleaning 
Utility by holding down for 3 seconds; see Chapter 8 - SETUP PART 6 - Initialization Utilities.

The LCD Display Icons
As mentioned earlier, the icons  listed below will mean a different printer function and will be covered in 
detail in another chapter.

Sheet Icon
The Sheet icon is referred to as Sheet Mode preceded by any phrase above it such as 
“Ready/Sheet” mode or “Paper Out /Sheet” mode.

	
Roll Icon
The Roll icon is referred to as Roll Mode preceded by any phrase above it such as 
“Ready/Roll” mode or “Paper Out /Roll” mode.

Roll Scissors Icon
The Roll & Scissors icon is referred to as Roll Cut Mode preceded by any phrase above 
it such as “Ready/Roll Cut” mode or “Paper Out /Roll Cut” mode.

WARNING
DO NOT press or attempt to use any button on the Epson LCD Display not 
covered in this Manual. Failure to follow this guideline can result in extended 
downtime, ruined output and/or damage to your printer that is not covered 
by warranty. If you note erratic machine behavior when attempting to print, 
immediately shut down the printer and contact Technical Support.
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About the User Interface Buttons
The T-Jet Blazer EXPRESS and the PRO both feature a User Interface (also referred to as HMI). The 
User Interface (UI) allows power and control of the printer assembly and has 3 main buttons (not counting 
the touch screen display).

Power Off Button
This button is used to shutdown the 
printer assembly during a normal 
shutdown cycle. For the Blazer PRO 

model is also used as an emergency shutdown. 
The Blazer EXPRESS has an emergency 
shutdown located on the front left side of the 
machine.

Power On Button 
This button is used to power on the 
Printer Assembly after the main 
power has been turned on.

Send Print Button
The green “send print” button(s) are used to send a print job. The PRO model has 2 while the 
EXPRESS model only has one. Press and hold the send print button(s) for a few seconds to send 
the print.

 

User Interface Touch Screens
The User Interface also adds convenience and function, allowing you to perform several operations from 
its touch screens rather than the LCD Control Panel. Each screen is touch sensitive, allowing you to 
navigate between screens or change screen settings with a touch of a finger. The opening screen is referred 
to as the Home Screen. Press the screen to begin navigation. Navigate by using the Left and Right arrows. 
Throughout the navigation process, return to the home screen by pressing the Home icon. 

The Mode Select Screen
The Mode Select Screen allows the selection of two modes 
using the selection dial. The mode select screen also 
allows the selection of the amount of print passes desired.
 
Manual Mode: Using the selection dial to select Manual 
will allow you to perform Maintenance Utilities and 
control finite movements of the printer.

Auto Mode: Using the selection dial to select Auto 
will change tht mode to Auto Mode (or printing mode) 
allowing you to print and select print passes. If printing, 
you must be in Auto Mode.
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Pass Select: Press the number of desired passes in the Pass Select area of the Mode Select screen. this 
will only work when in Auto Mode. 

Pad Enabled Icon: The Pad Enabled icon will appear on all of the User Interface screens and represents 
the mode that the Mode Select screen is set to. If the Pad Enabled is lit in red, the User Interface is in 
Auto Mode and if not lit, is in Manual Mode. 

IMPORTANT POINT
You MUST be in Manual mode to utilize any functions on the UI or perform any 
Maintenance Utilities such as Head Cleanings, Head Alignments, etc. To Print, you 
MUST be in Auto mode. 
 

 
 
The Manual Mechanism Movement Utility (MMMU) Screen
The MMMU Screen controls the movements of the Blazer EXPRESS Print Bed and The Blazer PRO 
Printer Assembly, prior to and after completion of a printing job. The MMMU Screen controls the 
movement of the Printer Assembly prior to and after completion of a printing job. These movement 
functions are also used when performing certain maintenance utilities. The Assembly has three preset 
positions and these are listed under the heading “Position”: Home, Nest and Index. Since the two Blazer 
models work a bit different, some of the following sections 
have been separated by model to prevent confusion.

Home Button: BLAZER EXPRESS
Pressing and holding the Home Button for 2 seconds will eject 
the Print Bed all the way to the front of the printer. From this 
position you may load or remove garments. 

Home Button: BLAZER PRO
Pressing and holding the Home Button for 2 seconds will send 
the Printer Assembly all the way to the back of the printer. 
From this position you may load or remove garments by pulling the platen handle out.

Index Button: BLAZER EXPRESS 
Pressing and holding the Index Button for 2 seconds will move the Print Bed to the rear of the printer. 
When in this position, you may perform various maintenance functions such as Nozzle Checks, Head 
Alignments, etc. 

Index Button: BLAZER PRO 
Pressing and holding the Index Button for 2 seconds will move the Printer Assembly towards the center 
of the Print Bed. When in this position, you may perform various maintenance functions such as Nozzle 
Checks, Head Alignments, etc.

Nest Button: Pressing and holding the Nest Button for 2 seconds will move the Printer Assembly 
(PRO) or Print Bed (EXPRESS) forward or backward and align it with the front sensor. No printing or 
maintenance functions should be performed from this position. This is ONLY to check the functionality of 
the sensor.
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JOG - For and Rev Buttons: BLAZER EXPRESS
Pressing the FOR button moves the print bed incrementally towards the back of the printer •	
(if facing printer, the bed will move away from you, towards the Index Position).

Pressing the REV button moves the print bed incrementally toward the front of the printer •	
(if facing printer, the bed will move closer to you, towards the Home Position).

JOG - For and Rev Buttons: BLAZER PRO:
Pressing the FOR button moves the printer assembly incrementally toward the front of the unit •	
(if facing printer, the assembly will move closer to you, towards the Index Position).

Pressing the REV button moves the printer assembly incrementally toward the back of the unit •	
(if facing printer, the assembly will move away from you, towards the Home Position) 
 
 
 

Platen (Print Bed) to Head Clearance Adjustment Screen

BLAZER EXPRESS: 
The Platen to Head (Print Bed to Print Head) Clearance 
Height Adjustment screen may appear as a User Interface 
screen, but its functions have been disabled and only work 
for the Blazer PRO model - see next section). On the T-Jet 
Blazer Express, the platen to head clearance is manually 
adjusted using the control knob located on the Print Bed.

Rotating the knob clockwise lowers the Platen giving 	•	
	 more clearance.

Rotating the knob counter-clockwise raises the Platen •	
giving less clearance.

To set the distance to a safe printing height, refer to the height sensor. The distance of the platen (with 
the substrate loaded) needs to be set to a minimum of 3mm to a maximum of 5mm in relation to the print 
head. This distance will depend on what distance is used in performing your Print Head Alignment. Learn 
more in Chapter 8 - SETUP PART 6 - Initialization Utilities.

BLAZER PRO: 
The Platen to Head Clearance Adjustment screen is only 
active on the Blazer PRO model and is used to set the proper 
clearance between the Platen (print bed) and the Printer 
Assembly (Print Head).

Pressing the UP button raises the Platen (Print Bed) giving •	
less clearance.



Chapter 7 - SETUP PART 5: Learning the LCD and User Interface Controls 

34
T-Jet Blazer Series User’s Manual

Pressing the DOWN button lowers the Platen (Print Bed) giving more clearance. •	

The distance of the platen (with the substrate loaded) needs to be set to a minimum of 3mm to a 
maximum of 5mm in relation to the Printer Assembly. This distance will depend on what distance is used 
in performing your Print Head Alignment. Learn more in Chapter 8 - SETUP PART 6 - Initialization 
Utilities. 
 
 
 

System Printer Control Utility (SPCU) Screen
The SPCU has been discontinued. Your printer may or may not 
have this screen available, but if so, the functions on this screen 
should be utilized from the LCD Display Control Panel rather than 
here.

To Reset a job or clear all jobs on the LCD Display Controls, press 
and hold the Pause Button for 3 seconds.

To Pause a job on t he LCD Display Controls, press the Pause 
Button.

The Alarm Select Screen
You may hear a tone when performing certain actions, 
such as sending a print command. You will also notice 
blinking of the green lights before and after printing. The 
Alarm Select Screen allows you to control whether or 
not you will hear or see these various audible and visual 
alarms.

Press any or both of the touch screen switches to turn the 
alarms either on or off. 

NOTE: To adjust these settings ensure the virtual dial on 
the Mode Select Screen is set to Manual.

IMPORTANT POINT
Anytime you choose the Manual mode from the Mode Select Screen, you must 
remember to return to that screen and switch the virtual dial to Auto to enable 
printing.
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Chapter 8

SETUP PART 6: 
Initialization Utilities

You have the Bulk Ink System in place and the Printer Driver installed, but there are a few more steps to 
follow before you can begin printing.  You must set the Shirt Board to the correct height for printing and 
perform an initialization process that will get the ink flowing, and ensure the Print Head Nozzles are in 
proper alignment to output the best possible images. Since the Blazer EXPRESS and PRO’s layouts and 
steps to raise the platen are different, the steps below will apply to the particular model. YOU MUST 
COMPLETE THESE INITIALIZATION STEPS TO PRINT! 
 
Shirt Board Height Settings 
BLAZER EXPRESS
It is necessary during setup to check and adjust the Shirt Board to Head Clearance to the proper height for 
output and to make sure that the Shirt Board is at a safe distance from the Print Head. It is also important 
that each corner of each Shirt Board being used is level with the Print Head. 

Leveling the Shirt Board (EXPRESS)
The first step in the process is to level the Shirt Board to the Print Head. You will want to repeat this 
procedure when switching between different Shirt Boards.

1.	 Determine the distance you want. 
Determine the distance you want between the Shirt Board (with 
garment) and the Print Head. THE DISTANCE MUST BE NO 
LESS THAN 3 MM AND NO MORE THAN 5 MM. To get the 
sharpest prints use a distance closer to 3mm but NEVER less. For 
this example, we’ll use a distance of 4 mm. 
 
NOTE: you will refer to this setting when completing the Print Head Alignment Utility later in this 
chapter. This will be your permanent height setting when printing.a 

Set the Printer to Print Position2.	 .

IMPORTANT NOTE:
To properly set the Print Head Height you must first set the Print Head to it’s 
printing height position. By default the Print Head sits higher than when it is printing 
and may cause the user to inadvertently set it too low, causing a head crash. 

There are two ways to verify that the printer is in the correct position for setting the Print Head Height. 

1. The recommended method is performing a Regular •	 Head Cleaning Cycle prior to setting the 
Print Head Height. When a Head Cleaning Cycle is completed the printer will be in the correct 
position to measure the distance and make any necessary adjustments if needed. Refer to the Head 
Cleaning Utility section of this chapter.     
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•	 2. The other method is to 
visually check the gear that 
controls the Print Head 
height. This gear is on the 
left end of the printer 
opposite of the capping 
station and can be viewed 
by lifting the lid.

IF YOU HAVE COMPLETED 
A HEAD CLEANING CYCLE 
OR HAVE CONFIRMED THAT 
THE PRINTER IS IN PRINTING 
POSITION, CONTINUE TO STEP 3 BELOW. 
 

3.	 Position the Shirt Board 
You will need to position the Shirt Board underneath the Print 
Head so that you can accurately measure the distance between the 
two. The distance needs to be checked (and adjusted if necessary) 
on all 4 corners to have the best possible prints. NOTE: Start out 
leveling the Over-sized Shirt Board. It is needed for the 
following sections - Nozzle Check and Print Head Alignment. 
Also, after leveling a Shirt Board, make sure you mark it in a 
way that you can tell which position it needs to sit in for future 
use.

•	 Go to the UI and switch to Manual Mode 
on the Mode Select screen. Refer to 
Chapter 6 for details on UI screens. 

•	 Next, go to the MMMU Screen and press the FOR button to 
move the Shirt Board incrementally towards the printer 
assembly. Stop when the Shirt Board is lined up with where the 
Print Head is. 
 

Release the Print Carriage for Access4.	  
The Print Carriage needs to be released in order to pull move it away from the capping station.

 
WARNING: BE VERY CAREFUL WHEN MOVING THE Print Head! DO NOT 
LET THE Print Head TOUCH ANY SURFACE! THIS WILL PERMANENTLY 
DAMAGE IT!

DEFAULT POSITION:
If the gear is open like above, DO NOT 
attempt to set the Print Head Height. The 
easiest way to  set this to Printing Position 
is by performing a Head Cleaning Cycle.

PRINTING POSITION:
If the gear is closed like above, it is in 
the correct position to set the Print Head 
Height. Continue on with the next step.

MODE SELECT
AUTOMANUAL

Pad
Enabled

MANUAL  MECHANISM  MOVEMENT  UTILITY
JOG

FOR. REV. HOME INDEX NEST

POSITION
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•	 Lift the printer cover (if it is not already lifted) and locate the 
Carriage Release Button (blue) located in front of the Print 
Carriage on the right side of the printer. 

Press down and slowly move the •	 Print Carriage towards the 
Shirt Board. 
 

5.	 Measure the Distance 
Using a ruler or a jig, measure the distance between 
the Shirt Board and the Print Head. You may need to 
go to the rear of the printer to see; you may also need 
a flashlight. 
 
In the photo to the right we used 3 CDs stacked 
together (measuring 4 mm) to show how a jig can 
help in the measuring process. 

6.	 Adjust Shirt Board Corner Height (if needed) 
If you determined that the Shirt Board needs to be raised or lowered in a 
particular corner, the Blazer Express Shirt Boards have adjustment  
screws located on the inside of the Shirt Board.

 
NOTE: If the Shirt Board adjustment screws cannot go 
any higher or lower, you may have to raise or lower the 
entire Print Bed Height using the Height Adjustment Knob 
to accommodate the Shirt Board’s distance. For example: if 
1 or more corners need to be raised or lowered an inch, then 
first raise or lower the entire height of the Print Bed one inch 
and continue the leveling process. 

Repeat7.	  
Repeat Steps 3 to 5  (and 6 if adjustments are needed) for every corner 
to complete the leveling process. Also, repeat these steps for the other Shirt Boards (you can do this 
later if desired).

Return the Print Carriage8.	  
Manually move the Print Carriage back to the Capping Station. It will click into place.

9.	 Return to Home Position 
Return to the UI and the MMMU screen. Under the Position 
heading, press Home.  The Printer Assembly will begin to move. 
When it stops, it will be in the Home position. 

Turning the knob clockwise will 
lower the Shirt Board, giving more 
clearance and turning it counter-
clockwise will raise the Shirt Board, 
giving less clearance.

JOG

FOR. REV. HOME INDEX NEST

POSITION
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Adjust the Overall Height of the Shirt Board (EXPRESS)
Now that the Shirt Board is level, the next step is to adjust the entire height of the Shirt Board (if needed). 
You may not have to complete this section for the initial setup if you ended up with an accurate measured 
distance in the previous section. In addition, should you need to raise or lower the Shirt Board to 
accommodate different garment thicknesses or other items, the following procedure would be used.

Confirm that the Printer is in the Proper Position.1.	  
Refer to the previous section - Leveling the Shirt Board - Step 2. You must make sure that the printer 
is in proper position before attempting to set and measure the height of the Shirt Board. If the printer 
is not in the “Print Position” you will NOT get an accurate measurement reading, which can lead to 
serious damage to the Print Head.

Enter the Mode Select Screen2.	  
After you have verified “Print Position” or have completed a Head Cleaning Cycle, on the UI, go 
to the Mode Select screen. Refer to Chapter 7 - SETUP PART 5: Learning the LCD and User 
Interface Controls, for details on UI screens.

3.	 Set the Printer to Manual Mode 
In the upper left hand corner is a virtual dial pointing to “Auto.” Press the dial 
once and it will rotate to “Manual.” 

Enter the4.	  MMMU Screen 
Using the “hand” buttons, scroll through the UI screens until you 
reach the Manual Mechanism Movement Utility (MMMU) screen. 
 
This screen will enable you to freely control the Platen assembly 
position. 

5.	 Position the Shirt Board 
In the JOG section of the MMMU screen, use the FOR and REV buttons to 
center the Platen assembly directly under the printer. Note: by this time you should 
have already completed the previous section, Leveling the Shirt Board. 
 
The Blazer EXPRESS (only) is equipped with a built-in Height Sensor that will prevent the Shirt 
Board (or garment) from striking the Print Head. This will happen 
if the distance between the garment and Print Head is less than the 
minimum of 3 mm. The height sensor is a thin laser beam that 
extends across the Shirt Board if it is at a dangerous height that will 
damage the Print Head. If the Shirt Board is set too high, or should 
anything break this beam, all machine functions will immediately 
pause, the LCD Display will read “Top Cover Open” and a small 
LED located on the top of the printer will flash Red. 

MODE SELECT
AUTOMANUAL

Pad
Enabled

MANUAL  MECHANISM  MOVEMENT  UTILITY
JOG

FOR. REV. HOME INDEX NEST

POSITION

--------------- - -  --------------------- - --------- -- ------------- --------------- --- ---- ------ --
--------------- - -  --------------------- - --------- -- ------------- --------------- --- ---- ------ --

HOME
“AUTO” MODE

JOG

FOR. REV.
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WARNING:
SOME EARLIER MODELS MAY NOT BE EQUIPPED WITH THE HEIGHT 
SENSOR. IF YOUR MODEL DOES NOT, REFER TO THE FOLLOWING SECTION 
- SETTING THE OVERALL HEIGHT FOR THE BLAZER PRO MODEL - WHICH 
ALSO DOES NOT HAVE A HEIGHT SENSOR EQUIPPED.  

  
6.	 Set the Shirt Board Height 

For best results, you will want to set the distance as close to the sensor level as possible. 
 
Use the Height Adjustment knob to set the clearance to the desired height for printing. NOTE: you 
will need to use the exact distance in the following chapter 
called Chapter 9 - SETUP PART 7: Performing a Print 
Head Alignment. If the Platen is set too high, the sensor will 
trigger. Lower slightly until the sensor shuts off. When the 
sensor shuts off, you are set to the ideal height which will 
give you the highest quality prints. This will only work 
accurately if you successfully completed the previous 
section, Leveling the Shirt Board. 
 
Turning the knob clockwise will lower the Shirt Board, 
giving more clearance and turning it counter-clockwise will raise the Shirt Board, giving less 
clearance. NOTE: If the sensor is tripped too many times, the printer will error out and display one of 
the following error messages on the LCD screen: 
 
“TOP COVER OPEN” 
SRVC REQD 00001001E 
 
In the case of either of these error messages, you will be forced to perform a complete shutdown. To 
learn more about error codes and messages, refer to Chapter 16 - Troubleshooting.

IMPORTANT POINT 
The Height Sensor is a “Last Line of Defense” to prevent the Print Head from 
striking a garment, Platen or any other object that could cause severe damage to the 
Print Head. Practice knowing where your Platen (Shirt Board) is in relation to the 
Print Head height. Do not rely solely on the sensor to warn you of potential collisions. 
Print Heads are not covered under warranty so we strongly encourage you to monitor 
and maintain a safe clearance between the Print Head and any garment or other 
printable item. 

 

7.	 Return to Home Position 
After the height of the Platen has been set, return to the UI and 
browse to the MMMU screen. Under the Position heading, 
press Home.  You will hear an audible tone  and the Printer 
Assembly will begin to move. When it stops, it will be 
in the Home position.

JOG

FOR. REV. HOME INDEX NEST

POSITION
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Shirt Board Height Settings 
BLAZER PRO
It is necessary during setup to check and adjust the Shirt Board to Head Clearance to the proper height for 
output and to make sure that the Shirt Board is at a safe distance from the Print Head. It is also important 
that each corner of each Shirt Board being used is level with the Print Head. 

Leveling the Shirt Boards (PRO)
The first step in the process is to level the Shirt Boards to the Print Head. You will want to repeat this 
procedure when switching between different Shirt Board sizes. 

1.	 Determine the distance you want. 
Determine the distance you want between the Shirt Board (with 
garment) and the Print Head. THE DISTANCE MUST BE NO 
LESS THAN 3 MM AND NO MORE THAN 5 MM. To get the 
sharpest prints use a distance closer to 3mm but NEVER less. For 
this example, we’ll use a distance of 4 mm. 
NOTE: you will refer to this setting when completing the Print 
Head Alignment Utility later in this chapter. This will be your permanent height setting when 
printing. 

Set the Printer to Print Position2.	 .

IMPORTANT NOTE:
To properly set the Print Head Height you must first set the Print Head to it’s 
printing height position. By default the Print Head sits higher than when it is printing 
and may cause the user to inadvertently set it too low, causing a head crash. 

There are two ways to verify that the printer is in the correct position for setting the Print Head Height. 

1. The recommended method is performing a Regular •	 Head Cleaning Cycle prior to setting the 
Print Head Height. When a Head Cleaning Cycle is completed the printer will be in the correct 
position to measure the distance and make any necessary adjustments if needed. Refer to the Head 
Cleaning Utility section of this chapter.     
     

•	 2. The other method is to 
visually check the gear that 
controls the Print Head 
height. This gear is on the 
left end of the printer 
opposite of the capping 
station and can be viewed 
by lifting the lid. 
 

DEFAULT POSITION:
If the gear is open like above, DO NOT 
attempt to set the Print Head Height. The 
easiest way to  set this to Printing Position 
is by performing a Head Cleaning Cycle.

PRINTING POSITION:
If the gear is closed like above, it is in 
the correct position to set the Print Head 
Height. Continue on with the next step.



Chapter 8 - SETUP PART 6: Initialization Utilities 

41
Version 5.5  Revised January, 2009

IF YOU HAVE COMPLETED A HEAD CLEANING CYCLE OR HAVE CONFIRMED THAT THE 
PRINTER IS IN PRINTING POSITION, CONTINUE TO THE NEXT STEP. 
 

3.	 Position the Shirt Board 
You will need to position the first Shirt Board underneath the Print 
Head so that you can accurately measure the distance between the 
two. The distance needs to be checked (and adjusted if necessary) 
on all 4 corners of each Shirt Board to have the best possible 
prints. 
 
NOTE: Start out leveling the 
Over-sized Shirt Boards (front 
and back ends) and 1 Standard 
Board (placed in the middle) as shown. This layout is needed 
for the following Print Head Alignment section. 
 
Also, after leveling a Shirt Board, make sure you mark it in a way that you can tell which 
position and setting it needs to sit in for future use.

•	 Go to the UI and switch to Manual Mode 
on the Mode Select screen. Refer to 
Chapter 6 for details on UI screens. 

•	 Next, go to the MMMU Screen and press 
the FOR button to move the Platen incrementally towards the 
printer assembly. Stop when the Shirt Board is lined up with 
where the Print Head is. On the UI, touch the screen to get to the 
Mode Select screen. Refer to Chapter 6 for details on UI screens. 
 

Release the Print Carriage for Access4.	  
The Print Carriage needs to be released in order to pull move it away from the capping station.

WARNING: BE VERY CAREFUL WHEN MOVING THE Print Head! DO NOT 
LET THE Print Head TOUCH ANY SURFACE! THIS WILL PERMANENTLY 
DAMAGE IT! 
 

•	 Lift the printer cover (if it is not already lifted) and locate the 
Carriage Release button (blue) located in front of the Print 
Carriage on the right side of the printer.

Press down and slowly move the •	 Print Carriage towards the 
Shirt Board. 

Over-sized 
Shirt Board

Stand. 
Shirt 
Board

Over-sized 
Shirt Board

MODE SELECT
AUTOMANUAL

Pad
Enabled

MANUAL  MECHANISM  MOVEMENT  UTILITY
JOG

FOR. REV. HOME INDEX NEST

POSITION
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5.	 Measure the Distance 
Using a ruler or a jig, measure the distance between 
the Shirt Board and the Print Head. You may need to 
go to the rear of the printer to see; you may also need 
a flashlight. 
 
In the photo to the right we used 3 CDs stacked 
together (measuring 4 mm) to show how a jig can help 
in the measuring process. 
 

6.	 Adjust Shirt Board Corner Height (if needed) 
If you determined that the Shirt Board needs to be raised or lowered in a 
particular corner, the Blazer Express Shirt Boards have adjustment 
screws located on the inside of the Shirt Board. 
 

NOTE: If the Shirt Board adjustment screws cannot go any higher or lower, you 
may have to raise or lower the entire Print Bed Assembly height using the Platen to 
Head Adjustment screen on the User Interface to accommodate the Shirt Board’s 
distance. For example: if 1 or more corners need to be raised or lowered an inch, 
then first raise or lower the entire height of the Print Bed Assembly one inch and 
continue the leveling process. Refer to the next section, Adjusting the Overall 
Height of the Print Bed Assembly. If Shirt Board is extremely out of level, refer to 
Chapter 16  - Troubleshooting for solutions. 
 

Repeat7.	  
Repeat Steps 3 to 5  (and 6 if adjustments are needed) for every corner to complete the leveling 
process. Also, repeat these steps for the other Shirt Boards that you will be utilizing (2 oversized, and 
1 standard). 

Return the Print Carriage8.	  
Manually move the Print Carriage back to the Capping Station. It will click into place. 

9.	 Return to Home Position 
Return to the UI and the MMMU screen. Under the Position 
heading, press Home.  The Printer Assembly will begin to move. 
When it stops, it will be in the Home position. 
 
 
 

JOG

FOR. REV. HOME INDEX NEST

POSITION
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Adjust the Overall Height of the Print Bed Assembly (PRO)
Now that the Shirt Boards are level, the next step is to adjust the entire height of the Platen. In addition, 
should you need to raise or lower the entire Print Bed Assembly to accommodate different garment 
thicknesses or other items, the following procedure would be used.

Confirm that the Printer is in the Proper Position.1.	  
Refer to the previous section - Leveling the Shirt Board - Step 2. You must make sure that the printer 
is in proper position before attempting to set and measure the height of the Shirt Board. If the printer 
is not in the “Print Position” you will NOT get an accurate measurement reading, which can lead to 
serious damage to the Print Head.

Enter the Mode Select Screen2.	  
On the UI, go to the Mode Select screen. Refer to Chapter 6 for details on UI screens.

3.	 Set the Printer to Manual Mode 
In the upper left hand corner is a virtual dial pointing to “Auto.” Press the dial 
once and it will rotate to “Manual.”

4.	 MMMU Screen 
Using the “hand” buttons, scroll through the UI screens until you 
reach the Manual Mechanism Movement Utility (MMMU) screen. 
 
This screen will enable you to freely control the Platen assembly 
position. 

5.	 Position the Platen Assembly 
In the JOG section of the MMMU screen, use the FOR and REV buttons to 
center the Platen assembly directly under the printer.

IMPORTANT POINT
When moving the print carriage for the first time, use caution to make sure it will not 
hit the Platen (Shirt Board). Use the following steps for adjustments.
 

6.	 Release the Print Carriage 
The Print Carriage needs to be released so that you can slide it 
towards the Shirt Board (Platen) to view it’s relation with the Print 
Head.

Lift the printer cover (if it is not already lifted) and locate •	
the Carriage Release Button (blue) located in front of the print 
carriage on the right side of the printer.

Press down and slowly move the Print Carriage away from the •	
Capping Station until its sits over the Shirt Board. To see the distance accurately, you may need a 
flashlight.

MODE SELECT
AUTOMANUAL

Pad
Enabled

MANUAL  MECHANISM  MOVEMENT  UTILITY
JOG

FOR. REV. HOME INDEX NEST

POSITION

--------------- - -  --------------------- - --------- -- ------------- --------------- --- ---- ------ --
--------------- - -  --------------------- - --------- -- ------------- --------------- --- ---- ------ --

HOME
“AUTO” MODE

JOG

FOR. REV.
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7.	 Set the Platen to a safe clearance 
Use the Platen to Head Clearance Adjustment Screen 
on the User Interface to set the clearance of 
approximately 3 mm (1/8”) and no less.

On the UI, press the “RIGHT hand” button until •	
the Mode Select screen appears. (Refer to the 
previous chapter for details on UI screens)

In the upper left hand corner is a virtual dial •	
pointing to “Auto.” Press the dial once and it will 
rotate to  Manual. 

•	 On the UI, browse through the screens until you come to 
the Platen to Head Clearance Adjust (PHCA) screen.

Use the UP/DOWN arrows to set a Print Head clearance of •	
approximately 3 mm. What moves up and down is the Platen, 
NOT the printer assembly. The UP button raises the Platen 
closer to the Print Head and the DOWN button lowers the 
Platen away from the Print Head. 
 

•	 Make sure that the minimum 3mm distance is 
maintained across the span of ALL THREE Shirt 
Boards. 
 

JOG

FOR. REV.

Use the JOG section of the 
MMMU screen to manually 
move the assembly to the 
other Shirt Board positions. 
 

Return the Print Carriage 8.	
After a safe distance has been established, slide the Print Carriage back to the capping station. It will 
click back into place. 

9.	 Return to Home Position 
Return to the UI and the MMMU screen. Under the Position 
heading, press Home.  The Printer Assembly will begin to move. 
When it stops, it will be in the Home position.

ALWAYS KEEP
CLEARANCE OVER 
3 MILLIMETERS 3mm

PLATEN
(PRINT BED)

PRINT HEAD

JOG

FOR. REV. HOME INDEX NEST

POSITION
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Power Cleaning Utility
To initialize the ink, a utility called Power Cleaning will need to be performed. The Power Cleaning 
Utility will pull the ink through the lines and into the Print Head. It can also be utilized if you have 
serious nozzle clogs, however, it will consume a large volume of ink. We recommend that you only 
perform a Power Cleaning for your initial setup unless the troubleshooting chapter or our support team 
suggests otherwise. The initial setup will require approximately two to three Power Cleaning cycles. We 
recommend completing two cycles, then continuing on with the next section - Nozzle Check Utility. If the 
printout from the Nozzle Check Utility is far from complete (many gaps) then return here and complete an 
additional Power Cleaning. Also see Nozzle Check/Power Clean Utility Using the LFP Remote Panel, 
later in this chapter. 
 
DO NOT perform a Power Cleaning for nozzle clogs unless directed to do so by our technical support. 
Use the Head Cleaning function; this cleaning uses MUCH less ink. For Head Cleaning steps, refer to 
the Nozzle Check section later in this chapter. If the Head Cleaning Cycle is not solving your problem, it 
may be another issue. Refer to Chapter 16 - Troubleshooting for answers to common concerns. If your 
answer is not resolved, then call our support department for assistance. 

IMPORTANT POINT
U.S. Screen is not liable for any damage caused by ink to property such as 
carpets, flooring or furniture . Please read and understand all operating and 
maintenance procedures before using the printer.
 

Setting Up for a Power Cleaning
Power up the Printer.1.	  
To begin, turn the printer ON as you normally would. The printer will go through a startup cycle that 
will take a couple of minutes.

Set the User Interface to Manual Mode.2.	  
The Power Cleaning cycle is executed from the LCD Control Panel. However, before beginning, you 
need to first set the virtual dial, in the mode select screen of the User Interface, to Manual.

On the UI, press the “RIGHT hand” button until the Mode Select screen •	
appears. (Refer to page 45 for details on UI screens)

In the upper left hand corner is a virtual dial pointing to “Auto.” Press the dial once and it will •	
rotate to  Manual.

3.	 Set the Printer to Print Status. 
The printer, after being powered up, should be in the Home 
Position and in Print Status.

•	 If the printer is not in Print Status:  
By using the LCD Control Panel, press the LEFT 
ARROW twice until the LCD Display reads “READY” with the 
Sheet icon. This mode is called READY/ SHEET mode.

LCD Display in Print status (Paper Out/Roll Cut Mode)

READY
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•	 Press the LEFT ARROW once more and the 
LCD Display will read “PAPER OUT” and displays a “roll of 
paper with a scissors” icon. This mode is called PAPER OUT/
ROLL CUT mode. The printer is now in Print status. 

Whenever you need to get to Print Status, this is the sequence you will use. 
The only difference would be if you were preparing to output an image onto 
a garment, the virtual dial of the Mode Select Screen would be set to Auto.  

Set the printer to 4.	 READY Status. 
Now that you are in Print Status, the next step is setting the printer to READY Status using the LCD 
Display Control Panel. 
 
To do this, press the Left ARROW Button once. The LCD Display 
should look like this.

 

Activate the Power Cleaning Cycle
A Power Cleaning Cycle is activated through the LCD Display Control Panel like most of the 
Initialization Utilities. Carefully follow the steps below. 

With the printer in 1.	 READY Status, press the RIGHT ARROW Button once.

Press the 2.	 UP ARROW Button and scroll through the menu items until you come to “Maintenance.” 
Press the RIGHT ARROW Button once.

Press the 3.	 DOWN ARROW Button to scroll the menu items until you come to “Power Clean.” 

To execute the 4.	 Power Cleaning, press the RIGHT ARROW Button once.

While Cleaning, the LCD display will inform you of the Power Cleaning status in percentages.
 

When prompted by the 5.	 LCD Display, move both blue levers adjacent the ink cartridges (the levers 
that lock the ink cartridges in place) to the UP position. The display will prompt you at the 17% mark.

When prompted, move both blue levers into the DOWN position. You will be prompted at around the 6.	
20% mark.

You will again be prompted to move both levers at the 30%, 40% and 50% marks. At the 50% point, 7.	
both levers will be in the DOWN position and you will not have to adjust them again during the 
power cleaning cycle. 
 
Once the Power Cleaning is complete, the LCD Display will read “Ready.” 

Repeat the Power Cleaning Utility until the ink has filled the ink lines and reaches the Print Head.8.	

PAPER OUT

READY
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Nozzle Check Utility
The next step in the setup process is performing  Nozzle Check. 
The Nozzle Check Utility is necessary to confirm that the ink is 
flowing and that the Print Head is performing properly. NOTE: 
Later in this chapter are instructions on completing the Nozzle 
Check Utility using the Epson LFP Remote Panel. 
 
The Nozzle Check Utility also works in conjunction with the 
Head Cleaning Cycle showing that a cleaning was successful or if another is needed. 
 
You may use either paper or film for this test, but we recommend a clear film such the film that we have 
included with the T-Jet. This is a standard screen print positive film and is available at most screen print 
supply stores. Make sure that it is a film that can be printed on. Paper can be used but will make it almost 
impossible to view the white ink pattern. Another, more cost efficient method is to print on a plexi-glass 
material which can be cleaned and reprinted on. You will have to adjust your Print Head Height settings if 
using a thicker media than film.  
 

Setting Up for a Nozzle Check
1.	 Set the printer from Print Status to READY/SHEET status by pressing the LEFT ARROW button 

twice on the LCD Control Panel. 
 
The display will read “READY” with a “sheet of paper” icon. Only 
when in READY/SHEET status can the Print Bed (Express) or Printer 
Assembly (PRO) be moved freely.

2.	 Using the “RIGHT hand” button, shuffle through the UI screens until you get to the 
Mode Select screen. Ensure the virtual dial is set to Manual.

Press the “RIGHT hand” button on the UI again until you reach the 3.	 Manual Mechanism Movement 
Utility (MMMU) screen.

4.	 Place your sheet of film on the Over-sized  Shirt Board (for the Blazer 
PRO it will be the Board furthest from the printer assembly). The film 
we include has a printable surface and a non-printable surface. The 
sticky side is the printable side and needs to be facing up. You can test 
this by wetting your finger and touching the film. Your finger will stick 
to the printable side. When placing the film, take care to align the film 
with the Shirt Board’s lower right hand corner (as you face the front of 
the printer.)  Overhang the film 1 inch over the edge of the Shirt Board.

On the UI, under the heading section, press the Index button. This will move the Print Bed to the 5.	
proper position for printing a nozzle check.

6.	 Next, go back to the LCD and change the printer mode to 
READY/ROLL mode by pressing the LEFT ARROW button twice. The 
display will read “READY” with a “roll of paper” icon.

READY
1

READY
1
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Activate the Nozzle Check Utility
A Nozzle Check Utility can be activated through the LCD Display Control Panel or the LFP Remote 
Panel (see later section in this chapter). For steps on activating through the LCD Display Control Panel, 
carefully follow the steps below.

1.	 The printer should now be in READY ROLL Mode. Press the RIGHT 
ARROW Button once - the display will read “Printer Setup.”

2.	 Press the DOWN ARROW Button once to see “Test Print.”

3.	 Press the RIGHT ARROW Button once to see “Nozzle Check.”

4.	 Press the RIGHT ARROW Button again and “Print” will appear in the display.

To execute the Nozzle Check, press the RIGHT ARROW button once. 5.	
 

If the Nozzle Check does not print 
a “GOOD” pattern,  perform a regular Head 
Cleaning Cycle. 

 

 

Head Cleaning Utility
The Head Cleaning Utility is much like a Power Cleaning Cycle but it 
consumes much less ink. To perform a Head Cleaning, hold down the RIGHT/
CLEAN ARROW Button on the LCD Display Control Panel for 3 seconds. If 
you are performing a Head Cleaning to correct the results of a Nozzle Check, 
execute another Nozzle Check to see if the Head Cleaning was successful. If not, 
repeat the Head Cleaning/Nozzle Check Utilities.

IMPORTANT NOTE:
If, AT ANY TIME, you have performed three Nozzle Checks without rebooting 
your printer, you must power OFF your printer before executing another one. If 
completed 4 Head Cleaning Cycles and you are not getting results, a Power Cleaning 
Cycle may be required.

PRINTER SETUP

TEST PRINT

TEST PRINT
NOZZLE CHECK

NOZZLE CHECK
PRINT

GOOD BAD
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Nozzle Check and Power Cleaning 
Utilities from the LFP Remote Panel
The Nozzle Check procedure can also be completed by using the Epson LFP Remote Panel. The LFP 
Remote Panel is a stand alone application designed to give you several utility functions, including the 
Print Head Alignment and Power Cleaning utilities, right from your computer. The LFP Remote Panel 
is included with the Epson Stylus Pro Driver CD that came with your Blazer Series printer. To execute a 
Nozzle Check test print or a Power Cleaning from the LFP Remote Panel, refer to the following steps for 
installation options and using the LFP Remote Panel. 

Installation and Download of the LFP Remote Panel
Installation works very similar to any installation. Simply follow the screen prompts.

Download On Web 
The LFP Remote Panel is also available to download from Epson’s website: www.epson.com. Select 
Drivers & Support, then select the applicable version for the Stylus Pro based on the Operating System 
(Windows XP, Vista, 2000 or MAC). 
 
 
To determine which Epson Print Engine your printer is equipped with, locate the printer serial number and 
compare it to the following table. 
  
If your Serial Number contains the following as the 4th and 5th 
digits (PRO) or 5th and 6th (EXPRESS) after TJB or TJBE. 
Download the latest LFP Remote Panel for your particular 
model.
 

Nozzle Check/Power Cleaning  With LFP Remote Panel

Setup Your Printer and Media 1.	
 
Before beginning, make sure you are familiar with printer setup in order to complete the nozzle 
check process properly. Refer to the previous section, Nozzle Check Utility - Setting Up for a Nozzle 
Check, for the complete setup procedure.

2.	 Once the printer is in correct position with media present, open the LFP Remote Panel by 
double-clicking on the Epson LFP icon on your computer’s Desktop. 
 
If not present, using your Start menu, select Programs > Epson > Epson LFP Remote 
Panel.

BO:     EPSON Stylus Pro 4800
BX:     EPSON Stylus Pro 4800
B8:      EPSON Stylus Pro 4880
BY:     EPSON Stylus Pro 4880
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3.	 From the main Window, select your printer from the drop down menu. 
 
Use the table below to determine your 
Epson print engine model. 
 
BO:     EPSON Stylus Pro 4800 
BX:     EPSON Stylus Pro 4800 
B8:      EPSON Stylus Pro 4880 
BY:     EPSON Stylus Pro 4880 
 
Your Serial Number will contain one of 
the four options after TJBE or TJB. The 
table will then outline which model your 
print engine is based on.

Select Power Cleaning from the LFP 4.	
Remote Panel Main Screen. 

5.	 Within the next screen, select your 
printer from the drop-down menu.

Click on the desired function. 6.	
 
NOTE: A Power Cleaning consumes 
a large volume of ink. For daily 
cleanings use the Head Cleaning 
function. For more information 
on the Power Cleaning and Head 
Cleaning Utilities, refer to those 
sections earlier in this chapter.  

When the procedure is complete, 7.	
click Exit. 
 
If the Nozzle Check does not print correctly, perform a regular Head Cleaning. See Performing a 
Head Cleaning earlier in this chapter and repeat the Nozzle Check Process if needed.  

IMPORTANT NOTE:
If, AT ANY TIME, you have performed three consecutive Nozzle Checks without 
rebooting your printer, you must power OFF your printer before executing another 
one. 
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Once you have obtained a satisfactory Nozzle Check, press the Power button on the UI to turn OFF 8.	
your printer. After the shutdown process has been completed, turn the power back ON and you may 
resume normal operations. To begin the Head Alignment process, place your printer in “Paper Out 
(Roll/Cut)” mode. The LCD Display will read “Paper Out” and display the “roll” icon in addition to 
the “scissors” icon.
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Chapter 9

SETUP PART 7: 
Print Head Alignments

Introduction
The Blazer EXPRESS and PRO have different procedures for completing a Print Head Alignment. This 
chapter has been split into 2 sections. Please refer to the correct section corresponding with your T-Jet 
Blazer Series model. The Print Head Alignment procedures have been carefully researched and it is 
extremely important that you follow the instructions carefully to prevent mis-calibration. 
 
All Blazer Series printers have been aligned prior to shipping and have been locked down using a 
lock-down bracket. In most cases, you WILL need to perform an alignment for initial setup. In the case 
that your prints are not lining up properly, performing a precise and COMPLETE Head Alignment is 
extremely crucial to creating great images with your new printer.

WARNING: Performing a Head Alignment can take up to 2 hours. Before 
beginning this procedure, make sure that you are familiar with all the required 
steps and have the necessary time available to complete the entire process. Once 
you have begun a Head Alignment you CANNOT exit the function without shutting 
down the machine. In addition, early exit may result in severe misalignment of the 
Print Head or other operational concerns.

When is a Print Head Alignment Needed
If your prints contain vertical lines or misaligned parts of an image. •	

If your printer was shipped or transported.•	

If the Print Head makes contact with any object whether it’s a garment or a Shirt Board. •	

Types of Print Head Alignments and Which to Complete
There are 2 types of alignments: Uni-Directional and Bi-Directional. Uni-Directional aligns the Print 
Head for printing one way (forward) across the garment, while Bi-Directional aligns the Print Head for 
printing forward and backward. The test prints performed after your initial setup will determine which 
alignment process may be needed. 

If completing the alignment procedure from the results of transporting your printer or from the •	
Print Head striking the Shirt Board, start with Uni-Directional (if wanting to print with High Speed 
Print Modes you will then need to complete the Bi-Directional alignment afterwards).

If your first test print is off using a standard print mode, you will need to complete the Uni-•	
Directional Print Head Alignment. If you then want to utilize the High Speed Print Modes 
(recommended), perform a test print using the HS print mode. If the print is off, you will then need 
to complete the Bi-Directional Print Head Alignment.

If your first test print (using the standard print modes) came out good, but your second test print, •	
using the High Speed Print Modes, printed off, you will only need to complete the Bi-Directional 
Print Head Alignment procedure.
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BLAZER EXPRESS ALIGNMENTS
This section will cover the execution 
of Uni-Directional and Bi-Directional 
Print Head Alignments for the Blazer 
EXPRESS. For steps on completing these 
alignments for the Blazer PRO, refer to the 
later section of this chapter named Blazer 
PRO Alignments. 

1. Install the LFP Remote Panel
The alignment procedure is completed by using the Epson LFP Remote Panel. The LFP Remote Panel is 
a stand alone application designed to give you several utility functions, including the Nozzle Check and 
Power Cleaning utilities, right from your computer. The LFP Remote Panel is included with the Epson 
Stylus Pro Driver CD that came with your Blazer Series printer.

Download On Web 
The LFP Remote Panel is also available to download from Epson’s website: www.epson.com. Select 
Drivers & Support, then select the applicable version for the Stylus Pro based on the Operating System 
(Windows XP, Vista, 2000 or MAC). 
 
To determine which Epson Print Engine your printer is equipped with, locate the printer serial number and 
compare it to the following table. 
  
If your Serial Number contains the following as the 5th and 6th 
digits after TJBE. Download the latest LFP Remote Panel for 
your particular model.

2. Printer Setup
To continue the Print Head Alignment procedure, you must have the Epson LFP Remote Panel installed 
and the computer connected to the printer. The printer must be in “Ready/ROLL” mode and be in the 
Index Position with the film or other media (to print on) in place. If the printer is not in the correct mode, 
you will receive a “Communication Failed” error. You will also need to determine the Print Head height 
that you will use permanently while printing. 

Power up the printer (if not powered up already).1.	

Check the distance between the Print Head and the 2.	 Shirt Board. 
 
The Shirt Board must have the media in place (whether it be film, paper or plexi-glass) to print the 

BO:     EPSON Stylus Pro 4800
BX:     EPSON Stylus Pro 4800
B8:      EPSON Stylus Pro 4880
BY:     EPSON Stylus Pro 4880
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test pattern on, before adjusting the distance setting. A DISTANCE OF 3 MM IS REQUIRED. 
This step is important in the process, because the distance between the Print Head and the “Media” 
used during the alignment process will need to be the exact distance between the Print Head and the 
garment that you will later print on. 3mm is the ideal setting and will give you the most crisp prints. 
If this is not recorded and adjusted correctly, your alignment process will not be as accurate for later 
printing.

3.	 Set the printer from Print to “Ready/Sheet” status by pressing the 
LEFT/PAPER button twice on the LCD Control Panel. The display 
will read “Ready” and display a “sheet of paper” icon. Only when in 
“Ready/Sheet” status can the Printer Assembly be moved freely.

4.	 Using the “RIGHT hand” button, shuffle through the UI screens 
until you get to the Mode Select screen. Confirm that the mode is set to Manual.

Press the “RIGHT hand” button on the UI again until you reach 5.	
the Manual  Mechanism Movement Utility (MMMU) screen.

6.	 Prepare the media printing on, to cover an area of 16” x 20” 
(41 cm x 53 cm) The Blazer EXPRESS can only perform one 
“Dot Size” at a time. A single Head Alignment procedure consists 
of 3 “Dot Sizes”. You will need to reload the media a total of three 
times per alignment. 
 
Align the media with the upper left hand corner of the Oversized 
Shirt Board (the bottom right hand corner if facing the front of the 
printer). Over hang the film 1 inch over the edge of the Shirt 
Board.

On the UI, browse to the MMMU screen. Under the heading Position, press the Index button. With 7.	
the Printer in the Index position, the Shirt Board is now directly beneath the Printer Assembly.

8.	 Next, go back to the LCD and change the printer mode to “Ready/Roll” 
mode by pressing the LEFT ARROW button twice. The display will 
read “READY” with a “roll of paper” icon.

Continue on with next step.9.	

READY
1

READY
1
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3. Send the Alignment Test Print
The following steps will cover sending the Print Head Alignment Test Print to the Blazer EXPRESS 
through the Epson LFP Remote Panel. 

1.	 Open the LFP Remote Panel by double-clicking on the Epson LFP 
icon on your Desktop. 
 
If not present, using your Start menu, select Programs > Epson > Epson LFP Remote 
Panel. 
  

2.	 From the main Window, select your printer from the drop down menu. 
 
Use the table below to determine your 
Epson print engine model. Your Serial 
Number will contain one of the four 
options after TJBE or TJB. The table will 
then outline which model your print 
engine is based on. 
 
 

 
 
 

Next, select Media Adjustment from the list of icons in the Remote Panel window. 3.	
 
NOTE: If you were performing a Power Cleaning or a Nozzle Check from the LFP Panel you would 
select Power Cleaning. 

WARNING: DO NOT change any values or run any Utilities other than those 
specified in this Manual. Your Blazer Series printer is a highly modified version of 
the Epson 4800/4880 and several custom settings were implemented at the factory 
level. If you modify any preset values, it may result in significant downtime and/or 
additional expense. 

BO:     EPSON Stylus Pro 4800
BX:     EPSON Stylus Pro 4800
B8:      EPSON Stylus Pro 4880
BY:     EPSON Stylus Pro 4880
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4.	 From the Media Adjustment screen select 
the Auto Adjustment icon.

In the Auto Adjustment section of the Media 5.	
Adjustment window, select Bi-Directional or 
Uni-Directional Alignment from the drop down 
menu. This selection will be determined in the 
earlier section of this chapter named “Types of 
Print Head Alignments and Which to Complete”. 
 
NOTE: DO NOT select any of the Auto Alignment 
options (in blue) on this screen.

IMPORTANT NOTE: If you 
notice SEVERE registration issues, 
we recommend you perform the Uni-Directional Alignment first, followed by a 
Bi-Directional Alignment. If you only wish to fine tune printer output, you can 
utilize the Bi-Directional Alignment as a standalone procedure. 
 

Select Dot Size in the Alignment Window.6.	

Within the Bi-Directional or Uni-Directional Alignment screens, place a check mark in the •	
first of the three boxes ONLY, below Dot Size. You will have to repeat the entire process two 
ADDITIONAL times, placing check marks in Dot Size 2 the second time and Dot Size 3 the third.

DO NOT modify 
any of the numbers 
in the boxes yet.
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Select Other for Media Type•	

Enter 2 for Paper Thickness•	

Select Standard from the Platen Gap drop-down menu. •	

WARNING: It is EXTREMELY crucial that  you only select ONE Dot Size per 
printout! The Blazer EXPRESS does not have enough bed length to print out all 
dot sizes in one run. If you do not deselect the other two check boxes, the printer 
will error out. If this happens refer to the Error codes in Chapter 15 - 
Troubleshooting. 
 

Double check that your film (or media) is still setup correctly. Also verify that the printer is still in 7.	
Index Position and in READY/ROLL Mode.

8.	 Press the Print button on the LFP Remote Panel Screen. 
 
The print process will take approximately 10 minutes. After the print is complete, be careful not to 
smudge the ink, it will be wet for a short while (depending on what media type you are printing on).

Continue on with the next step. 9.	

4. Selection and Entry of the Values
This portion of the Alignment process will be the most difficult. Determining and entering the correct 
values may be a bit confusing, but we have gone through great lengths to provide you with the best 
possible instructions that will help you understand the process and save you time and money, as well as 
getting the best possible print out of your new investment.

1. Study the alignment patterns.

Uni-Directional Alignment Pattern: 
If completing a Uni-Directional Alignment, you will notice a group of dotted lines marked either #1, #2 or 
#3, representing the Dot Size # your are reviewing. 
 
Each ink color (C, M, Y, Pk/Mk. Lc, Lm, Lk, LLk) will 
have it’s own set of lines, numbered 1-9 like the sample 
shown here. 
 
NOTE: The Lc, Lm, Lk and LLk represent the 4 white ink 
cartridges. 
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Bi-Directional Alignment Patterns: 
If performing a Bi-Directional Alignment, you will see lines for black and individual sets of color 
swatches for the colors. 
 
The black and light black ink colors (Pk/Mk and LK) will have it’s 
own set of lines like the sample shown here. 
 
 
 
 
The colors (C,M and Y) will each have color swatch set 
numbered 1-9 (cyan shown in this example). 
 
 
 
The 4 white cartridges will each have a white swatch set 
numbered 1-9 as well, labeled Lk, Lc, Lm, and LLk. 
 
 
NOTE: You will notice that there are two columns of identical groups. The first, or left hand column, will 
be used for calibration. The second column is only a duplicate image of the first column. 

 

2. Determining “Best” Values
These following sections will cover determining which numbers are the best from the printout and 
entering those values in the Alignment Screen. 

Determine “Best” Lines: Uni-Directional 
The first set of vertical lines begin with PK/MK, which refers to Black. 
Carefully examine the printed lines and determine the cleanest, straightest line. 
This line will then be entered (1-9) in the corresponding box in the LFP window. 
 
Determine “Best” Lines: Bi-Directional 
The “C” refers to the Cyan color swatch. Examine the Cyan 
swatches and select the one closest to a perfect rectangle with no 
gaps or breaks in color. Pick the best swatch number (1-9) to  enter 
in its corresponding box on the LFP Remote Panel screen. 

GOOD 
LINE

BAD 
LINE

BEST
SWATCH

WORST
SWATCH
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3. Entering in Values - Part 1 - Uni-Directional
Below is an example printout of a Uni-Directional Alignment pattern (Figure 1). Throughout the process 
of selecting the best values, for this example we will use a chart (Figure 2) to keep track of the selections 
and entries made to help you understand how the process is completed. Figures 3 and 4, in the later 
section - Step 3 - Entering Values - Part 2, will cover the process of entering Bi-Directional data. 

   
Prints that Line Up  (Uni-Directional) 
Observing the Alignment printout (Figure 1), the calibration is not 
far off and can observe the dashed lines lining up. In the worksheet 
(Figure 2) we have entered the best values for all 3 dot sizes. For 
now, only concentrate on the Dot Size #1 or column 1. 

Enter in the best values into the LFP Remote Panel screen •	
where the default of 5 is entered.

•	 Next, click the Save button.

Continue on to •	 Step 4 - Final Printout and Calibration.

Figure 1: Uni-Directional Alignment Printout

Figure 2: Uni-Directional Worksheet
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Prints that Do Not Line Up (Uni-Directional) 
If in the printout, none of the lines came out close to “good”, you would need to pick the closest and enter 
in that value multiple times for that particular color. This is where the process may get a bit tricky. 
NOTE: a worksheet is included for the following situations in doing a Bi-Directional Alignment - see 
Prints that Do Not Line Up (Bi-Directional). 

•	 First Entries: 
The process is completed properly by estimating 
how far the alignment is off by using the test 
printout and determining which way the Print 
Head needs to be aligned. In other words, your 
printout may be off to one side or the other; 
depending on which side, you can assume that a 
particular entry entered, in the LFP Remote 
Panel, will shift the alignment towards the 
desired side. Doing this properly will prevent 
having to complete the printout 3 or more times. 
 
Enter in the desired values and click the SAVE button.  All of the values 
will read 5 again, each time you click the Save button. 

•	 Second Entries: 
Entering in the corresponding value once, 
however, will not get the complete results on 
the printout (see Second Entries example to the 
right), leaving you to enter them again and 
again etc., until the alignment finally prints 
correct. 
 
Enter in the desired values 
and click the SAVE button. 

Third Entries:•	  
This example allows you to assume that you need to enter this number 
in 3 times (for example) before even needing to complete another 
printout. 
 
Enter in the desired values 
and click the SAVE button. 
 
NOTES: Each color may need different values entered, depending on 
which way the pattern line is off. For an example, the cyan set may be off to the right (enter 9s) and 
the magenta off to the left (enter 1s), while the yellow may be perfect (enter 5s). Completing the 
“estimation” process too many times can “over shoot” the alignment causing it to be off the 
opposite way. If the pattern is only slightly off (half of what you see in this example) only two 
entries may be necessary.

Continue on to •	 Step 4 - Final Printout and Calibration. 

For this pattern,  
you would enter 
9 for all values. If 
you were to print 
the alignment out 
again, the lines will 
look similar to the 
following Second 
Entries example.

For this pattern,  
you would enter 
1 for all values. If 
you were to print 
the alignment out 
again, the lines 
will look similar to 
the Second Entries 
example.

Pattern to Enter 9 Pattern to Enter 1

First Entries

Pattern to Enter 9 Pattern to Enter 1
The pattern is closer 
to the desired line,  
however, it is not close 
enough for a good 
alignment. Entering 
9 for all values again 
will bring the pattern 
closer, and without 
having to reprint the 
pattern.

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 
1 for all values again 
will bring the pattern 
closer, and without 
having to reprint the 
pattern.

Second Entries

After entering in either 
9 or 1 (depending on the 
pattern) a third time, the 
pattern will give you a 
much more desired print 
out of the alignment 
pattern, leaving you to only 
to printout the pattern twice 
for a final check, versus 
three or more times. 

Third Entries
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3. Entering in Values - Part 2 - Bi-Directional 
Below is an example printout of a Bi-Directional Alignment pattern (Figure 3). Throughout the process 
of selecting the best values, for this example we will use a chart (Figure 4) to keep track of the selections 
and entries made to help you understand how the process is completed. Figures 1 and 2, in the earlier 
section - Step 3 - Entering Values - Part 1, covers the process of entering Uni-Directional data.

Prints that Line Up  (Bi-Directional) 
Observing the Alignment printout above (Figure 3), the calibration is far off  from where it needs to 
be. If you had swatch options to choose from that looked like the example to the right, select the 
closest swatch to representing a full box, and enter those values into the LFP remote panel window. 

Enter in the best values into the LFP Remote Panel screen.•	

•	 Next, click the Save button.

Continue on to •	 Step 4 - Final Printout and Calibration.

Figure 3: Bi-Directional Alignment Printout
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Prints that Do Not Line Up (Bi-Directional) 
Observing the Alignment printout on the previous page (Figure 3), the calibration is far from where it 
needs to be. 
 
In the worksheet (Figure 4) we have entered 1 for all 3 dot 
sizes (columns). Notice on Figure 3, that the Cyan and LLK are 
slightly closer that the other 4 colors. On the worksheet, we 
have entered multiple values of the number 1, five times for all 
the colors and only 3 times for the Cyan and LLK which were 
a bit closer to the desired pattern. In this case you would leave 
the values at the default of 5 for the last 2 entry routines. 
 
To explain, if in the printout, none of the swatches or lines 
came out close to “good”, you would need to enter in a 
particular value (in this example 1) multiple times in the LFP 
remote panel, in order to shift the alignment into place (saving 
after each entry). This is where the process may get a bit tricky. 
In figure 3, there aren’t any good options to choose. The 
following section will explain what to choose and why and 
how many times to select and enter the values.  NOTE: The Pk/Mk and Lk show as lines on the pattern. 
refer to the Uni-Directional description for these 2 colors.

•	 First Entries: 
The process is completed properly by 
estimating how far the alignment is off by 
using the test printout and determining which 
way the Print Head needs to be aligned. In 
other words, your printout may be off to one 
side or the other; depending on which side, 
you can assume that a particular entry entered, 
in the LFP Remote Panel, will shift the 
alignment towards the desired side. Doing this 
properly will prevent having to complete the 
printout 3 or more times. 
 
Enter in the desired values and click the SAVE button. Each time you 
click the Save button, all of the values will read 5 again.

•	 Second Entries: 
Entering in the corresponding value once, 
however, will not get the complete results 
on the printout (see Second Entries 
example to the right), leaving you to 
enter them again and again etc., until the 
alignment finally prints correct. 
 
 
Enter in the desired values and click the SAVE button.

Figure 4: Bi-Directional Worksheet-Part 1

For this pattern,  
you would enter 
9 for all values. If 
you were to print 
the alignment out 
again, the patterns 
will look similar to 
the Second Entries 
example.

For this pattern,  
you would enter 
1 for all values. If 
you were to print 
the alignment out 
again, the patterns 
will look similar to 
the Second Entries 
example.

Pattern to Enter 9 Pattern to Enter 1
First Entries

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 9 
for all values again will 
bring the pattern closer, 
and without having to 
reprint the pattern.

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 1 
for all values again will 
bring the pattern closer, 
and without having to 
reprint the pattern.

Pattern to Enter 9 Pattern to Enter 1
Second Entries
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•	 Third Entries: 
This example allows you to assume 
that you needed to enter the 
correseponding number 
in 3 times before even needing to 
complete another printout. 
 
 
 
 
Enter in the desired values and click the SAVE button. 

•	 Conclusion: 
After entering the multiple 
values of “1” in the previous 
worksheet (Figure 4), the 
resulting printout (Figure 5) 
shows a much tighter 
alignment of the blocks. 
 
Now that you are able to 
visualize how entering 
multiple values brings the 
blocks together, refer to the 
next worksheet of values 
(Figure 6) entered for the last 
entries to complete the 
process. 
 
NOTES: Each color may 
need different values entered, 
depending on which way the 
pattern line is off. For an 
example, the cyan set may be 
off to the right (enter 9s) and the magenta off to the left 
(enter 1s), while the yellow may be perfect (enter 5s). 
Completing the “estimation” process too many times can 
“over shoot” the alignment causing it to be off the opposite 
way. If the pattern is only slightly off (half of what you see 
in this example) only two entries may be necessary. 
 
*** A Full worksheet has been supplied for your use at the 
end of the Print Head Alignments Chapter. 

Continue on to •	 Step 4 - Final Printout and Calibration.

Pattern to Enter 9 Pattern to Enter 1
Third Entries

After entering in 9 
three times, the pattern 
will give you a much 
more desired print 
out of the alignment 
pattern, leaving you 
to only printout the 
pattern twice versus 
three or more times. 

After entering in 1 
three times, the pattern 
will give you a much 
more desired print 
out of the alignment 
pattern, leaving you 
to only printout the 
pattern twice versus 
three or more times. 

Figure 5: Bi-Directional Alignment Printout - Last

Figure 6: Bi-Directional Worksheet-Part 2
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5. Final Printout and Calibration
At this point you should have made all of your entries in the LFP Remote Panel and Saved. If you exit this 
screen without saving your data, it will be lost. If this should occur, return to the correct alignment screen, 
re-enter your numbers and select Save.

Turn off your Blazer Express and Power Back on.1.	  
 
After completing and saving your settings in the LFP Remote panel, you MUST turn OFF the printer. 
You CANNOT print or perform any additional maintenance routines on your machine without 
powering OFF first. You can do this by simply turning OFF the power using the User Interface OFF 
button.

Go back to Step 2 - Printer Setup 2.	
 
In order to get the final results of your previous calibrations, a new Alignment Pattern Print must be 
completed again. You will have to re-set up the film, and go through the entire process again. If you 
completed the previous steps correctly, your final printout should be good enough to enter the values, 
click save and continue with the next step - Step 5 - Repeat for Dot Size # 2. 
 
NOTE: You can leave the LFP Remote Panel Open until the entire Alignment Process is complete.

Once you have entered in the correct values, Dot Size #1 is complete.3.	

 

6. Restart for Next Dot Size
You must now restart the printer and setup the printer for Dot Size #2 in the LFP Remote Panel Screen. 
Go back to the previous section, Step 2 - Printer Setup  and repeat the entire process.

YOU MUST COMPLETE THE ENITIRE PROCESS FOR ALL THREE DOT SIZES TO 
ENSURE ACCURATE PRINT OUTPUT. 
 
NOTE: There is a good chance that Dot Sizes #2 and #3 are much closer to alignment than Dot Size #1. 
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BLAZER PRO ALIGNMENTS
This section will cover the execution of 
Uni-Directional and Bi-Directional Print 
Head Alignments for the Blazer PRO. For 
steps on completing these alignments for 
the Blazer EXPRESS, refer to the earlier 
section of this chapter named Blazer 
EXPRESS Alignments. 

1. Install the LFP Remote Panel
The alignment procedure is completed by using the Epson LFP Remote Panel. The LFP Remote Panel is 
a stand alone application designed to give you several utility functions, including the Nozzle Check and 
Power Cleaning utilities, right from your computer. The LFP Remote Panel is included with the Epson 
Stylus Pro Driver CD that came with your Blazer Series printer.

Download On Web 
The LFP Remote Panel is also available to download from Epson’s website: www.epson.com. Select 
Drivers & Support, then select the applicable version for the Stylus Pro based on the Operating System 
(Windows XP, Vista, 2000 or MAC). 
 
To determine which Epson Print Engine your printer is equipped with, locate the printer serial number and 
compare it to the following table. 
  
If your Serial Number contains the following as the 4th and 5th 
digits after TJB. Download the latest LFP Remote Panel for your 
particular model.
 
 

2. Printer Setup
To continue the Print Head Alignment procedure, you must have the Epson LFP Remote Panel installed 
and the computer connected to the printer. The printer must be in “Ready/ROLL” mode and be in the 
Index Position with the film or other media (to print on) in place. If the printer is not in the correct mode, 
you will receive a “Communication Failed” error. You will also need to determine the Print Head height 
that you will use permanently while printing. 

Power up the printer (if not powered up already).1.	

BO:     EPSON Stylus Pro 4800
BX:     EPSON Stylus Pro 4800
B8:      EPSON Stylus Pro 4880
BY:     EPSON Stylus Pro 4880
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Check the distance between the Print Head and the 2.	 Shirt Board. 
 
For this procedure you will need the 3 standard-size Shirt Boards loaded onto the Blazer PRO. The 
Shirt Board must have the media in place (whether it be film, paper or plexi-glass) to print the test 
pattern on, before adjusting the distance setting. A DISTANCE OF 3 MM IS REQUIRED. This 
step is important in the process, because the distance between the Print Head and the “Media” used 
during the alignment process will need to be the exact distance between the Print Head and the 
garment that you will later print on. 3mm is the ideal setting and will give you the most crisp prints. 
If this is not recorded and adjusted correctly, your alignment process will not be as accurate for later 
printing. 

3.	 Set the printer from Print to “Ready/Sheet” status by pressing the 
LEFT/PAPER button twice on the LCD Control Panel. The display 
will read “Ready” and display a “sheet of paper” icon. Only when in 
“Ready/Sheet” status can the Printer Assembly be moved freely. 

4.	 Using the “RIGHT hand” button, shuffle through the UI screens 
until you get to the Mode Select screen. Confirm that the mode is set to Manual. 

Press the “RIGHT hand” button on the UI again until you reach 5.	
the Manual  Mechanism Movement Utility (MMMU) screen. 

Prepare the media that you are printing on. 6.	
The Blazer PRO can print out all 3 “Dot Sizes” in 1 media layout of three 8 1/2 x 11” pieces of 
media. The measurements of where the media need to be located are different for Uni-Directional and 
Bi-Directional Alignments. Refer to the Introduction of this chapter to determine which alignment is 
needed. 

•	 Uni-Directional Media Layout. 
Align the media with the upper left hand corner of the Shirt Board 
(the bottom right hand corner if facing the front of the printer). Over 
hang the film 1/2” over the right edge of the Shirt Board. 
 
 
Measure from the end of the platen (where the metal 
platen handle is attached), 14”. This is where the first 
sheet needs to be placed. The second sheet will be at 25” 
and the third at 38.5”. 
 

•	 Bi-Directional Media Layout 

READY
1

14” 25” 38.5”
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Align the media with the upper left hand corner of the Shirt Board (the bottom right hand corner if 
facing the front of the printer). Over hang the film 1/2” over the right edge of the Shirt Board. 
 
 
 
 
Measure from the end of the platen (where the metal 
platen handle is attached), 15.5”. This is where the first 
sheet needs to be placed. The second sheet will be at 
27.5” and the third at 38.5”. 
 
 

On the UI, browse to the MMMU screen. Under the heading 7.	 Position, press the Index Button. With 
the printer in the Index Position, the Shirt Board(s) is now directly beneath the Printer Assembly. 

8.	 Next, go back to the LCD Display Control Panel and change the printer 
mode to “Ready/Roll” mode by pressing the LEFT ARROW button 
twice. The display will read “READY” with a “roll of paper” icon. 
Continue on with next section. 

Continue on with next step. 9.	

3. Send the Alignment Test Print
The following steps will cover sending the Print Head Alignment Test Print to the Blazer EXPRESS 
through the Epson LFP Remote Panel. 

1.	 Open the LFP Remote Panel by double-clicking on the Epson LFP 
icon on your Desktop. 
 
If not present, using your Start menu, select Programs > Epson > Epson LFP Remote 
Panel. 
  

15.5” 27.5” 38 1/2”

READY
1
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2.	 From the main Window, select your printer from the drop down menu. 
 
Use the table below to determine your 
Epson print engine model. Your Serial 
Number will contain one of the four 
options after TJBE. The table will then 
outline which model your print engine is 
based on.

Next, select Media Adjustment from the list of icons in the Remote Panel window. 3.	
 
NOTE: If you were performing a Power Cleaning or a Nozzle Check from the LFP Panel you would 
select Power Cleaning.

WARNING: DO NOT change any values or run any Utilities other than those 
specified in this Manual. Your Blazer Series printer is a highly modified version of 
the Epson 4800/4880 and several custom settings were implemented at the factory 
level. If you modify any preset values, it may result in significant downtime and/or 
additional expense. 
 

4.	 From the Media Adjustment screen 
select the Auto Adjustment icon.

In the Auto Adjustment section of the 5.	
Media Adjustment window, select 
Bi-Directional or Uni-Directional 
Alignment from the drop down menu. 
This selection will be determined in the 
earlier section of this chapter named 
“Types of Print Head Alignments and 
Which to Complete”. 
 
NOTE: DO NOT select any of the Auto 
Alignment options (in blue) on this 
screen. 

BO:     EPSON Stylus Pro 4800
BX:     EPSON Stylus Pro 4800
B8:      EPSON Stylus Pro 4880
BY:     EPSON Stylus Pro 4880
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IMPORTANT NOTE: If you notice SEVERE registration issues, we 
recommend you perform the Uni-Directional Alignment first, followed by a Bi-
Directional Alignment. If you only wish to fine tune printer output, you can utilize 
the Bi-Directional Alignment as a standalone procedure. 
 

Select All of the Dot Size #s and complete other settings.6.	

•	 Within the Bi-Directional or Uni-Directional Alignment screens, place a check mark in all three of 
the Dot Size check boxes, under Dot Size.  

Next, select Other for Media Type•	

Enter 2 for Paper Thickness•	

Select Standard from the Platen Gap drop-down menu. •	

DO NOT modify any of the 

numbers in the boxes yet.
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Double check that your film (or media) is still setup correctly. Also verify that the printer is still in 7.	
Index Position and in READY/ROLL Mode.

8.	 Press the Print button on the LFP Remote Panel Screen. 
The print process will take approximately 10 minutes. 
After the print is complete, be careful not to smudge the ink, it will be wet for a short while 
(depending on what media type you are printing on).

Continue on with the next step. 9.	
 

4. Selection and Entry of the Values
This portion of the Alignment process will be the most difficult. Determining and entering the correct 
values may be a bit confusing, but we have gone through great lengths to provide you with the best 
possible instructions that will help you understand the process and save you time and money, as well as 
getting the best possible print out of your new investment.

1. Study the alignment patterns.

Uni-Directional Alignment Pattern: 
If completing a Uni-Directional Alignment, you will notice a group of dotted lines marked either #1, #2 or 
#3, representing the Dot Size # your are reviewing. 
 
Each ink color (C, M, Y, Pk/Mk. Lc, Lm, Lk, LLk) will 
have it’s own set of lines, numbered 1-9 like the sample 
shown here. 
 
NOTE: The Lc, Lm, Lk and LLk represent the 4 white ink 
cartridges. 
 
 
Bi-Directional Alignment Patterns: 
If performing a Bi-Directional Alignment, you will see lines for black and individual sets of color 
swatches for the colors. 
 
The black and light black ink colors (Pk/Mk and LK) will have it’s 
own set of lines like the sample shown here. 
 
 
 
 
The colors (C,M and Y) will each have color swatch set 
numbered 1-9 (cyan shown in this example). 
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The 4 white cartridges will each have a white swatch set 
numbered 1-9 as well, labeled Lk, Lc, Lm, and LLk. 
 

 
NOTE: You will notice that there are two columns of identical groups. The first, or left hand column, will 
be used for calibration. The second column is only a duplicate image of the first column. 

 

2. Determining “Best” Values
These following sections will cover determining which numbers are the best from the printout and 
entering those values in the Alignment Screen. 

Determine “Best” Lines: Uni-Directional 
The first set of vertical lines begin with PK/MK, which refers to Black. 
Carefully examine the printed lines and determine the cleanest, straightest line. 
This line will then be entered (1-9) in the corresponding box in the LFP window. 
 
Determine “Best” Lines: Bi-Directional 
The “C” refers to the Cyan color swatch. Examine the Cyan 
swatches and select the one closest to a perfect rectangle with no 
gaps or breaks in color. Pick the best swatch number (1-9) to  enter 
in its corresponding box on the LFP Remote Panel screen.

 

3. Entering in Values - Part 1 - Uni-Directional
On the following page is an example printout of a Uni-Directional Alignment pattern (Figure 1). 
Throughout the process of selecting the best values, for this example we will use a chart (Figure 2) to 
keep track of the selections and entries made to help you understand how the process is completed. 
Figures 3 and 4, in the later section - Step 3 - Entering Values - Part 2, will cover the process of entering 
Bi-Directional data. 

GOOD 
LINE

BAD 
LINE

BEST
SWATCH

WORST
SWATCH
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Prints that Line Up  (Uni-Directional) 
Observing the Alignment printout (Figure 1), the calibration is not 
far off and can observe the dashed lines lining up. In the worksheet 
(Figure 2) we have entered the best values for all 3 dot sizes.  
 

Enter in the best values into the LFP Remote Panel screen •	
where the default of 5 is entered (for all 3 dot sizes).

•	 Next, click the Save button.

Continue on to •	 Step 4 - Final Printout and Calibration. 
 

 

Figure 1: Uni-Directional Alignment Printout

Figure 2: Uni-Directional Worksheet
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Prints that Do Not Line Up (Uni-Directional) 
If in the printout, none of the lines came out close to “good”, you would need to pick the closest and enter 
in that value multiple times for that particular color. This is where the process may get a bit tricky. 
NOTE: a worksheet is included for the following situations in doing a Bi-Directional Alignment - see 
Prints that Do Not Line Up (Bi-Directional). 

•	 First Entries: 
The process is completed properly by estimating 
how far the alignment is off by using the test 
printout and determining which way the Print 
Head needs to be aligned. In other words, your 
printout may be off to one side or the other; 
depending on which side, you can assume that a 
particular entry entered, in the LFP Remote 
Panel, will shift the alignment towards the 
desired side. Doing this properly will prevent 
having to complete the printout 3 or more times. 
 
Enter in the desired values (for all 3 dot sizes) and click the SAVE button.  
All of the values will read 5 again, each time you click the Save button. 

•	 Second Entries: 
Entering in the corresponding value once, 
however, will not get the complete results on 
the printout (see Second Entries example to the 
right), leaving you to enter them again and 
again etc., until the alignment finally prints 
correct. 
 
 
 
 
Enter in the desired values (for all 3 dot sizes) and click the SAVE button. 
 

Third Entries:•	  
This example allows you to assume that you need to enter this number 
in 3 times (for example) before even needing to complete another 
printout. 
 
 
 
 
 
Enter in the desired values (for all 3 dot sizes) and click the SAVE button. 
 
NOTES: Each color may need different values entered, depending on which way the pattern line is 

For this pattern,  
you would enter 
9 for all values. If 
you were to print 
the alignment out 
again, the lines will 
look similar to the 
following Second 
Entries example.

For this pattern,  
you would enter 
1 for all values. If 
you were to print 
the alignment out 
again, the lines 
will look similar to 
the Second Entries 
example.

Pattern to Enter 9 Pattern to Enter 1

First Entries

Pattern to Enter 9 Pattern to Enter 1
The pattern is closer 
to the desired line,  
however, it is not close 
enough for a good 
alignment. Entering 
9 for all values again 
will bring the pattern 
closer, and without 
having to reprint the 
pattern.

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 
1 for all values again 
will bring the pattern 
closer, and without 
having to reprint the 
pattern.

Second Entries

After entering in either 
9 or 1 (depending on the 
pattern) a third time, the 
pattern will give you a 
much more desired print 
out of the alignment 
pattern, leaving you to only 
to printout the pattern twice 
for a final check, versus 
three or more times. 

Third Entries
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off. For an example, the cyan set may be off to the right (enter 9s) and the magenta off to the left 
(enter 1s), while the yellow may be perfect (enter 5s). Completing the “estimation” process too 
many times can “over shoot” the alignment causing it to be off the opposite way. If the pattern is 
only slightly off (half of what you see in this example) only two entries may be necessary. 

Continue on to •	 Step 4 - Final Printout and Calibration.  
 
 

3. Entering in Values - Part 2 - Bi-Directional 
Below is an example printout of a Bi-Directional Alignment pattern (Figure 3). Throughout the process 
of selecting the best values, for this example we will use a chart (Figure 4) to keep track of the selections 
and entries made to help you understand how the process is completed. Figures 1 and 2, in the earlier 
section - Step 3 - Entering Values - Part 1, covers the process of entering Uni-Directional data.

Figure 3: Bi-Directional Alignment Printout
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Prints that Line Up  (Bi-Directional) 
Observing the Alignment printout above (Figure 3), the calibration is far off  from where it needs to 
be. If you had swatch options to choose from that looked like the example to the right, select the 
closest swatch to representing a full box, and enter those values into the LFP remote panel window. 

Enter in the best values into the LFP Remote Panel screen (for all 3 dot sizes).•	

•	 Next, click the Save button.

Continue on to •	 Step 4 - Final Printout and Calibration.

Prints that Do Not Line Up (Bi-Directional) 
Observing the Alignment printout on the previous page (Figure 3), the calibration is far from where it 
needs to be. 
 
In the worksheet (Figure 4) we have entered 1 for all 3 dot 
sizes (columns). Notice on Figure 3, that the Cyan and LLK 
are slightly closer that the other 4 colors. On the worksheet, 
we have entered multiple values of the number 1, five times 
for all the colors and only 3 times for the Cyan and LLK 
which were a bit closer to the desired pattern. In this case you 
would leave the values at the default of 5 for C and LLK of 
the last 2 entry routines. Entering 5 means no change. 
 
To explain, if in the printout, none of the swatches or lines 
came out close to “good”, you would need to enter in a 
particular value (in this example 1) multiple times in the LFP 
remote panel, in order to shift the alignment into place (saving 
after each entry). This is where the process may get a bit 
tricky. In figure 3, there aren’t any good options to choose. 
The following section will explain what to choose and why 
and how many times to select and enter the values.  NOTE: 
The Pk/Mk and Lk show as lines on the pattern. refer to the 
Uni-Directional description for these 2 colors. 

 

•	 First Entries: 
The process is completed properly by 
estimating how far the alignment is off by 
using the test printout and determining which 
way the Print Head needs to be aligned. In 
other words, your printout may be off to one 
side or the other; depending on which side, 
you can assume that a particular entry entered, 
in the LFP Remote Panel, will shift the 
alignment towards the desired side. Doing this 
properly will prevent having to complete the 
printout 3 or more times. 

Figure 4: Bi-Directional Worksheet-Part 1

For this pattern,  
you would enter 
9 for all values. If 
you were to print 
the alignment out 
again, the patterns 
will look similar to 
the Second Entries 
example.

For this pattern,  
you would enter 
1 for all values. If 
you were to print 
the alignment out 
again, the patterns 
will look similar to 
the Second Entries 
example.

Pattern to Enter 9 Pattern to Enter 1
First Entries
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Enter in the desired values (for all 3 dot sizes) and click the SAVE button. 
Each time you click the Save button, all of the values will read 5 again. 

•	 Second Entries: 
Entering in the corresponding value once, 
however, will not get the complete results 
on the printout (see Second Entries 
example to the right), leaving you to 
enter them again and again etc., until the 
alignment finally prints correct. 
 
 
Enter in the desired values (for all 3 dot sizes) and click the SAVE button. 

•	 Third Entries: 
This example allows you to assume 
that you needed to enter the 
corresponding number 
in 3 times before even needing to 
complete another printout. 
 
 
 
Enter in the desired values (for all 3 dot sizes) and click the SAVE button. 

•	 Conclusion: 
After entering the multiple 
values of “1” in the previous 
worksheet (Figure 4), the 
resulting printout (Figure 5) 
shows a much tighter 
alignment of the blocks. 
 
Now that you are able to 
visualize how entering 
multiple values brings the 
blocks together, refer to the 
next worksheet of values 
(Figure 6) entered for the last 
entries to complete the 
process. 
 
NOTES: Each color may 
need different values entered, 
depending on which way the 
pattern line is off. For an 

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 9 
for all values again will 
bring the pattern closer, 
and without having to 
reprint the pattern.

The pattern is closer 
to the desired box,  
however, it is not close 
enough for a good 
alignment. Entering 1 
for all values again will 
bring the pattern closer, 
and without having to 
reprint the pattern.

Pattern to Enter 9 Pattern to Enter 1
Second Entries

Pattern to Enter 9 Pattern to Enter 1
Third Entries

After entering in 9 
three times, the pattern 
will give you a much 
more desired print 
out of the alignment 
pattern, leaving you 
to only printout the 
pattern twice versus 
three or more times. 

After entering in 1 
three times, the pattern 
will give you a much 
more desired print 
out of the alignment 
pattern, leaving you 
to only printout the 
pattern twice versus 
three or more times. 

Figure 5: Bi-Directional Alignment Printout - Last
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example, the cyan set may be off to the right (enter 9s) and the 
magenta off to the left (enter 1s), while the yellow may be 
perfect (enter 5s). Completing the “estimation” process too 
many times can “over shoot” the alignment causing it to be 
off the opposite way. If the pattern is only slightly off (half 
of what you see in this example) only two entries may be 
necessary. 
 

Continue on to •	 Step 5 - Final Printout and Calibration. 
 
 
 

5. Final Printout and Calibration
At this point you should have made all of your entries in the LFP Remote Panel and Saved. If you exit this 
screen without saving your data, it will be lost. If this should occur, return to the correct alignment screen, 
re-enter your numbers and select Save.

Turn off your Blazer PRO and Power Back on.1.	  
 
After completing and saving your settings in the LFP Remote panel, you MUST turn OFF the printer. 
You CANNOT print or perform any additional maintenance routines on your machine without 
powering OFF first. You can do this by simply turning OFF the power using the User Interface OFF 
button.

Go back to Step 2 - Printer Setup 2.	
 
In order to get the final results of your previous calibrations, a new Alignment Pattern Print must be 
completed again (as we showed you in Step 3 - Conclusion. You will have to re-set up the film or 
media and go through the entire process again. If you completed the previous steps correctly, your 
second printout should be good enough to enter the values, click save and be done with the alignment 
process. 
 
NOTE: You can leave the LFP Remote Panel Open until the entire Alignment Process is complete.

 
For your convenience, a copy of the Print Head Calibration Worksheet has been provided for you on the 
next page. Please make copies and save original as a master copy. 

Figure 6: Bi-Directional Worksheet-Part 2
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Chapter 10

Software Overview
Graphic files can be large and the data sent from FastRIP to the printer is sent at a very high speed (high 
data rate). In order to get the fastest speed and have the fewest communication problems with the printer, 
you need a fast computer. You can use a standard desktop computer or even a laptop, but for the best 
performance, the computer should have at least 1GB of RAM (2 GB is recommended). If you want to 
continue working and creating artwork while the printer is printing, having a higher amount of RAM is 
essential. Ideally you should have a dedicated computer for use with this printer.

While sending data to the printer using a USB cable, do not plug in any other USB devices other than a 
mouse and the FastARTIST/RIP dongle. USB busses do not have a lot of power and the more devices 
plugged in, the more power drain will occur. In order to run FastARTIST, you MUST use a Windows-
based Operating System such as XP, 2000 or Vista (ME is not supported). MAC users can create their 
artwork in their favorite program and simply network or copy the files over to the PC “workstation.”

There are several videos online that deal with art setup, editing and special features of 
FastARTIST as well as working in Corel, Adobe Illustrator and Photoshop. Refer to 
Chapter 17 - Product Support for information on how to log on to our support site and 
view these videos. Most, if not all of these videos are also included on the Training 
DVD provided with the FastARTIST Package.

Graphics and RIP Software
Your printer includes the latest versions of both FastARTIST and 
FastRIP. FastARTIST is a graphics application that will make 
preparing an image to print, as easy as a click or two of the mouse. 
With “one-click wonder” Underbasing and simple clipping features, 
FastARTIST can help ease the transition if you are not familiar with 
graphics applications.

For avid users of Photoshop, CorelDRAW, Illustrator, etc., you may 
choose to work within your graphics application of choice and still 
set up the image properly for printing. However, all images MUST be 
either Imported into FastARTIST from another graphics application 
or created in FastARTIST if you will be printing with white ink. The 
file to be imported must be flattened RGB files and have a 150 dpi resolution or more.

Once a graphic file is ready to print, it needs to be sent to special software called a RIP (Raster Image 
Processor.) This software tells the machine what image resolution to use, how many passes of each 
color to make, when and how to print the Underbase and Highlight and how much ink to lay down. To 
do all of this for you, we have included with your printer package our own very special RIP program 
called FastRIP. YOU MUST TURN OFF ALL SCREENSAVERS AND ENERGY SAVING WHEN 
PRINGING! For information about using FastARTIST and FastRIP, consult the FastARTIST User’s 
Manual.
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FastARTIST and FastRIP
Not only do the printer and ink makes the T-Jet Blazer 
Series Printers so unique, but also the software that drives 
them. As mentioned earlier, your printer comes with two 
very powerful programs called FastARTIST and FastRIP. 
FastARTIST is a complete graphics program much like 
CorelDRAW and Adobe Photoshop. You can use it for all 
of your graphic image creation or you can create images 
in CorelDRAW or Adobe Photoshop and import them into 
FastARTIST to take advantage of the one-click Underbase 
Wizard or simple clipping options.

FastRIP
FastRIP is a driver specifically designed for Inkjet-to-Garment printers like your T-Jet Blazer Series 
printer. A RIP converts the data from a graphics program to computer code called Postscript. This 
powerful language allows much more control over a printer, making the following possible:
 

Previewing printable images•	

Control over the amount of ink used•	

Faster print speeds compared to a •	
standard printer driver

FastRIP is extremely easy to use and is almost 
transparent when working with the Fast T-Jet Blazer 
Express.

IMPORTANT NOTE: 
It is important to have a basic knowledge of both 
FastARTIST and FastRIP. Although the manuals may 
seem very large, don’t be concerned by the size. You do not 
need to know everything to get started.
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Using Computer Graphics Software
In order to print a good looking image on a shirt, you need a good piece of artwork. The customer 
typically has no idea about the type or quality of artwork needed so you are often stuck with inferior 
designs. If you don’t have computer graphics experience, you might print this bad artwork and then blame 
your printer for the poor quality image.

We often hear from first time users that they did not think they would need to know about graphics 
software. Getting a great image onto a garment, however, is not the same as taking your digital camera’s 
memory card to the drug store and getting pictures made. Yes, it would seem that simple and it CAN be, 
but in the world of T-Shirt printing there are many variables.

Visit our support site for videos on working with FastARTIST along with Corel, Adobe 
Illustrator and Photoshop. Refer to Chapter 17 - Product Support for information on 
how to log on to our support site and view these videos.

Image Types
Vector
Currently there are two types of graphics programs – Vector 
and Bitmap. FastARTIST, CorelDRAW, Adobe Illustrator 
and Macromedia Freehand are called vector programs. Vector 
programs create images based on shapes somewhat like a 
coloring book. They typically have hundreds or even thousands 
of typefaces and many have extensive “coloring book” type 
stock clip art that you can use to create artwork.

Vector programs are generally used for images with a hard edge 
like race designs, school mascots, corporate logos, etc.
 

Pixel Based Bitmap
Programs like FastARTIST and Adobe Photoshop 
are called pixel, or raster based programs, and work 
great for photographic images. Bitmap applications 
can lighten, darken, sharpen and even create images. 
Photoshop is a common graphics program used by 
many for manipulating images, but FastARTIST also 
contains similar editing tools. Images with lots of 
gradations or that are photorealistic are generally created 
and manipulated in programs such as FastARTIST and 
Photoshop. 
 
Note: FastARTIST is both a bitmap and vector graphic program!
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Summary
If you intend to create your own artwork, then we recommend that you have both a vector and bitmap 
program (one will work fine but will limit what you can do). The vector program will be used for working 
with shapes, text and edges, while the bitmap program will be used for any photographic or detailed 
images. If you don’t have two applications, or don’t wish to spend the money to purchase one of both 
needed programs, FastARTIST is the perfect solution because it will work with both types of images.

FastARTIST can be used to create the entire image if needed. With similar tools to CorelDRAW and 
Photoshop, those already familiar with other graphics programs can quickly master FastARTIST.

Editing Bitmap Artwork in FastARTIST/
Photoshop
The following sections gives Tips and suggestions for creating artwork suitable for printing with your 
new Blazer Series printer. Remember, if you are proficient in a graphics program other than the new 
FastARTIST- create the images where you are most comfortable. For advanced users of programs such as 
Photoshop and CorelDRAW, the entire image can be set up to print and then Imported into FastARTIST 
for printing a White Underbase or Highlight White. Remember that in most cases, the image to be 
imported into FastARTIST must be flattened RGB files and have a 150 dpi resolution or more. There is an 
exception if printing on garments with no white or if printing on only 1 garment color and using a cartoon 
print mode. This exception allows you to import a transparent psd file. 

IMPORTANT NOTE: 
The Underbase and Highlight White options are only available when printing from 
within FastARTIST. 

Visit our support site for videos on working with FastARTIST and how to setup and 
import images as well as some advanced techniques. Refer to Chapter 17 - Product 
Support for information on how to log on to our support site and view these videos.

Besides the ability to work with vector based images such as hard edge graphics, clip art and font 
manipulation, FastARTIST will do a lot of basic pixel editing functions necessary when the customer 
gives you a Pixel/Bitmap file such as: JPEG, GIF, TIFF or PSD.

Generally, a short run of photorealistic images is not profitable when Screen Printing. However, should a 
customer want a picture of the entire team on a shirt - no problem! One of the T-Jet’s major strengths is 
the ability to print short runs of photorealistic images.

A common problem in the T-Shirt business is that customers need high resolution images, yet often 
all they have is artwork that is small and low resolution. It is MANDATORY that you learn how to 
make ANY artwork the correct size and resolution, besides knowing how to make the image brighter 
(most images are dull) with good color saturation. In reality, this may be the ONLY time you utilize the 
FastARTIST or Photoshop image editing tools.



Chapter 10 - Software Overview 

85
Version 5.5  Revised January, 2009

A Quick Note about Photoshop
As you begin to work with different kinds of images in different formats and resolutions, it is very 
important to have the proper tools necessary to clean up and make images “print ready.” Even though 
FastARTIST is a very powerful graphics program, there may be times when a program such as Photoshop 
is required for specific editing functions. Don’t worry, Photoshop works hand-in-hand with FastARTIST, 
making it a very complimentary program to have when working with bitmap images.

The goal here is to cover the basics of image editing, so that you can print the best looking images 
possible. When first learning graphics programs, the process may seem a bit overwhelming, but don’t get 
frustrated. Just keep in mind the 80/30 rule: you use 30% of the program 80% of the time. But, in this 
case, it’s actually more like a 90/10 rule.

So, you might be asking why you need Photoshop at all if you have FastARTIST? In a nutshell, you can 
do almost everything you need with FastARTIST, but Photoshop is much more powerful when creating 
an image with lots of photographic components. Plus, Photoshop is much more powerful when fixing and 
cleaning up poor quality artwork. 

Photoshop is the flagship product of Adobe Systems at www.adobe.com. The program retails for around 
$650 and, as of this writing, version 9.0 CS3 is the most current version. It is always nice to have the 
latest and greatest version, but frankly, you can do everything mentioned here with version 5.5 or higher. 
If you are a student, teacher or work for a school, you may be eligible for an “Educator Version” from 
places like www.academicsuperstore.com.
 
 

Check File Mode
This is the step that most new users will overlook when opening a file. It is very important to note the 
file attributes when first opening a file as well as determining the file mode. Note whether it is CMYK or 
RGB and make changes if necessary. Because the T-Jet does not print spot color, the file must be in RGB 
mode. 

If the file is CMYK from another application, FastARTIST will Open/Import it as RGB. However, 
FastARTIST will open the file at a larger resolution than normal, drastically increasing the file size. For 
best results, convert the file to RGB (if you can) before importing it into FastARTIST.

Yes, Photoshop will do process color separations called CMYK, but for file manipulation and adjustment 
you should work in RGB mode. To check the Mode of the file in Photoshop, go to Image > Mode. If 
CMYK is checked, click on RGB.  NOTE: changing modes will flatten the file if not flattened already.

 

Check File Size and Resolution
FastARTIST and Photoshop will let you “Open” a wide variety of files including, TIFF, JPEG, GIF, EPS, 
PSD, AI and others. If you open a file that is vector based, such as one from Adobe Illustrator, Photoshop 
will convert the file from mathematical vectors to small pixels. This is called Rasterizing a file.
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The important point here is to keep the file resolution high enough for the image to remain sharp. It is 
generally accepted that a file needs to be at 300 dpi at the final size in order for it to remain crisp.

In T-Shirt printing, you can get away with file resolutions of 150 to 300 dpi at the final size.

 

You MUST know the actual resolution and size of 
the image, otherwise you could be working on a very small file 
and not know it. In FastARTIST, Import a photorealistic file and 
click on Bitmap > Image Size. This will display the actual size of 
the image in terms of total X and Y pixels and Pixels per Inch 
which is the equivalent of dpi. If the resolution is not sufficient, 
enter any changes and click on Apply. Remember that an 
appropriate image size should be 150 to 300 dpi.
 
 
 

If the images physical size is too small, resize the image before changing the resolution. After the image 
size is adjusted, click on Bitmap > Image Size. Change the resolution and select Bicubic. Click Apply.
 
 

In Photoshop, go to Image > Image Size. If it 
says pixels per cm, change this to inches and then enter the 
image’s intended final print size. Re-adjust the resolution 
and make sure that Bicubic is selected. The physical size 
should be the final print size.

If you have an image that is very low resolution, your only 
real choice is to change the image size and resolution. This 
is often referred to as “Upsampling.” Photoshop upsamples 
the image, but in doing so, it must make calculations where 
to place the extra pixels and what color to make the pixels. 
Images may have softer edges when upsampled, but they will also be less pixilated! If you can get a 
higher resolution file from the client, do so.

CorelDRAW and Adobe Illustrator have similar Image Size functions.
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IMPORTANT POINT:
If the original file is low resolution 
and not the final size, you need to 
upsample the file to the final print size 
with a resolution of 150 to 300 dpi. A 
resolution of 150 dpi is OK for photos 

and images without hard edges and resolutions of 300 
to 350 are recommended where there is lettering or 
sharp edges. After upsampling, you can work on the 
file and add type or other elements. It is important to 
upsample the image first so any additional elements 
you add will be at the higher resolution. If you aren’t 
sure if the image is sharp enough, zoom in on the file 
(select View>Actual Pixels). It might look great 
zoomed out but very soft or jagged when you zoom in. It will print the way you see it when zoomed 
in.
 
 

Check File Saturation
Quite often customers’ images will be flat and in need of a color boost. Always check the file to see if it 
needs a saturation boost by going to Bitmap > CMYK Color Adjustments > Hue Saturation (FastARTIST) 
or Image > Adjustments > Hue Saturation (Photoshop). 

 

Sharpening Images
Typically, an image can be made sharper. Even if the file came from an agency or large licensed job, don’t 
assume that their artist knew your needs. Images that are printed not only get darker, but also get softer. 
You must make them as sharp as possible.

Go to Bitmap > Filters > Sharpen > Unsharp Mask (FastARTIST) or Filter > Sharpen > Unsharp Masking 
(Photoshop). Don’t let the term “Unsharp” fool you. This term comes from the process camera days 
and means it only sharpens areas of high contrast. The reality is, it sharpens the image but keeps it less 
apparent that you have sharpened the image. 
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Move the Amount slider to 150%. Set the Pixel Radius to 1 and the Threshold to 8. How does the image 
look? To compare the original to the sharpened version, uncheck the Preview check box (Photoshop). 
Click it on and off and compare the results. If you can’t see much difference, move the Amount slider 
higher. Go all the way to 500% if you need to but don’t make the image too grainy.

 

Using the Tone Curve
Whether you are Screen Printing, heat transfer printing 
or Inkjet-to-Garment printing, a common dilemma is that 
images tend to get a little “muddy.” If you have a file with 
lots of detail in the shadow areas, this will probably be lost 
when printed so you need to adjust the “density levels” of the 
image. In FastARTIST, go to the Bitmap dropdown menu, 
and then select CMYK Color Adjustments > Curves. In 
Photoshop, go to Image > Adjustments > Curves.

The Tone Curve is a very powerful tool that allows 
you to adjust specific tonal areas from the lightest “Highlights” to the 
darkest “Shadows.” By placing your cursor in the middle of the 
“Midtones” curve and dragging the mouse up or down, you can
lighten/darken the medium, or Midtones, in an image.

By clicking on the very top corner and dragging the mouse in, you 
can make the highlights lighter (Photoshop). Play around with the 
Tone Curve and see what happens. A good curve for flat images is a 
slight “S”, where you lighten the highlight area (35%) and darken the 
shadow area (75%).

In later versions of Photoshop (CS through CS3), similar adjustments can be made using the Shadow/
Highlight dialogue under Image > Adjustments. Make sure you click the “Show More Options” check box 
for additional settings.
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Bitmap Editing in FastARTIST
Photoshop is always in bitmap mode because it is a pixel-
based editing program. FastARTIST (along with CorelDRAW 
and Adobe Illustrator) defaults to vector mode when you 
launch the program, so you will need to find the bitmap editing 
tools in these programs. In FastARTIST, double-click on the 
image. That changes the top Toolbar icons to standard bitmap 
editing mode (very similar icons to Photoshop).

Selecting Areas
In FastARTIST, if you want to apply a Tone Curve adjustment or 
Unsharp Masking to specific areas, you must double-click on the 
object to make the bitmap tools available. You then click on the 
Lasso tool (Hint: It looks like a lasso) and hold down the mouse 
button while drawing around the area you wish to modify. When 
you release the mouse, you will have a yellow outline identifying 
the selected area. Now, anything you do ONLY happens to this 
area.

In Photoshop, you can choose an area with one of the Selection 
Tools on the Toolbar. Click on the tool that looks like a Lasso 
and draw around the object while holding down the left mouse 
button. When the mouse button is released the selected area will be identified by what is called “Marching 
Ants” – small moving lines around the selected area. While the area is selected, any changes made will 
only apply to this area. To remove the marching ants, go to the Select > De-Select (You can also use the 
keyboard shortcut of [Ctrl] + D). If you want to select square or round areas, use the Marquee Tool (top 
left tool) and use this the same way you would use the Lasso tool.

Channels and Layers
What really separates Photoshop from FastARTIST and 
CorelDRAW is the ability to work in Layers to build images. 
Therefore, whenever you are using Photoshop, you should have 
both the Channels Palette and Layers Palette open.

People often get these confused so here are the rules: The 
Channels Palette is used to create output. Channels print. The 
Layers Palette is used to create or build the image and layer 
the various components together including adding Type to an 
image. Layers don’t print.  
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You will also notice that your Channels Palette shows four channels: RGB, Red, Green and Blue. Your 
test file probably only shows one Layer, called Background.

For more details on using the Layers Palette in Photoshop, consult the Adobe User’s Manual or the 
In-Program Help sections.

Setting Transparent Images in FastARTIST
To set transparent backgrounds in FastARTIST, double-click 
on the image to enter the 
bitmap edit state. 

Using the Eyedropper tool, click on the Red background and 
then click on the Add Color button in the Color Selection 
dialog box. This will make the selected Red the current 
color.

The background color can be any solid color, not just red. 
For example it can be white, black, yellow, green, etc. 
However, it is important to note FastARTIST will only 
remove ONE color. If your image has a multi-color or 
gradient background, it will be necessary to use Photoshop 
to make the image print ready. 

To make the Red transparent, click on the Eye icon next to 
the selected color. This acts like a toggle switch, so selecting 
it again will deactive any transparent color. 

Visit our support site for videos on working 
with Transparent Images and FastARTIST. Refer to Chapter 17 - Product Support for 
information on how to log on to our support site and view these videos.

Removing Backgrounds with Photoshop
In order to make removing backgrounds as easy as possible, try to maintain a consistent/neutral 
background if possible. For example, if photographing the motorcycle shown on the following page, 
park in front of a wall or a background that contains a much lighter color than the bike. This will help 
Photoshop determine the difference between the selected background and the object (such as the 
motorcycle) you intend to keep. 

Using the Magic Wand – Click and Delete
With the Magic Wand, click on the unwanted areas around the image and then delete them. It’s a pretty 
simple process IF the background color is different 
(contrasting) from any of the edges of your image.
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Click an area in the background and 
the Magic Wand will make a selection around the 
image. If the “marching ants” selection goes into the 
main design, change the Tolerance on the Property 
Bar. The default is 32. Note: if you are working on a 
“flattened” piece of art (JPEG) with 1 layer named: 
“Background,” you need to first duplicate this layer 
to switch to “PSD file mode” to get the transparent 
background. The original layer can then be deleted.

Depending upon the variations and gradients in the background, 
it may require some trial and error with Tolerance settings and several selections 
before the background is completely removed.

If the first click of the Magic Wand does not get all the unwanted areas, you can add 
to the selection by holding down the [Shift] key and clicking another area. You can 
subtract from the selection by holding down the [Alt] key and clicking on a area.

Photoshop and FastARTIST both have Magic Wand tools (it looks like a wand with a 
sparkler on the end.)

Using the Extract Filter
Photoshop also has a Filter called 
Extract. This will allow you to draw around an 
image and fill the center with color. Photoshop 
then removes all the areas around the image, 
leaving you with a transparent background. 
Extract does a decent job, but the Magic Wand is 
the preferred method.
 
 
 

Keep in mind, the Magic Wand and Extract filters perform best when the 
background is a solid color and not a gradient.
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Making Your Selection a New Layer
The goal behind all this is to get your main 
image on a layer with a transparent background. 
(This will show as a gray and white checkered 
pattern throughout the image). With a transparent 
background, you can add additional elements to 
the image including text, drop shadows, glows and 
more.

Fixing Bad Line-Art in Photoshop and 
FastARTIST 
 

You may also use a bitmap editing program to improve the 
quality of line-art. Earlier we covered file resolution, noting 
how a low resolution file will have very jagged edges. By 
simply upsampling a file to a much higher resolution you will 
have less of a jagged effect, and a softer edge. 
 
 
 
 
 
For Black and White images, you will want to 
upsample and then apply a Tone Curve to make edges Black and 
White without any “gray” areas. This process is available in 
FastARTIST, Photoshop, CorelDRAW and Adobe Illustrator. 
 

IMPORTANT POINT:
You must take ownership of fixing bad 
artwork. If the file is provided in a pixel 
based format like TIFF, PSD, JPEG, GIF, 
etc., you can’t assume it is bright, sharp, of high resolution and ready to print. You 
must check the resolution and upsample the file if necessary. Make adjustments if 
it needs sharpness or boost color saturation if the file is dull. Lighten the file if it 
seems too dark because the image may print even darker!
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Artwork for Light and Dark Garments
To set up artwork properly, it is imperative to know 
first onto what color garment the image is to be printed. 
This will then determine if the image background needs 
to be transparent, White, Black, or in some cases both 
Black and White. 
 
For Light colored garments, the T-Jet will print the 
image just as it appears, but it does not print the White. 
Printing in color without an Underbase is the easiest 
form of garment printing.

If you require White in the image, it will be necessary 
to Underbase the image. Therefore, Dark colored 
garments will always require an Underbase that allow 
the colors to “stand off” the garment. 

Visit our support site for videos on working with light and dark garments in 
FastARTIST as well as setting it up with different clipping options. Refer to Chapter 17 
- Product Support for information on how to log on to our support site and view these 
videos. 

Refer to the FastARTIST User’s Manual
Please keep in mind, this section is intended only as a brief Overview and Introduction into the world of 
software graphics applications. Your FastARTIST User’s Manual covers the file setup process in-depth, 
including how to prepare files for printing onto both Light and Dark shirts. For step-by-step instructions 
and additional Hints and Tips, please refer to the FastARTIST User’s Manual.

For information about the Photoshop, CorelDRAW or Illustrator processes addressed in this Chapter, 
please refer to that application’s User’s Manual or In-program Help section.
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Chapter 11

Printing Basics
Congratulations! You have made it to the chapter - Printing Basics. Its been quite a lengthy process to get 
here, but since you were patient and read through the entire manual, you will be rewarded with the most 
brilliant prints in the industry. This chapter will cover printing basics on lighter-colored garments NOT 
using white ink. Read this chapter of basics before continuing on to the next chapter.

Your T-Jet Blazer Series printer is very easy to use. Simply create an 
image, load a shirt, choose the appropriate Print Modes, select the 
number of passes and press the Print button.

 
 
        Voila! 
 Instant shirt! 
 

Printing Basics Introduction
OK, the time has come. You have installed the bulk ink system, you have created a simple image in 
your favorite graphics program and now you are ready to ruin a few shirts. Be warned, there is a slight 
learning curve to printing on fabric and you must get over the fact that some will get ruined. Remember, 
it is ONLY a shirt. Even when you’ve become a seasoned pro, it’s a fact of life in the garment decorating 
industry. Your printer will also need to be “broken in” a little. When you first install the bulk ink system, 
there is a chance that not all of the inks are flowing yet. You won’t really know this until you have done a 
print or two, or a nozzle check. Therefore, you should start off by using clean rag shirts, or just accept the 
fact that you will ruin a few new shirts and buy some extras. Your first print may NOT be a winner, but 
after you have printed a few, you will feel like a professional. 
 
This chapter will first walk you through the basics steps of printing. Afterwards, you will learn a few extra 
pointers and tips for along the way.
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Shirt Boards

T-Jet Blazer Express
The Blazer EXPRESS includes one Standard Adult and one Large (over-sized) Shirt Board. The 
EXPRESS model prints one garment at a time.

T-Jet Blazer PRO
The Blazer PRO model includes three Standard Adult and two Large (over-sized) Shirt Boards, meaning 
that on the PRO, although you are not required to, can print either 3 standard-sized prints or 2 over-sized 
prints at a time.

Shirt Board Options
You can purchase additional Shirt Boards to accommodate different needs. Each Shirt Board/garment 
holder will correspond to a different art layout (or template in FastARTIST). Pictured below are the 
various sizes of the Shirt Boards available to order. There are also optional shirt hoops that will aide in 
holding the garment in place (call for availability). Refer to Chapter 13 - Printing Other Items for layout 
instructions, and additional accessories.

 

Shirt Board Placement and Care
As covered in Chapter 4 and Chapter 5, each Shirt Board is held in the proper position by metal pins 
screwed into the top of the Print Bed that align with the holes in the Shirt Board base. If you have a 
Screen Printing background, you may wonder what holds the garment in place. The rubber-like material 
on the top of each Shirt Board lets friction hold the garment in place.

WARNING 
All Shirt Boards are comprised of a foam rubber pad and a steel base. Although the 
base is nearly indestructible, the rest of your printer is not. DO NOT set anything 
on top of the Print Bed or Shirt Board. IT IS NOT A STORAGE SHELF and it 
WILL WARP.

DO NOT apply any cleaner or glues to the foam rubber pads, they will crumble and disintegrate, 
leaving a mess on your shirts. Store your Shirt Boards in a cool, dry place. On the PRO, the storage 
cabinets beneath are provided for your convenience to help you store shirts, inks, etc.

Standard Over-Sized

Youth Infant/Misc. Sleeve
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Basic Printing Steps:
Power Up1.	  
Power up your T-Jet (see Chapter 4 or Chapter 5 for proper steps) and allow the machine to go 
through its startup cycle.

2.	 Verify Print Status on the LCD Display 
After powering up, the printer should be in Print 
Status, but a far too common user error occurs when a 
print command is sent to the printer without the 
machine being in the proper mode. 
 
The printer MUST be in “Paper Out/Roll Cut” mode.  
 
NEVER send a Print command without VERIFYING the mode status on the LCD Display each 
and every time.

Set the Printer to Print Status (if needed)3.	  
Placing the printer into Print Status requires using the buttons located below the LCD Control Panel. 
If the LCD Display does not look like the image above, press the LEFT /PAPER ARROW until the 
LCD Display reads “Ready.” 
 
Press the LEFT ARROW once more. The LCD Display should read “Paper Out” and display a “roll 
of paper with scissors” icon.

4.	 Extend the Platen (PRO model only) 
For the BLAZER PRO, manually pull the Platen handle away from 
the printer until the third Shirt Board clears the Printer Assembly. 

Load your garment(s)5.	  
Shirts can be full of lint and some have more than others. Lint can settle on key components inside 
the printer, affecting print quality and printer operation.

•	 For the best results, grab a shirt by the shoulder 
seams and snap it like you would a small dusty rug 
before you place it on the Shirt Board. 
 
Doing this will pull out wrinkles as well. For the best 
results, use a Heat Press to heat and flatten the 
garment and garment fibers before loading.

Lay the garment on the •	 Shirt Board, stuffing any 
excess into the space between the top and base. We 
recommend loading the garment with the collar 
towards you, but in the end it will depend on how you 
have your art setup.

LCD Display in Print Status “Paper Out/Roll Cut”
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For a more vibrant CMYK print on light garments, refer to Chapter 12 - Advanced 
Printing With White and learn about FastCOLOR Pretreatment and the 
pretreatment process. 
 

IMPORTANT POINT 
DO NOT leave the collar or seam exposed on top of the Shirt Board. Any 
unnecessary height on the bed may hit the Print Head when printing. Load the 
collar over the edge of the Shirt Board so that it is out of the way. It is also critical 
that the shirt lay flat. Any fluctuations in the printing surface could cause the print 
to be soft or out of register and/or result in a damaging Print Head strike. 

Check your Print Bed height (platen to head clearance) 6.	
 
BLAZER EXPRESS: Visually check underneath to help 
you determine if the Shirt Board is set too high. You will want to 
make sure that the distance between the Print Head and the Shirt 
Board, with media loaded, is set to the same setting (distance) 
that was used for completing the Print Head Alignment (3-5mm). 
Use the Shirt Board Adjustment Knob located on the front of the 
Print Bed. NOTE: Make sure that the printer is in printing 
position before adjusting the height. An easy way to make sure is 
to perform a Head Cleaning Cycle before adjusting the Print 
Head height. Refer to Chapter 8 - SETUP PART 6: 
Initialization Utilities -  Setting the Platen Height: Blazer EXPRESS for complete steps. 
 
BLAZER PRO: Make sure you have the required minimum 
of at least 3 mm of space between the Print Head and the 
garment. This is usually only necessary when switching 
between garment thicknesses. In any event, make sure that 
the distance between the Print Head and the Shirt Board, 
with media loaded, is set to the same setting (distance) that 
was used for completing the Print Head Alignment (3-5mm). 

WARNING: the Blazer PRO does not have a backup safety device to protect 
the Print Head in case the platen is set too high. Refer to Chapter 8 - SETUP PART 
6: Initialization Utilities -  Setting the Platen Height: Blazer PRO for complete 
steps. 
 
 

 

For the BLAZER PRO7.	 , return the Platen to its operating position by pushing it back toward the 
printer until its ends are even with the ends of the Bed Rail.

ALWAYS KEEP
CLEARANCE OVER 
3 MILLIMETERS 3mm

PLATEN
(PRINT BED)

PRINT HEAD
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8.	 Choose the artwork you wish to print. 
In the beginning you will need to concentrate on the print 
placement and getting the image in the graphics program 
coordinated to the correct location on the shirt.  
 
You can print directly to FastRIP from your favorite 
graphics application (if you are not outputting an 
Underbase or Highlight White), or you can print from 
within FastARTIST (recommended).

Make sure that the image is at the correct physical size •	
for output and that you have placed it in on a “Page” 
that is the same size as the printable area. 
 
The easiest way to get the correct print placement is to create a template for the size and placement 
of the Shirt Board or to use FastARTIST and load a pre-made Template. You can also export a 
Pre-made FastARTIST Template into another graphics application. Remember, you MUST use 
FastARTIST if you will be printing with white ink. Refer to Chapter 11 - Printing with White Ink 
of this Manual for more details. Also refer to your FastARTIST and FastRIP User’s Manuals  for 
other setup options as well as tools for the design and layout process. 
Note: The Blazer Express will support a total printable area of 16” x 20” (41 cm x 51 cm). 
The Blazer PRO will support a total printable area of 17” x 45” (43 cm x 114 cm).

IMPORTANT POINT  
FastARTIST refers to its page dimensions in terms of width and “height.” For 
purposes of printing a two-dimensional image on a garment or non-textile item, be 
aware of the fact that “height” means the same thing as “length.” 

9.	 Open the FastARTIST Template

Open the desired template •	
to Import your graphic into. 
The templates to the right are 
included in your FastARTIST 
package. 
 
The Blazer Express Standard 
Template layout is 17” x 31” 
with a total printable area of 16” 
x 20”. 
 
The Blazer PRO Standard Shirt 
Board Template layout is 
17” x 45” with 3 13” x 16” sections for each Shirt Board. The Oversized Shirt Board template 
layout is also 17” x 45” but with 2 16” x 20” sections for the Shirt Boards. 
 
NOTE: Adjust the FastARTIST Page Size by going the Layout pull-down menu and selecting Page 

Blazer Express Standard Template
Blazer PRO Standard (3-up)Template
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Size. Also, make sure that the page size is correct under File>FastRIP Setup under Preferences.

10.	 Import your Art into the Template

From the File Pull-down Menu •	
select Import.

Choose the file you want to •	
import.

Click on the page to import the •	
file at it’s actual size or click and 
drag to apply a custom size. 
 
You can adjust the size by 
clicking and dragging on a 
corner.

Center the graphic in the “Safe Area” of the template. •	
 
Determine the correct print location by using the grid lines which represent an outline of the Shirt 
Board(s). The template will open with either a Yellow or Pink placeholder representing the size of 
the safe print area. (Click on a block of color to delete it.) NOTE: Do not reposition the guides in 
the FastARTIST template. To lock the guides, right click anywhere on the page and a Dialog 
Box will appear. Check the “Lock Guides” box and click OK. 
HINT: To help determine where and how to place your art in relation to the Shirt Board(s), the top 
of the page represents the opposite side of where the printer assembly is.  

From the File Pull-down Menu select Save As. Save the file as a different name (name of job)so •	
that you do not save over the Template File. 
 

Think about the printing speed when importing graphics. You can place graphics 
sideways in a template and load the shirt sideways if it will accommodate a better 
print layout. 
 
 

 

Select the appropriate Print Mode. 11.	
There are a wide variety of Print Modes available within FastRIP to give you the flexibility to print 
high resolution photo quality images at a slower speed or lower resolution Spot Color images at faster 
speeds. 

Blazer Express Standard Template
Blazer PRO Standard (3-up)Template
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From the File Pull-down Menu, select FastRIP Setup. A window will open up letting you adjust all of 
the print setting and Print Modes. You can also do this by selecting File>Print to FastRIP.  The screen 
will look a bit different and at the top of the window, click the square button with 3 dots in the 
middle.  Pressing this button will open up the setup options. 
All designs are different and each have different needs. A brief overview of Print Modes follows. For 
a detailed listing of available Print Modes and their recommended usage, please refer to Chapter 7 of 
your FastARTIST User’s Manual. 

We recommend that you do ALL of your printing through FastRIP and 
FastARTIST, even if you are NOT using White ink. After completing your 
design in other graphics applications, Import that design into FastARTIST and 
use the provided template for optimal printer performance. 
 
 

12.	 Set UI to Auto Mode (for Printing) and Select Passes 
On the User Interface, scroll through the screens until you 
reach the Mode Select interface. Make sure that the Mode 
Select dial is set to Auto. Also, select the number of passes 
you wish to make by pressing the appropriate virtual 
button. Note: You would select the number “2” if you are 
using a two pass print mode or printing a white underbase.

The above photo shows how the Print Mode selection windows will look if you 
print directly from Adobe Photoshop. (You MAY NOT have the same Print Modes 
available with your version of the Fast T-Jet Blazer Express or PRO.)

How Print Mode selection will look if you print using FastARTIST. 
(You MAY NOT have the same Print Modes available with your 

version of the Fast T-Jet Blazer Express.)
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Send the Print command (from FastARTIST).13.	

After all Print Modes have been •	
selected, select File>Print to FastRIP The print preview window will open (you may already have 
this window open if you set the file up in this window). 

Using the Arrow tool, select the art on the Artboard that you wish to print. In most cases you will •	
want to print everything on the Artboard. Drag a box around the entire image to select it then either 
drag the art to center it in the preview window or using the arrows on the keyboard, adjust the 
location as desired.

•	 Press the print icon in the FastARTIST 
Print Toolbox. 
 
 
The job will then be placed in the FastRIP Queue Window. Wait for the job to be spooled, 
then right-click on the job and select print (you can set FastRIP to print automatically or Spool 
only). Once the job reads “Printing”, continue to next step. 
 

Press the Send Print Buttons.14.	  
The Green button(s) on the User Interface will be blinking. Press and hold for a few seconds to begin 
printing your image. 

WARNING: 
DO NOT press the Green button(s) on the User Interface until a job has been sent 
and reads “printing” in the Rip Queue window. If you press the button too early, it 
can result in serious printer errors and possible ruined garments. 
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When a Printing Job Is Finished
After your job finishes printing, the Printer Assembly will 
return to the Home position and the green button on the 
User Interface will start to flash.

At this time it is safe to:
Remove your garment and cure. •	
 
For the Blazer PRO, extend the platen by the handle 
so that the third position Shirt Board is completely 
clear of the Printer Assembly.

Load your next garment(s) and resume printing.•	  

Curing Your Garments
Finished prints must be heat cured to fully set the ink. For 
best results pre-press the garment for a few seconds prior to printing. 
This dries the garment for areas with higher humidity and flattens the 
fibers for a cleaner and smoother print. 
 
If using a Heat Press for curing, use light pressure and either a Teflon 
cover sheet or silicone treated baking pan liner to prevent ink from 
getting on the element. 
 
If using a conveyor textile dryer, you MUST achieve these times 
and temperatures. A typical short tunnel textile dryer does not have 
sufficient tunnel dwell time and shirts may have to go through two or 
three times. Also, refer to the literature included on the ink bottle. 

If you experience scorching on certain shirt brands, reduce the 
temperature and cure longer. 
 

IMPORTANT POINT
Perform wash tests! All curing times and temperatures ARE RECOMMENDED 
STARTING POINTS. It is your responsibility to find the cure times that work best 
for your location and Print Mode preferences.

LIGHT GARMENTS 
Using FastBRIGHT
Cure Time: Approximately 120-180 seconds 
Cure Temp: 330°F (166°C)
 
Using FastCOLOR
Cure Time: Approximately 35-60 seconds
Cure Temp: 330°F (166°C)

DARK GARMENTS 
Using FastINK Pretreatment #1 
Cure Time: Approx. 180-240 seconds
Cure Temp: 330°F (166°C)
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Printing Tips and Tricks
Preventative Maintenance
One of the most important tasks in keeping your new printer running smoothly is to keep up on the 
maintenance of the machine. Although the T-Jet is “simply” an inkjet printer, the number one technical 
issue is a lack of maintenance of the machine. There are three main areas of concern:

Printing on t-shirts is not the same as printing on paper. A shirt gives off much more lint which •	
must be cleaned up regularly.

The amount of ink deposited on fabrics is far greater than on paper. This means all ink supply lines •	
must be feeding properly as well as all excess ink must be cleaned up daily to prevent build-up.

When printing on dark shirts, you must apply a Pretreatment. This solution can settle inside the printer 
and cause numerous problems, therefore we recommend you pretreat shirts as far away from the printer as 
possible (i.e. in another room) 
 
Refer to Chapter 14 - Daily, Weekly and Monthly Maintenance for complete descriptions of required 
maintenance.

 

Export a FastARTIST Template
If you would like to setup the FastARTIST template in another graphics application, follow these steps. 
 
The FastARTIST templates do not include any actual 
art, only guides. This means that you will have to 
create art (shapes) on the template page, referencing 
where the guides are, which you can then export to 
your desired file type. In this example, we will use 
the Express Standard Template (17”x 31”). 
 

First, select a color in the color palette for •	
the background (blue in this example). Next, 
select the rectangle tool and draw a box 
representing the entire page. 
 
In the properties bar, you can adjust the size of 
the box to the page size of 17 x 31. 

Zoom in and make sure that the box is •	
properly lined up with the page edges. Do this 
on all 4 sides. 
 
 



Chapter 11 - Printing Basics 

105
Version 5.5  Revised January, 2009

•	 Next, deselect anything selected and choose a new 
color to represent the print area. In this example, we 
will use yellow. Select the rectangle tool again and 
trace the safe area of the guide. 
 
 
 
 

•	 Zoom in and make 
sure that the edges 
line up with the 
guides. Do this on 
all 4 sides. 
 
 

Click File>Export. We recommend exporting as an EPS. An EPS file will open in almost any •	
graphics application. Open the EPS in your “third-party program” and make sure that your page 
size is 17 x 31 (Express in this example). 

Use the guides tool to re-create the print area by adding a guide to each side of the yellow box. •	
Select the “lock guides” option. Once this is done, you can delete the eps file (or layer) and re-save 
the document as a new “third party software” template for future use. 
 
 
 

Resolutions, Speed and Quality
The resolution you choose will not only determine print quality, but print speed as well. If you use a lower 
resolution Print Mode, you will achieve a much faster print speed, but may not get the quality needed 
for photo images. Lower resolutions apply fewer ink dots per inch (DPI), which allows the Print Head to 
move much faster.

If you use higher resolution Print Modes, you will notice a decrease in print speed but an improvement 
in image quality. A higher DPI increases print quality by increasing the density of the dots per inch. 
Therefore, we recommend a lower resolution for cartoon images, but a higher resolution for photo type 
images.

Also, we recommend the use of HS (high speed) print modes for faster printing. These also work great for 
full-cover underbases. 
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Saving a Spooled Print File
You can save a spooled job for later printing. This is most helpful when you want to print a particular 
job the exact same way or if a customer requests a repeat order by surprise. The spooled file saves as a 
file called JTB. The JTB file obtained it’s name from the extension of the actual file being archived. So 
when you spool the art file and name it cat, the JTB file will be named cat.jtb. Inside FastARTIST, you 
would build a file as your normally would; add the underbase if needed, adjust the colors and all the other 
wonderful things you may need to do to the art before sending to print. When you spool a JTB file, all 
the settings will be kept the same as the original file; the placement, the print mode and the colors of the 
image.

1.	 Creat the JTP File 
Make sure you have your 
FastRIP set to hold the job when 
sending the print command. You 
can set this up by clicking the 
paper icon with the arrow in the 
bottom right corner. If setup 
correctly, the icon will be lit and 
the arrow will be green. You can 
also set this up in the FastRIP 
Setup print dialog box when 
selecting the print options.   
 

2.	 Right click on the job and select Spool Only.  
 
 
 

After the job is spooled, highlight it and go select from the pull-down menu, Jobs>Properties. 3.	

4.	 The Job Ticket Properties 
window opens. 
 
Under Settings at the top left, 
click on Archiving. The archiving 
options will now be visible in the 
body of the window. 
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5.	 Towards the bottom of the window, 
where it says Location, click on the 
box with the three dots. 
 
A “Browse For” folder will open. This is 
where you will name the JTB file and 
select a save location. This works like 
any other browser window when saving 
a file. When a save location is selected, 
click OK at the bottom of the window. 
 
The location path in the window now 
displays the path of where you selected to save your file.

6.	 Next, click the Archive button.  Another 
window will open, giving you a field to 
enter the job name. Enter the desired job 
name and click OK. You will see two blue 
bars that display the process of saving. After 
completed, click OK.

Minimize FastRIP and browse for your 7.	
newly created JTB file. To load the file for printing, drag and drop the file into the FastRIP Queue 
window. The job will post in the list of current jobs (if any).  Right click the job and select print. 
 
 

Canceling a Print Job
Occasionally a print job will not print. This could be caused by a problem with the file, the printer not 
being in the Load position when the print command is sent, a chip indicating a color is out of ink or other 
issues. If you have ever owned an inkjet printer, you know that it is sometimes hard to “kill” a print job. 
When you send a Print command from your graphics application or FastARTIST, the FastRIP does its 
calculations and then sends the job to the Windows Print Manager. It is almost impossible to stop a print 
job within the RIP if the job is still in the Print Manager. To open Print Manager, double-click on the 
small printer icon on the lower right bottom of your computer screen (This section is called the Task Bar). 
When the Print Manager opens, it shows the status of the print job. However, a job that is NOT printing 
might still show as printing. To cancel a print job, click on the actual job file, go to the File menu and 
select Cancel All Documents.

If there are printing problems when using FastRIP that require you to cancel a Print command, right-click 
on the file and Abort the Print command. If you get a partial image on a shirt from the previous job, you 
probably have not fully canceled the Print command in FastRIP. 

If you must cancel a job while still printing, we recommend you power OFF both your computer and the 
printer. This will clear the memory, cache and buffers in which the image may still reside.
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Emergency Off Switch - Blazer Express
The T-Jet Blazer Express is equipped with an Emergency Kill 
Switch that will cut OFF all power to the printer. After pressing 
this button, you must shutdown the machine completely, 
including the Power Switch in the rear of the housing. All 
jobs within FastRIP must be cancelled and deleted. Perform a 
complete start-up and initialization to resume operations. 

 IMPORTANT POINT  
Any file that was printing or spooled at the time of the emergency shutdown will be 
lost. An unfinished image cannot be restarted and all jobs must be re-spooled.
 
 

Kill Switch - Blazer PRO
The T-Jet Blazer Pro is equipped with a Kill Switch in both the Home and Index positions. These circuit 
breakers will only be activated if the Printer Assembly attempts to exceed specific printing dimensions. 
These switches will prevent damage to your machine should the Assembly fail to trip specific sensors.

In the event you experience a sudden and total loss of power to all systems, including the User Interface, 
it may be due to a Kill Switch activation. To reset your system please do the following:

Turn OFF power to your machine by flipping the breaker switch located next to the AC power cord. 1.	
If you do not turn OFF the breaker, the Printer Assembly may immediately activate the Kill Switch 
again after reset.

Move the Printer Assembly 3-4” toward the center of the Platen.2.	

Reboot your system and power ON your printer.3.	

IMPORTANT POINT 
Should you experience a Kill Switch activation, all spooled files and print jobs must 
be reloaded and again sent to Print.
 
 

 
A Warning About Page Sizes
When printing, you MUST ensure the correct Page Size is used. The Maximum Printable Area is limited 
to the specifications mentioned earlier in this chapter . FastARTIST comes with a template that matches 
each dimension layout and we STRONGLY recommend you use these when printing. If you are printing 
from a graphics application other than FastARTIST, you MUST make sure that you have configured your 
Custom Page Size correctly within that program.

Failure to follow these guidelines could result in a blown fuse on the Main Board of your printer, 
rendering it unable to print. Should this occur, you must contact Tech. Support for further instructions.
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Height Sensor: Blazer Express ONLY
The Blazer EXPRESS (only) is equipped with a built-in Height Sensor that will help determine what the 
height of the platen needs to be set to for printing. The height sensor is a thin laser beam that extends 
across the Platen if it is at a dangerous height that will damage the Print Head. If the platen is set too 
high, or should anything break this beam, all machine functions will immediately pause, the LCD Display 
will read “Top Cover Open” and a small LED located on the top of the printer will flash Red. 

Immediately check your garment for folds or wrinkles that may affect Print Head clearance, smoothing 
out any variations as needed. In addition, adjust the Platen to Head Clearance using the adjustment knob 
on the front of the Print Bed, if necessary. Once the obstruction is cleared, printing will resume from 
where it left off, without the need to re-send or re-spool the output.

IMPORTANT POINT:  The Height Sensor is a “Last Line of Defense” to 
prevent the Print Head from striking a garment, platen or any other object that could 
cause severe damage to the Print Head. Practice knowing where your platen is in 
relation to the Print Head height. Do not rely solely on the sensor to warn you of 
potential collisions. Print Heads are not covered under warranty so we strongly 
encourage you to monitor and maintain a safe clearance between the Print Head and 
any garment or other printable item. 

 
NOTE: If the sensor is tripped too many times, the printer will error out and display one of the following 
error messages on the LCD screen: “TOP COVER OPEN” or “SRVC REQD 00001001E” 
 
In the case of either of these error messages, you will be forced to perform a complete shutdown. To learn 
more about error codes and messages, refer to Chapter 16 - Troubleshooting. 
 
 

Placing the Printer into Print Status
A far too common User Error occurs when a Print command is sent to the printer without the machine 
being in the proper mode.

To prevent erratic printer behavior, 
ruined shirts and lost time for 
maintenance and troubleshooting, 
NEVER send a Print command without 
VERIFYING the status of your Blazer 
Express each and every time.

The printer MUST be in “Paper Out/Roll Cut” mode.
 

Placing the printer in Print Status requires using the buttons located below the LCD Control Panel. If the 
LCD Display does not look like the image above, press the LEFT ARROW until the LCD Display reads 
“Ready.” Press the LEFT ARROW once more. The LCD Display should read “Paper Out” and should 
display a “roll of paper with scissors” icon. 

LCD Display in Print Status 
“Paper Out/Roll Cut”
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Print Modes and FastRIP
When first starting out, the most versatile Print Mode combination for BOTH 
photos and cartoons is 720 HS  for CMYK and 1440 HS for the Underbase. For 
images on light garments in which no Underbase is used, a 2 Pass Print Mode will 
result in better color saturation. 

CMYK Cartoon and Photo Print Modes
The T-Jet Blazer Series Printers have three basic modes for printing – Cartoon, Photo, and Underbase. 
The Cartoon and Photo Print Modes will print the image in color when printing from FastARTIST or any 
other graphics program. These two modes were created to adjust print characteristics based on the image 
to be printed. If you are printing vector graphics with Spot Colors, use the Cartoon Print Modes. If you 
are printing photo-type Bitmap images, use the Photo Print Modes.  

Cartoon Print Modes are designed to:

lay down more ink with good color saturation•	

be used for non-critical images•	

allow a lower DPI to be selected•	

Photo Print Modes are designed to:

lay down less ink with highly accurate colors•	

reproduce an extremely detailed image•	

utilize a higher DPI to ensure good print quality•	

 
High Speed Print Modes
Some of the Print Modes in the list of options have an HS after the name. These are the High Speed Print 
Modes available for use. If the print mode does not have a HS after it’s name, then it is a uni-directional 
print mode. When you select one of the High Speed Print Modes, the printer will print twice as fast, 
referred to as Bi-Directional mode. Bi-Directional printing lays down ink as the print head is moving 
from left to right AND from right to left. You will probably use these Print Modes more than not because 
of the increased printing speed. 
 
You must perform a Print Head Alignment to enable the printer to print in HS mode. If you haven’t yet 
completed a Bi-Directional Head Alignment, you will need to in order to use these print modes. It is very 
important that the print head be 3mm minimum to 5mm maximum away from the substrate. If you run the 
alignment with the print head at 4mm away from the test media, then you will need to make sure while 
printing in HS mode that the print head is 4mm away from the shirt.
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Eight Color Print Modes
The Fast T-Jet Blazer Express also supports Eight Color Print Modes that utilize the additional colors 
of Red, Green, Blue and Orange in place of the four White cartridges. This configuration of inks cannot 
be used to print on dark garments, however when printed on light garments, the additional colors create 
vibrant hues that add an exciting dimensionality to your final output.

IMPORTANT POINT
The Eight Color Bulk Ink System is an optional configuration. If your printer is not 
equipped with the necessary inks and cartridges, you may purchase the additional 
accessories from U.S. Screen Print & Inkjet Technology. Refer to Chapter 7 of your 
FastARTIST User’s Manual for details on ink cartridge placement. 
 

 

Underbase Print Modes
The Underbase Print Modes may only be selected from within FastARTIST. With Cartoon and Photo 
Print Modes available in three different resolutions as well as having a High Speed opotion, you have 
the ability to select the proper mode to match your graphic image. For dark shirts try using the 1440 HS 
(High Speed) Print Mode to achieve a stronger, more consistent Underbase. This is due to the fact that 
the higher resolution will dispense more ink at a slower speed, creating extremely even coverage, plus 
the High Speed options will also cut the printing time down considerably. If you are printing on lighter 
colored shirts, it may not be necessary to print such a strong Underbase. 720 DPI may work better.

See the previous section for more information on High Speed Printing. For a complete list of the 
various CMYK, Eight Color and Underbase Print Modes available, refer to Chapter 7 of your 
FastARTIST User’s Manual.
 

Printing Concerns
Spots or Stains
Spots or ink stains must be removed BEFORE 
the print is cured, using a standard Spot Removal gun. Once 
the ink is cured, it is almost impossible to remove spots or 
smudges. Take care NOT to spray the wet print!  
 
Washability Related Concerns
Turn print inside out before washing or drying. Use cold 
Water only with a medium dryer temperature. If possible, give the customer washing instructions with 
the finished prints. You can expect a little fading with the first washing. This is normal and very similar 
to what you would get from a screen printed shirt. If you experience irregular fading, check your dryer 
temperature. If the shirts are damp from excess humidity, you should put them under the Heat Press for a 
few seconds to dry out before printing (see the following humidity section). 

If you have any washability issues increase the time.
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Poor washability ON LIGHT SHIRTS may be caused by insufficient ink deposit.  For best results, 
print at a minimum of 720 DPI and do two print passes (light shirts only). You can greatly improve 
the washability of the final print on light shirts that do not have white ink in the image by using 
FastCOLOR pretreatment. For information on pretreatments and applying pretreatment, refer to Chapter 
12 - Advanced Printing With White. Poor washability ON DARK SHIRTS may be caused by too much 
pretreatment or from drying the pretreatment with a slick Teflon sheet or silicone treated baking pan liner. 
The slick surface may not allow the ink to adhere properly.  

Humidity Concerns
For areas of greater humidity or where shirts are very damp after printing, try pre-pressing the garment for 
a few seconds using a heat press. Doing this will also flatten the fibers giving a smoother print.

Variables such as climate and the amount of ink used can extend cure times. Certain garment fabrics may 
also require more time. Even seasonal changes may effect already established times and temperatures.
 

Temperature Tests Vs. Wash Tests
Before doing a major production run, ALWAYS DO WASH TESTS and verify your dryer temperature. 
For Heat Presses, the most accurate method of checking the temperature is with Paper Thermometer heat 
tapes available from all screen print supply companies. Infrared ray guns do NOT always give accurate 
readings on heat presses.  For conveyor dryers, use Paper Thermometers or temperature “donut” probes 
available from screen print supply companies.
 

Slight Discoloration
Some shirts might show a slight discoloration if using a Heat Press to cure the print. (This is most often 
seen in Red and medium to dark garment colors other than Black.) This discoloration will usually go 
away when the shirt cools or when  washed.

Red dye is the hardest to control for discoloration because heat can permanently change the red pigment.
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Chapter 12

Advanced Printing 
With White Ink

This chapter will cover proper care of white ink, pretreatments and the pretreatment process, printing with 
white ink and how to take the proper steps in being successful with the process. 
 
The process of printing white ink onto garments was not easy 
to develop. Because the openings in Print Heads are so small, 
one cannot use thick ink like standard Screen Print Plastisol Ink. 
Printing White ink on a T-Jet was made possible by a combination 
of the following: 

 

White Ink Care
The T-Jet Blazer Series ship with the latest innovation in textile ink: FastINK Bright White. This ink is 
the best in the industry at producing bright Whites and brilliant Highlights. To keep the ink in the best 
possible condition, follow these simple steps.

Beginning of the Day Agitation
We recommend that as part of your daily routine you remove each 
of the White Bulk Ink Cartridges and gently agitate. While holding 
upright, twist back and forth a few times and re-insert into the printer. 
Do this to all four cartridges every morning or at the beginning of the 
day.

A very special ink •	
that has taken years 
to develop 

A software printer •	
driver called 
FastRIP that 
allows the printer to dispense 
more ink than originally designed 

The software Raster/Vector Graphics program •	
called FastARTIST that creates special 
Underbase and highlight white files

A revolutionary Pretreatment that binds the ink •	
to the garment.
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Do not violently shake the ink; only shake mildly! Shaking too severely may cause the formation of small 
air bubbles that can severely impair printing or create a vapor lock within the ink during the day.
 

End of the Day Agitation 
At the end of each work day, we recommend you remove each of the 
White Bulk Ink Cartridges, hold your finger tightly over the breather 
cap and gently tilt upside down. Doing this will spread pigment that 
may have settled at the bottom, to the rest of the ink. Hold the cartridge 
upside down for 10 seconds and gently tilt it back to its upright 
position. Repeat for all white cartridges.

IMPORTANT POINT: 
If the machine sits idle for two days or more, the ink in the lines as well as the ink 
in the bulk bottle will start to separate. The longer the machine goes without 
operation, the more the ink will separate. The agitation steps mentioned above will 
help but the ink in the lines and dampers will need to be purged or the white ink 
may have a transparent or grey look for the first few prints.
 

Weekly White Ink Care
SHAKE THE WHITE INK BOTTLE(S) STORED ON THE SHELF, EVERY WEEK FOR ABOUT A 
MINUTE TO PREVENT SETTLING. Doing this will keep the pigment suspended throughout the bottle 
and will give you the best printing resultss 
 
 

Breather Cap Airflow
It is very important that the filters on the breather caps do not 
get clogged up. After shaking the ink, ink may form on the 
breather cap. This can reduce or even stop the airflow causing 
the white to drop off. Check to make sure that you  have 
accurate ventilation in the top of each cap (for CMYK as well). 
 

To ensure that you always have proper 
airflow, loosen the breather caps slightly, 
creating a backup airflow. 
 
 

 
White Ink Shelf Life
The shelf life of FastINK Bright White is 6 months from the manufacture date. It is always good to keep 
white ink on hand, but don’t overstock. 

Notice in this photo, the breather cap on the left 
seems dirty, but has proper airflow, while the cap on 
the right, although it appears to be clean, does not 
have airflow.
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Pretreatment Basics
The Pretreatment solution is a milky colored, odorless and nontoxic liquid. A chemical reaction between 
the Pretreatment and the White ink causes the ink’s pigments to stay on top of the garment and not be 
absorbed by the textile fibers. Because of these reactive chemicals, it is CRITICAL the Print Head does 
not touch a pretreated garment - even one that has been dried! You should also have good ventilation in 
the area where you are applying the Pretreatment. If possible, pretreat garments in another room entirely. 

WARNING: 
You MUST NOT spray Pretreatment near the printer. In fact, you should pretreat 
shirts in a separate room entirely to prevent any overspray from getting inside the 
of the T-Jet. If using another room is not possible, a large cardboard box enclosure 
is a good substitute for applying Pretreatment. If using an AutoTREAT 
Pretreatment center you can pretreat in the same room if kept at a safe distance.

IMPORTANT POINT:
Like the CMYK cartridges, each White ink cartridge has “smart” chip that counts 
the number of drops of ink dispensed in order to warn you when the cartridge 
is empty. When printing with White ink, it does not take much ink usage before 
the chip tells the printer it is “out.” If this happens DURING a printing pass, the 
printer may stop printing and the Ink Level Indicator on the LCD Display for 

one or more of the White ink cartridges will start flashing. If you turn the printer off during this 
process, you will lose the job and ruin a shirt. Instead, remove the cartridge(s) that is indicated as 
low or out of ink and reset the chip(s). If the ink level has fallen below the Low Ink Mark on the 
cartridge, refill the cartridge with ink before reinserting it into your printer. Refer to page 15 of this 
manual for more details.

 

Applying Pretreatment
It is essential that the Pretreatment solution be applied evenly to ensure a great 
looking print (free from light and dark spots) on a Black garment. You can 
use manual spray pumps, weed sprayers or any other method you 
feel comfortable with to apply a uniform coating of FastINK 
Pretreatment. However, we strongly suggest the use of a Control 
Spray Gun (commonly used to paint a porch deck or furniture etc.). 
We recommend an affordable sprayer such as the Wagner Control 
Spray Gun. These guns are fairly inexpensive ($70 USD at home 
improvement stores.) However, these are not designed for high 
volume work, therefore you should keep an extra gun handy as 
backup. 

Cleaning the gun is simple and should be done on a regular basis to extend the life of your sprayer. 
Just fill up the storage bottle with water and run it through the gun as you would normally dispense 
any other solution.
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Types of Pretreatment
Currently we offer three types of Pretreatment-FastINK Textile Pretreatment, FastBRIGHT Textile 
Pretreatment and FastCOLOR Textile Pretreatment:

•	 FastINK Pretreatment is specifically designed for use on Dark colored garments, allowing 
for extremely bright Whites and vibrant colors. FastINK Pretreatment should only be 
used with medium to dark colored garments due to possible discoloration of light shirts 
when exposed to direct sunlight. 

•	 FastBRIGHT Pretreatment works extremely well with light colored 
garments and images that have an Underbase. Using FastBRIGHT creates vibrant 
images with rich, deep Blacks and Reds that will not discolor when exposed to direct 
sunlight.  

•	 FastCOLOR reduces cure times while GREATLY increasing the color 
brilliance and washability of your print. This pretreatment is designed for use with images 
on light colored shirts with NO White ink. 

WARNING 
DO NOT mix any of the Pretreatments together or the result will be ruined shirts.

Proper Pretreatment Application Using a Spray Gun
All of our Pretreatments are specially formulated liquids that prevent ink pigments from being absorbed 
by the fabric of a garment. When applying a Pretreatment solution, do not saturate the garment! You don’t 
want the shirt to be soaking wet.

•	 Move the spray gun from side to side in even strokes. 
Light shirts only require a misting back and forth, but 
Black and other dark colors will need a slightly heavier 
application. Always refer to the pretreatment packaging 
for the best application methods. 
 
The proper amount of Pretreatment needed, is 
something that you will get the hang of with repetition. 
The main idea is to get an even coat throughout the 
shirt or print area.  
 
Please note, if you miss a spot or apply the 
Pretreatment in an uneven spray, it will be noticeable 
in the final print.

View our video online covering correct 
pretreatment application. Refer to Chapter 
17 - Product Support for instructions on 
logging on to our support site and accessing videos.
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Drying the Pretreatment
Using a Heat Transfer Press is the best means for drying the Pretreatment. A heat press will flatten out the 
fibers leaving a flat and smooth print surface. You can use a conveyor dryer or even a hair dryer, however, 
other methods of drying will not flatten the fibers and may result in a lower print quality. 
 
When using a Heat Press, lay a sheet of non-silicone Pretreatment paper (parchment paper) available from 
U.S. Screen. This will protect the garment. If you use a silicone based paper, it will seal the Pretreatment 
on the shirt surface and the White ink may not stick well enough.
 
You may use a Quillon treated baking pan liner, however, if the paper sticks to the Pretreatment after you 
are done pretreating, there may be too much Pretreatment applied, too much pressure set on the heat press 
or has been pressed for too long. Standard “butcher paper” or “brown craft paper” can also be used as a 
heat press protector when drying the Pretreatment. 

Clamp the press down with medium pressure for 8 to 10 seconds when drying Pretreatment at 330°F. 
Consult the pretreatment bottle directions for curing using other means.

Depending on pretreatment amounts, pretreating for half the time with the pretreatment paper and half 
without, has shown great results. Also, some users have reported better wash durability by spraying the 
shirt with water BEFORE spraying it with Pretreatment. 

IMPORTANT POINT 
Too much Pretreatment may cause poor wash durability. Also, the Pretreatment 
MUST be completely dry before printing.
 

We recommend taking a look at the 
AutoTREAT Pretreatment Center. These machines 
make pretreating a garment very easy and apply a 
perfect application every time.

 
 
 
 

Printing White Ink
This section covers specific information for printing white ink. Refer to Chapter 11 - Printing Basics for 
all other steps. 
 
Please consult your FastARTIST User’s Manual for more detailed instructions and 
specific Hints and Tips. DO NOT attempt to print ANY image until you have read and 
familiarized yourself with FastARTIST and FastRIP, including their uses and capabilities.
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Top off ALL of your White Ink cartridges to the 150ml mark at the 
beginning of each day and DO NOT allow the ink levels to drop below the 100ml 
mark or you risk ink starvation issues. DO NOT overfill above the 200 mL mark or 
overflow may occur. If the printer has been unused for a few days, perform two or 
three regular Head Cleaning cycles to get the White ink flowing properly.
 

File Setup
When printing with White ink, it is very important that you set up the 
file correctly in FastARTIST. When Underbasing solid, Spot Color 
images, generally you’ll print solid White ink and then follow that 
pass with CMYK. When using FastARTIST, if the image has White 
as part of the design, a second pass of White can be made at the 
same time as the other colors. This second pass of White is called a 
Highlight and it boosts the brightness of the White.
 

The Underbase Wizard 
When printing photorealistic images, you will need to run a 
special routine called the Underbase Wizard. This feature of 
FastARTIST will create a separate piece of artwork that FastRIP 
will use to print an Underbase of White ink. When printing a 
photorealistic image, the Underbase is NOT solid White but 
instead it is Grayscale. Grayscale consists of light and dark areas 
that give the image dimensionality.
 

Set Print Modes
You must tell FastRIP what Print Modes to use for both the White ink and Top Colors. Under the File 
Pull-down Menu, select FastRIP Setup. This will open the dialog box to select your printer, layout 
orientation, underbase options and print modes. Once you have made these selections, they can be used 
again for other jobs. For Dark shirts you can get very good “Screen Print” quality White if you select a 
1440 DPI Print Mode for the Underbase. For the top colors of Cyan, Magenta, Yellow, Black and the 
highlight White, choose a 720 DPI Print Mode.

For medium colored shirts, use a 720 DPI Print Mode (faster than 1440 DPI) for the White ink Underbase. 
In some cases, very light colored shirts may not even need a White Underbase. These images can print 
using just CMYK and highlight White to save printing time. 

We recommend you DO NOT mix Print Modes. You will notice that certain Print 
Modes contain a ‘HS” or “HS (Bi-Directional)” while the standard Print Modes 
contain neither. DO NOT use standard Print Modes in conjunction with HS Print 
Modes. The result may lead to registration issues and ruined prints. Please note 
that this warning is not referring to print resolution, i.e. 720 or 1440 DPI. Print 

resolutions can be mixed and matched as needed. If you are not sure how different Print Modes 
work together, do a test print before doing a production run. For more information on Print Modes, 
refer to Chapter 11 - Printing Basics.
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Cure the print
Carefully remove the shirt from the Shirt Board and cure. Keep in mind, White ink will need to be cured 
longer than standard colors. Cure in a conveyor dryer or Heat Press. Refer to Chapter 11 - Printing 
Basics - Curing Your Garments for more information. 

•	 If using a Heat Press, place a silicone treated 
piece of parchment paper (a common baking pan liner) over 
the print and close the press. 

When you open the press, peel the paper immediately. The •	
paper can be used a number of times. After a while, the 
paper will develop wrinkles and will need to be replaced or a 
wrinkle pattern will transfer onto the shirt.

You will only use the silicone treated paper for curing after the entire 
print has been completed. You risk ruining a shirt if you use silicone paper in the Pretreatment phase.

You can also use a standard Teflon pad rather than silicone treated parchment when curing the print in a 
Heat Press. Teflon pads are available from most Heat Press manufacturers. 

IMPORTANT POINT
When printing gradient images with White ink, we recommend having two JPEG 
versions of the artwork at 150-300 dpi. One version having a white background 
and the other having a black. These two files can be created in Photoshop, 
Adobe Illustrator, CorelDRAW or even in FastARTIST. Another option is 
using transparent files (psd etc.) and use the pop-up window for completing the 
underbase settings. Consult your FastARTIST Users Manual for more details. 

There is an excellent video tutorial on “Underbasing with Two Versions of 
Artwork” on the T-Jet Support page. Refer to Chapter 16 - Product Support for 
instructions on logging on and viewing videos.



Chapter 12 - Advanced Printing With White Ink 

120
T-Jet Blazer Series User’s Manual

Washing Directions
For the longest lasting print, the shirt should be turned inside out, washed in COLD water and dried on a 
delicate cycle. If possible, include washing directions to customers along with the finished prints.

When you apply the Pretreatment correctly and choose the proper Print Modes, you will get very 
detailed bright prints like these!

 
 

White Ink Troubleshooting & 
Maintenance
For a complete listing of troubleshooting concerns and problems, refer to Chapter 16 -Troubleshooting.

Concern: White prints seem dull
Solution 1:
You may not be applying enough Pretreatment or not using a 1440 DPI print mode.

Solution 2: 
The Print Head may be clogged. If you had bright White prints before and they now seem dull, you may 
have clogged nozzles. Due to the nature of the White pigment, you may experience more head clogs 
than normal. These can easily be cleared by doing two or three Head Cleaning Cycles. Perform a Nozzle 
Check to be certain nozzles are firing properly. Always follow Chapter 14 - Daily, Weekly and Monthly 
Maintenance. Do not skip a day, week or month.
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Solution 3:
The Highlight White settings in FastARTIST are wrong. You may actually be printing white ink ON TOP 
of the CMYK colors. Reload the image into FastARTIST and run the Underbase/Highlight Wizard again. 
Try not applying a Highlight or toning down the Highlight.

Solution 4:
Dry ink may be causing the Print Head to not seal properly. Due to the nature of the white ink pigment, 
it will build up faster on the capping station and on the wiper blade. Dry White ink around the rim of the 
Capping Station will interfere with the printer pulling ink out of the cartridge during a Head Cleaning 
cycle. Use a sponge foam tipped swab and cleaning fluid or water to clean the 
areas noted below. 

 
Perform DAILY cleaning of these items.
For a complete description on cleaning these parts, refer to Chapter 14 - Daily, Weekly and Monthly 
Maintenance. 

Clean Encoder Strip Do NOT touch the middle part of the 
print head where the nozzles are. This 
could damage your print head.

Clean Spit Tray/Flushing Box Clean Wiper Blade

Clean Capping Station Clean Print Head Area
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Solution 5:
The Print Head is permanently clogged or damaged from lack of maintenance. Before contacting us for 
a replacement or for other instructions, check the print head to see if there is any visible ink or lint stuck 
to it. If so, use FastINK HD Cleaning Solution or Windex on a sponge swab and CAREFULLY wipe the 
bottom of the Print Head in one direction with VERY LITTLE PRESSURE. The print nozzles are very 
sensitive and can be damaged very easily. This procedure should only be completed as a last resort to 
replacement. Flip the alcohol pad and repeat the process. 
 
NOTE: You will need to release the Print Carriage and move the print head to the middle of the machine 
to gain access to it.
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Chapter 13

Printing Other Items
The T-Jet can print on almost any fabric or 
material and you usually don’t need a 
clamping device. FastINK is a water-
based textile ink designed to work not 
only on natural fabric materials, but also 
on non-textile items such as unfinished 
wood, mouse pads, golf balls, metals, 
plastics and more. With the help of Fast 
T-Jet Non-Textile Series Pre/Post 
Treatment, FastINK will adhere to 
almost any type of surface. 

Location and Placement
The hardest part of printing on odd-sized items is determining their print location. Remember, if you are 
facing your machine, the outer right edge is “zero” in your graphics program. Another way to think about 
it is that the printer assembly 
would be the bottom of the 
page.

Make a template or custom 
page size to match the size of 
your Shirt Board.
 
FastARTIST allows you 
to adjust the Page Size to 
match your items in the Page 
Setup window. You must also 
set the correct Page Size in 
FastRIP Setup.
 
 

FastARTIST refers to its page dimensions in terms of width and “height.” For 
purposes of printing a two-dimensional image on a garment or non-textile item, it is 
important to be aware of the fact that “height” means the same thing as “length.”
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FastARTIST Page Size – Go to Layout > Page Size
FastRIP Setup – Go to File > FastRIP Setup 

 
For more information about printing on caps or Non-Textile, such as golf balls, there is a downloadable 
PDF available at www.screenprinters.net.
 
 
 

Adjusting the Platen Height
Before sending any print, check the Platen/Print Bed to Head Clearance. You will most likely need to 
adjust it when printing other items. For the best prints, the printable surface should set to 1/8inch (3mm) 
below the Print Head. If the item has a seam or excess fabric, these areas should be lower than the main 
printing surface. Refer to Chapter 8 - SETUP PART 6: Initialization Utilities for the proper steps. 

WARNING:
Make sure that the printable item has the required distance of at least 3mm from 
the print head. Also be extra careful with other items while releasing and sliding 
the carriage over. If the bed is much too high, you can accidentlay damage it if 
being careless.
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Non-Textile Printing
Required Items and Overview
You must have the following to successfully 
print on Non-Textile items:
			 

Non-Textile Pretreatment1.	
Non-Textile Post-Treatment2.	
fine bristle brush3.	

Optional materials may be required:

Non-Textile Primer1.	
a holder for object(s) (i.e. Golf Ball Holder)2.	
an extra brush or two3.	
Non-Textile Print Modes and Templates: utilize the latest Non-Textile Print Modes by downloading 4.	
the most recent Printer Package from www.myt-jet.com

 
CAUTION: WEAR GLOVES WHEN APPLYING AND USE WITH ADEQUATE 
VENTILATION. HANDLE WITH CARE AND PROTECT EYES WITH SAFETY 
GLASSES WHEN APPLYING AS A SPRAY. BEFORE USE, CONSULT THE 
MATERIAL DATA SAFETY SHEET (MSDS) THAT IS INCLUDED WITH 
THESE PRODUCTS

KEEP OUT OF REACH OF CHILDREN
 

Getting Started
It is necessary to determine if the surface intended for printing will allow the Pretreatment to stick. 
Certain surfaces will accept the direct application of the Non-Textile Pretreatment, while others will 
require first require a coat of Non-Textile Primer. Generally, smooth surfaces such as light switches, 
keyboards, lighters and gloss tiles will require an application of Non-Textile Primer before the Non-
Textile Pretreatment. 

To Test: Apply a very small thin amount of Non-Textile Pretreatment to the intended printing surface. If 
the Pretreatment runs off, it will be necessary to use the Non-Textile Primer. 

If this is your first time using a Non-Textile Pretreatment, it is recommended you 
pretreat small quantities at first to familiarize yourself with the process. 
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T-Jet Non-Textile Primer
Fast T-Jet Non-Textile Primer is designed to be used on high gloss, non-porous surfaces 
as a primer coat prior to the application of our standard T-Jet Brand Non-Textile 
Pretreatment.

DO NOT print directly onto this product. 

Protect your work surfaces with newspaper.
 
 
 

APPLICATION DIRECTIONS: 
Dip a fine bristle brush into the Primer, wiping off any excess on •	
the side of the bottle. Gently brush Primer over the surface of the 
non-textile item, making sure there are no uneven areas. 
 
The Primer must be applied in a thin even layer to ensure optimal 
print quality.

After the application is complete, clean the brush thoroughly with •	
hot water to remove all Primer residue. 

IMPORTANT POINT 
This product can be sprayed on, but the application may not be as smooth as 
necessary for good print reproduction. If applying with an airbrush, spray bottle 
or paint sprayer, you may need to dilute the solution with water. If you dilute the 
Primer, two coats may be necessary. 

Clean up spills and brushes with soap and water immediately after use. •	

Allow the Primer to dry thoroughly before applying the Non-Textile Pretreatment. Dry time will •	
vary but can take up to one hour or more. To speed up the drying process, you may use a hair dryer, 
heat lamp or a heat gun set on a low temperature setting.

A Heat Press may also be used by setting the non-textile item under the heating element. However, •	
DO NOT allow the heating element to touch the non-textile item.
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T-Jet Non-Textile Pretreatment
Fast T-Jet Non-Textile Pretreatment is designed for use as an inkjet ink receptive base 
coat when printing directly onto non-textile materials such as plastic, metal and wood. 
For increased durability of the final print use our Fast T-Jet Post-Treatment on top of 
the final print. When using a Fast T-Jet Inkjet-to-Garment Printer and FastINK Textile 
ink, you WILL NOT need to change inks when using this product.

 
 
 

APPLICATION DIRECTIONS:
Dip a fine bristle brush in the Pretreatment, wiping off any •	
excess on the side of the bottle. Gently brush the Pretreatment 
over the surface of the non-textile item, making sure there are 
no uneven areas. If Primer was applied, then the entire Primer 
treated surface must be covered with Pretreatment.  
 
The Pretreatment must be applied in a thin even layer to 
ensure optimal print quality. 

Use a second brush to apply Pretreatment. After the application is complete, clean 
the brush thoroughly with hot water to remove all residual Pretreatment.  
 

This product may be sprayed on, but the application may not be as smooth as 
necessary for good print reproduction. If applying with an airbrush, spray bottle 
or paint sprayer, you may need to dilute the solution with water. If you dilute the 
Pretreatment, two coats may be necessary.  

Clean up spills and brushes with soap and water immediately after use. •	

Allow the Pretreatment to dry thoroughly before applying the Non-Textile Pretreatment. Dry time •	
will vary but can take up to one hour or more. To speed up the drying process, you may use a hair 
dryer, heat lamp or a heat gun set on a low temperature setting.

A Heat Press may also be used by setting the non-textile item under the heating element. However, •	
DO NOT allow the heating element to touch the non-textile item. 

Since the pretreatment process can take some time to dry, we recommend you 
pretreat as much of the production run as possible to avoid delays due to drying 
time (Do this only after becoming proficient with the Non-Textile Primer/
Pretreatment). 
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Setting up an Image for Printing
To setup an image for print you may use an application such as Photoshop, Illustrator or CorelDRAW, 
however we recommend using FastARTIST. If you will be printing White ink, you MUST use 
FastARTIST. For the purposes of this Manual, we demonstrate will setting up the image using 
FastARTIST. The steps required for printing with other graphic applications will be very similar- please 
consult your application’s Owner’s Manual if needed.

Setup the printing area in which you will be printing on. To do this 1.	
you will need a measuring tape to measure the width and height 
of the Non-Textile item.

2.	  From within FastARTIST select File > FastRIP Setup. From the 
Setup window, select Page Setup. In the Page Setup window, select 
Custom under the Page option. Enter the Height and Width of the 
Non-textile item you have measured. After entering the values, 
click OK to return to the workspace.

 
 
 

 

3.	 Select Layout > Page Size. For the Page Size, enter the Height 
and Width of the Non-textile item you have measured. After 
entering the values, click OK to return to the workspace.

The non-textile item dimensions will now be represented by a 
black box located within the workspace. If this is not displayed, 
click View > Show Page Size to view the black box. 

 
 
 
 
 
 

Import4.	  your image for printing and position the image as you would like it to print on the non-textile 
item. For further details, please refer to your FastARTIST User’s Manual.

Select 5.	 File > Print to FastRIP > Position the image and click on the printer icon located in the Printer 
Toolbox. This will send the image to FastRIP.  
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Printing on Golf Balls 
To print golf balls you will need a Golf Ball Holder 
(optional), T-Jet Non-Textile Pretreatment, and 
Post-Treatment (T-Jet Non-Textile Primer is not 
necessary). For more information, refer to the 
literature that came with your Golf Ball Printing Kit

Load the Golf Balls into the Holder and place the 1.	
Over-spray Shield on top of the balls. The Shield will protect areas not intended to be printed upon 
from Pretreatment and over-spray. 

2.	 Dip a fine bristle brush in the Pretreatment, wiping 
off any excess on the side of the bottle. Gently apply the 
Pretreatment to the exposed golf ball surface, making sure there are 
no uneven areas. 

Allow the Pretreatment to dry thoroughly before printing. Dry time 3.	
will vary, but it may take up to one hour or more. To speed up the drying process use a hair dryer, heat 
lamp or heat gun set on a low temperature setting. 

 

Golf Ball Holder Placement
Align the four holes in the base of the Golf Ball Holder with the four pins on the Platen designed for the 
FIRST Shirt Board. Place several golf balls within the Holder and use the Height Adjustment Knob on 
the Print Bed to ensure the proper Print Head clearance is maintained when loaded.

If you are using multiple Golf Ball Holders, you must check the Print Head 
clearance of each one.

Loading Golf Ball Template (FastARTIST Only)
Go to 1.	 File > Open and double-click 
on the Golf Ball Holder Template to 
open. 

Import2.	  the images or text 
you wish to print and place them 
inside of the grid lines. 
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Choose a Print Mode (Non-textile Print Mode). For a list and description of the available Print 3.	
Modes, please refer to your FastARTIST User’s Manual.

Print to FastRIP.4.	

T-Jet Non-Textile Post-Treatment
This Post-Treatment is a protective coating used for prints on non-textile surfaces. Using the post-
treatment will prevent fading of ink colors, extend the life of the image as well as waterproofing and 
acting as a UV protectant.

APPLICATION DIRECTIONS:
Shake the can before each use. After all ink has dried thoroughly, 
apply a thin coat, holding the can 4 to 8 inches from surface and 
using a swift motion to prevent overspray and unwanted build-up. If 
build-up does occur, use a lacquer thinner to remove. A second coat 
may be applied after approximately two minutes of drying time. 
Allow treated surfaces to dry for 30 minutes to one hour in a clean, 
dust free area before handling. Allow 24 hours cure time prior to 
placing coated articles into service.

Clean the valve after use by turning the can upside down and spraying a short burst until cleared. If the 
nozzle is clogged or sprays irregularly, check for clogging within the opening. Scrape off excess coating 
with a soft object and twist the valve one half turn to close.

 

Post Treatment Warnings and Safety 
Information
Use Fast T-Jet Non-Textile Post-Treatment only in a well ventilated area.

Fast T-Jet Non-Textile Post-Treatment VAPOR is HARMFUL and MAY AFFECT THE BRAIN OR 
central NERVOUS SYSTEM, CAUSING DIZZINESS, HEADACHE OR NAUSEA. It may CAUSE 
NOSE, THROAT IRRITATION and LUNG IRRITATION. OVEREXPOSURE MAY CAUSE LIVER, 
KIDNEY OR BLOOD DAMAGE. It may CAUSE EYE or SKIN IRRITATION. Fast T-Jet Non-Textile 
Post-Treatment is HARMFUL IF SWALLOWED. 

Reports have associated repeated and prolonged occupational exposure to solvents with permanent brain 
and nervous system damage. Intentional misuse by deliberately concentrating and inhaling the contents 
may be harmful or fatal.

CAUTION: Do not puncture or incinerate (burn) container. Exposure to heat or prolonged exposure to 
sun may cause bursting. Do not expose to heat or store at temperatures above 120°F. Vapors may ignite 
explosively. Keep away from heat, sparks and flame.
VAPORS MAY CAUSE FLASH FIRE. Do not smoke while using this product. Extinguish all flames 
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and pilot lights and turn off stoves, heaters, electric motors and other sources of ignition during use and 
until all vapors are gone. Prevent buildup of vapors by opening all windows and doors to achieve cross 
ventilation. Use only with adequate ventilation. Do not breathe dust, vapors or spray mist. Ensure fresh 
air entry during application and drying. If you experience eye watering, headache or dizziness or if air 
monitoring demonstrates that vapor/mist levels are above applicable limits, wear an appropriate, properly 
filled respirator (NIOSH/MSHA approved) during and after application. Follow respirator manufacturer’s 
directions for respirator use. Avoid contact with eyes, skin and clothing. Wash thoroughly after handling.

KEEP OUT OF REACH OF CHILDREN
First Aid: in case of contact, immediately flush eyes or skin with plenty of water for at least 15 minutes. 
Remove contaminated clothing and shoes. Get medical attention. Wash clothing before reuse. If 
swallowed, get medical attention immediately. If you experience difficulty in breathing, leave the area 
to obtain fresh air. If continued difficulty is experienced, get medical assistance immediately. If spilled, 
contain spilled material and remove with inert absorbent. Dispose of contaminated absorbent, container 
and unused contents in accordance with local, state and federal regulations.

The Manufacturer shall not be liable for loss or damages whether direct, indirect, incidental or 
consequential, regardless of the legal theory asserted, including negligence and strict liability. Read 
Material Safety Data Sheet before use. 
 
 

Non-Textile Printing Tips
When brushing on any of the treatments, make sure they are applied in smooth, even and thin •	
layers. 

Having two brushes can make the pretreatment and priming processes easier. Use one for the •	
Non-Textile Primer and one for the Non-Textile Pretreatment. 

Cleaning the brushes when done with hot water and letting dry will prevent them from drying out •	
and ruining the brushes. 

When printing on Non-Textile items, use a piece of film that covers the whole item and print a test •	
print on the film to see if it is in alignment with the desired printing area. 

The maximum printable area of a Fast T-Jet Blazer Express is 17” x 47”. To maximize production, •	
you can line up multiple items to print more then one item at a time. 

If you have a Heat Press, you may dry items faster by placing them under the element, but you •	
MUST avoid contact between the item and the heated surface.
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Chapter 14

Daily, Weekly and Monthly 
Maintenance

Your T-Jet Blazer Series Printer should work trouble free IF you take the time to understand and 
perform the necessary maintenance. 95% of our Technical Support calls come from people who have 
not maintained their machines properly. While it may appear to be “just” an inkjet printer, it is a VERY 
SPECIAL inkjet printer. When printing on garments, it must print A LOT more ink than when printing 
on paper. This can, and will, cause excess ink to coat internal parts if the machine is not maintained on a 
regular basis.
 

Release the Print Carriage for Access
To access the printer parts that need to be cleaned on a regular basis (daily maintenance) the print carriage 
needs to be released and positioned  away from the capping station. 

Lift the printer cover (if it is not already lifted) and locate •	
the Carriage Release button (blue) located in front of the print 
carriage on the right side of the printer.

Press down and slowly move the Print Carriage to the left until its •	
sits in the center of the Shirt Board.

See the video online named Moving Print Carriage 
for Access. Refer to Chapter 17 - Product Support for logging onto the support site 
to access the available videos.

 

Daily Maintenance
Daily maintenance is a very critical part of keeping your printer performing at its best. By not following 
the required daily maintenance described below you will void your warranty as well as damage the 
machine. Many of these items have been covered earlier in this Manual, but the following list will help 
you understand and prioritize the maintenance tasks that need to be completed on a regular basis.

1. Keep Your Encoder Strip Clean
A main concern of many T-Jet users is the printer getting “confused” while printing an image. An inkjet 
printer tells the Print Head what and where to print an image by using a thin piece of film called the 
Encoder Strip. A dirty Encoder Strip can cause images to print in the wrong location, large blocks of ink 
to spray on the garment, double-images, dark bands across the print, thin horizontal lines as well as other 
concerns.  

While in motion, the Print Head continually receives data through this strip. Should the strip become 
coated with lint from shirts or ink from overspray, it can confuse the printer. Even very small amounts of 
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dirt can interfere with the exchange of data between the Print Head and the Encoder Strip.
Manually move the carriage to the left and right throughout the cleaning process to allow you reach and 
clean the entire Encoder Strip.

For best results use 90% Isopropyl Alcohol pads 
(NOT “Rubbing Alcohol” pads) and wrap the 
alcohol pad around both sides of the Encoder 
strip. Gently move the pad in both directions. If 
the pad becomes black, replace pad and clean 
again.

Allow the Encoder Strip to AIR DRY.  
 
Manually return the Print Carriage back to the 
Capping Station to clean the rest of the Encoder 
Strip.
 

IMPORTANT POINT: 
The Encoder Strip is translucent with small marks on it. Be 
careful NOT to scratch it or the Print Head sensor will not read it correctly. Only 
use FOAM TIP cleaning swabs or Isopropyl Alcohol Pads when doing any 
maintenance or cleaning inside your T-Jet.
 

 
 

2. Check and Clean the Capping Station
The Capping Station is the rectangular piece onto which 
the Print Head seats. Ensure the outer rubber seal is free 
from dried ink and garment fibers. Ink residue around the 
edge of the Capping Station may keep the Print Head from 
sealing properly and can cause Print Head clogs. Be aware 
that White ink will build up faster and thicker than regular 
colors. Use a foam swab along with FastINK HD Cleaning 
Fluid, distilled water or glass cleaner to loosen the ink 
residue and repeat to confirm that the seal is clean. 

IMPORTANT POINT:  
When cleaning the Capping Station, be careful NOT to move it out of position or 
the Print Head will not seat properly. If you push down on it too hard, it WILL 
move off of its mount causing the Print Head to not be seated. 
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3. Clean the Wiper Blade
The Wiper Blade is a part of the capping station (above the 
capping station) that wipes off left over residue after printing 
large volumes of jobs. The wiper blade is an important 
component and needs to be kept clean in order to reduce 
other maintenance issues. 
 
Using a foam tipped swab along with FastINK HD Cleaning 
Fluid, clean both sides of the wiper blade, making sure that 
there is no residue present.
 
NOTE: Move the clear plastic cover out of the way for access

4. Check and Clean the Spit Tray
The Spit Tray/Flushing Box assembly sits to the left of the 
capping station and wiper. The Spit Tray collects waste 
ink from Head Cleaning Cycles (etc.) very quickly. Check 
it regularly and clean if needed. 
 

 
 

5. Clean the Print Head Area
After printing several jobs, ink and lint will accumulate 
around the Print Head area. Using a foam tipped swab along 
with FastINK HD Cleaning Fluid, distilled water or glass 
cleaner, wipe the surrounding area of the Print Head. 

You may need to perform this procedure if anything should 
come in contact with the Print Head. Again, always check 
the Platen height settings to avoid the print head coming in 
contact with anything.
 
 

WARNING
Do NOT touch the middle part of the print head where the nozzles are. This could 
damage your print head. Only clean around the outside area of where the nozzles 
are.
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6. Run Head Cleaning Cycles - Start and End of Each Day
After turning ON the machine at the start of the day, perform 
1 or 2 Head Cleaning Cycles. Press and hold the Right/Clean 
button on the LCD control panel, for three seconds to initiate. 
Also, perform Head Cleaning Cycles at the end of a large shirt 
run as well as at the end of each day. 
 

Another option is to setup your computer 
to schedule automatic Head Cleaning Cycles daily. Prevent from forgetting this 
important step and refer to the following chapter, Chapter 15 - Tips and Utilities to 
Maximize Print Quality for more information. 
 

7. Ink Levels and Care
Top off the ink levels at the beginning of each shift/day to keep 
the levels as clos to the full line as possible. Make sure that the 
ink levels do not get too low. If the ink gets too low, the ink lines 
will run dry.  When refilling the ink bottles, STOP at the top line 
marked on the front of the bottle. This will prevent excess pressure 
from building up within the cartridge, which can cause ink to 
drip from the Print Head. Also, do not overfill the cartridges or 
overflow can occur. The ink should NEVER go above the bottles 
200 mL mark.

Agitate the white ink cartridges at the beginning and ending of 
each day. This will keep the ink in the best possible condition. 
For instructions on agitating the White Ink, Refer to Chapter 12 - 
Advanced Printing With White Ink - White Ink Care. 

 
8. Turn Off Your Printer (unless using the AutoClean Function) 
Turning the printer off nightly will ensure that the print carriage is properly seated on the Capping 
Station. If it is not seated, ink may dry up leaving undesirable effects. This process may not be necessary 
if utilizing the AutoClean function in FastRIP. To learn more about the AutoClean Function, refer to 
Chapter 15 - Tips and Utilities to Maximize Print Quality.
 
Turn OFF the machine at night using the 
red power button on the User Interface. 
Wait for the printer to completely power 
down (the Print Carriage will dock onto 
the capping station). It is critical that 
you ensure that it is properly seated. 
Next, turn off the main Power Switch 
next to the AC cord. DO NOT turn off 
your printer at the power strip.
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Weekly Maintenance
Weekly Maintenance is also very important to practice in order to keep the best results in daily printing as 
well as preventing any future issues. The amount of weekly maintenance required depends on how many 
garments were printed that week. Follow these steps to ensure that your T-Jet continues to print the best 
images possible.

1. Perform a Thorough Cleaning of the Entire Capping 
Assembly
In addition to daily maintenance of the Capping Assembly, we recommend doing a thorough cleaning of 
these parts weekly. The daily cleaning is effective, but to keep maximum print quality, clean these parts 
thoroughly at least once a week. Parts are as follows:

Capping Station•	

Wiper•	

Spit Tray/Flush box•	

 

2. Monitor Waste Ink Tank Levels (Change if Necessary)
Always keep an eye on the Waste Ink Tank Level 
Indicator located on the LCD Control Panel. We 
recommend having a replacement Pad on hand for when it 
fills up. When the Waste Ink Tank is full, the LCD control 
panel display will read “Waste Tank Full” and you will 
be unable to start any more print runs (it will finish any 
images in progress).  When full, remove the tank from the 
machine and change the pad.

•	 Remove the Waste Tank 
The Waste Tank is located below the bank of 
white ink cartridges and behind a metal face plate. 
Remove the two finger screws to remove the face 
plate.

WASTE TANK FULL

Waste Ink Tank Level Indicator
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•	 Next, gently slide the metal cowling free and 
the Waste Tank will be easily accessible. To remove 
the Waste Tank, slide if from its bin. 

Always r eplace the Waste Ink Tank or Pad •	
 

Reset the Chip•	  
Next, use the Chip Reset Module to reset the Waste Tank chip. For instructions on resetting 
the chip, refer to Chapter 3 - SETUP PART 2: The Bulk Ink System - Resetting the Bulk Ink 
Cartridges. The instructions for resetting a bulk ink cartridge also apply to the Waste Ink Tank.  

Replace the Waste Tank•	  
Slide the Waste Tank back into place and reattach the metal face plate.

WARNING: DO NOT reset the Waste Ink Tank chip without first replacing the 
pad.  Practicing this correct method will leave your Waste Ink Tank monitor on the 
LCD accurate. Failure to change the Waste Ink Tank pads when necessary WILL 
cause ink to overflow from the Tank and onto critical components of your printer. 
In addition to having a large mess to clean up, you may short out the motherboard. 
This will be very costly in terms of downtime and repair expense. Damage from 
this type of incident is NOT covered by any warranty. 

 IMPORTANT POINT 
U.S. Screen is not liable for any damage caused by ink to property such as carpets, 
flooring or furniture . Please read and understand all operating and maintenance 
procedures before using the Fast T-Jet Blazer Express.

 

3. Agitate Your Stored White Ink
As explained in Chapter 12 - Advanced Printing With White Ink, the white ink requires 
a weekly agitation to keep the pigment suspended. For best results, shake the bottle 
vigorously for at least 1 minute.
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Monthly Maintenance 
You will need to lubricate the Bed Rails and Rail Guides on a Monthly basis to facilitate the Print 
Assembly moving smoothly during image output. This procedure will help prevent banding as well as 
several other image quality concerns.

1. Clean the Print Carriage Drive Belt Gear and Roller
During normal operating conditions, lint that 
is coated with Pretreatment can get caught in 
the Print Carriage Drive Belt Gear, located 
in the right rear of the housing. This lint can 
clog causing the belt to slip, resulting in the 
Print Carriage jerking around and/or not 
complete print jobs. We recommend checking 
this gear at least once a month and cleaning if 
necessary.

Release Belt•	  
To clean, first release the print carriage using the blue release lever and move it to the left so it is 
out of the way. Next remove the drive belt from the gear side of the printer (right side). Be careful 
not to damage the belt in any way during cleaning. The belt is equipped with an auto tension spring 
and can be removed fairly easily by carefully pulling on the belt (do not twist) until you can pull it 
off of the gear assembly.

•	 Clean Gear 
Clean the gear using a wire brush or computer 
vacuum. By moving the print carriage from left to right, you 
will be able to clean the entire diameter of the gear. For heavy 
buildup, use a pick of some kind to pry away any debris that 
may be stuck in the gears.

Located at the opposite end of the Printer Assembly is the Drive Belt Roller. Occasionally this component 
will require cleaning as well. The belt cannot be easily removed from the roller.

Clean Roller•	  
Using an old toothbrush or something equivalent, carefully clean the roller from the inside where 
the belt is not touching. DO not use a utensil that may damage the roller. Move the print carriage to 
expose the rest of the roller. 
 
NOTE: While performing maintenance on any internal printer part, make sure to avoid ANY 
contact with the Encoder Strip. It is fragile and can easily be damaged!   

2. Lubricate the Bed Rail Guides
Use a Grease Gun to inject a Lithium-based soap grease 
(White Grease) through the four Zerk fittings. DO NOT 
over-lube. Using only one “squirt” per Guide is necessary. 
Lubricating the two Main Rails will prevent oxidation (rust) 
and debris build-up, allowing the Printer Assembly to travel 
freely. This will help prevent registration issues that can occur 
in multiple pass prints.

Drive Belt Roller                  Drive Belt Gear
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A Grease Gun and Lithium-based grease can be purchased from most major Auto Parts stores. Connect 
the Grease Gun to the Zerk fitting pictured here to lube the Rail Guides. There are 2 Rail Guides per side, 
4 total.

3. Lubricate the Bed Rails
To correctly lubricate the Main Rails, 
apply a very THIN coat of the same 
Lithium-based grease used for the 
Rail Guides. Spread the White Grease 
along the ENTIRE length of both 
Rails using a clean, lint-free cloth. 
DO NOT use any other lubricant, 
such as WD-40 or Machine Oil, or 
you will risk contamination of the 
Rail Guides. 

DO NOT LUBRICATE DRIVE SCREW
The Drive Screw MUST NEVER be lubricated or wiped off 
with a chemical solvent. This is due to a special coating that has 
already been placed on the Drive Screw to prevent dust buildup 
that could potentially hinder the fluid movement of the Printer 
Assembly. Treating the Drive Screw will allow dust buildup, 
contaminating the drive mechanism.  

 

4. Ink Cartridge Cleaning (Flush)
In order to keep the white ink flowing smoothly, a monthly cleaning of the 4 white ink cartridges is 
necessary. The CMYK cartridges may need cleaning every 3 months. Ink sediment will build up over time 
and can effect the ink flow and may cause clogs and starvation. This procedure will also keep your ink in 
a clean environment, which is very important for the white ink to work properly as well as the colors.

Remove a white ink cartridge from the printer and shake (cover breather) to mix as much of the •	
sediment as possible. Pour the ink into the stored ink bottle.

Next, using warm water, clean out the bottle until all parts appear cleaned. Let the cartridge air dry.•	

Refill the cartridge with ink and prime using the priming pump. Refer to•	  Chapter 3 - Bulk Ink 
System for filling and priming steps.

Repeat for the next cartridge.•	

Perform a Head Cleaning Cycle and Nozzle Check to verify the ink is still flowing through the ink •	
lines.

If the Nozzle Check is far from “good” a Power Cleaning may be necessary, however, if the Nozzle •	
Check is close, perform up to 3 more Head Cleaning Cycles. 

Rail /Rail Guide- one per side (two total)

Drive Screw
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Maintenance Schedule Checklist
Use this Checklist as a guide to ensure critical maintenance is performed on a regular basis. DO NOT 
SKIP A DAY, WEEK OR MONTH! The Checklist may also be downloaded from www.screenprinters.net
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Chapter 15

Tips and Utilities to 
Maximize Print Quality

This section will cover basic and “not so basic” tips and utilities to help keep your printer and your 
printed images the best that they can be.

Eliminating Ink Drops on Shirts
When you perform a Head Cleaning, ink is forced through the 
Nozzles and the Print Head is cleaned and wiped by the printer. On 
occasion, this may not clean away small pieces of shirt lint that collect 
around the base. This excess lint can create ink build up, causing ink 
to drip onto a garment. Using a foam tip swab, water, glass cleaner, or 
cleaning fluid, clean any lint and ink residue off the edges.

BE CAREFUL not to rub the bottom of the Print Head. This is where 
the actual Nozzles are located and they can be easily damaged.

 

Shake Shirts and Press to Minimize 
Lint
T-Shirts generate a lot of lint and it is important to minimize the amount of lint inside your machine. Get 
in the habit of shaking the shirt or garment before loading it. If you feel shirts you are using generate 
excess lint, use a Pet Hair Pickup Roller on the shirt after it is placed on the Shirt Board. You may also 
preheat them in a Heat Press for just a few seconds to flatten the fibers.

Protect Printer Environment - Keep Lid 
Closed
Due to the airborne nature of the White ink Pretreatment, you should try to pretreat shirts in a different 
room or far away from the machine. If pretreating in a different room is not an option, then make sure 
the lid on the printer is kept closed at all times, especially during the print process. Pretreatment will 
immediately clog the Print Head if it comes in contact with any ink. We strongly suggest creating a 
separate enclosed area, such as a large cardboard box at an absolute minimum. This will help keep 
overspray away from the Print Head and the Encoder Strip as well. 
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Humidity and Environmental Control
Controlling the environment in which your printer “lives” is a must! During the cold winter months, dry 
heat is often pumped into a room. This is not a good thing for inkjet printers! They prefer humidity levels 
of 40% to 60%.

If your room is dry, place a humidifier in the room and buy an inexpensive 
hygrometer from Radio Shack, Target, Walmart etc. to measure the humidity 
level. In the summer months, if the humidity is too high, use a dehumidifier. 
Try very hard NOT to place this machine in a dusty, dirty or non-climate 
controlled environment (like a Screen Printing shop or a garage). For best 
results, place the printer in a dust free room with air-conditioning. 
In addition, DO NOT not allow fans to blow air across the Print Head. 
This will dry the ink and cause a clog, seriously affecting your printer’s 
performance.

Clean Bulk Ink System Computer Chips
The small computer chips on the back of the ink cartridge can get dirty and not make good contact. If 
you get sporadic error messages on certain colors, clean the chips with a foam-tipped swab and Isopropyl 
Alcohol. A pencil eraser also works well for this task.

RAM and Your Computer
RAM is the temporary memory that your computer uses when processing complex data. RAM is NOT 
expensive and most computers ship with only 512mb of RAM, which is not enough, especially when 
using FastARTIST and FastRIP. Your computer should have at least 2 GB of RAM.

If using or upgrading to Windows Vista, you will need at least 2GB of RAM for proper operation of your 
printer and software.

 

No Windex on Clear Cover
The clear window on the top of the printer does not like Windex or other glass cleaner containing 
ammonia. Using this as a cleaning solution will cause the window to crack and possibly break over time. 
Use only a mild soap and water solution to clean this part of your printer. You may use Windex on the 
metallic sides and Platen, but take care not to allow ANY Overspray to land on the window area.
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When in Doubt, Unplug Everything
Sometimes inkjet printers just get “confused,” especially if you stop them in the middle of a run. If 
the printer is suddenly acting abnormally, turn everything OFF and unplug the power cord. Make sure 
to disconnect the USB cable between your Fast T-Jet Blazer Express and the computer to end data 
transmission that still may be occurring. Leave everything unplugged for a few minutes and then plug it 
all back in and start over.

You MUST cancel all print jobs for this to be effective or they may resume printing when you again turn 
ON the computer and printer.

Preparing your T-Jet for Downtime
1 to 3 Day Downtime
We recommend you schedule the Automatic Head Cleaning function every 6 to 8 hours using FastRIP. 
This will help prevent Print Head and Capping Station issues caused by dried ink, lack of use or a dry 
environment. Refer to the following section in this chapter named “Auto Head Cleaning Function” for 
more details. 

4 to 9 Day Downtime
In the event your printer will sit for more than 1 week without use, you MUST:

Complete all of the Daily Maintenance steps 1.	

Remove all of the bulk ink cartridges and replace them with cleaning solution cartridges. 2.	

Perform a minimum of 2-3 Power Cleaning Utilities to flush ink from the Ink Lines. Perform as 
many Power Cleanings as needed until all of the Ink Lines are Clear. Then execute one more Power 
Cleaning to thoroughly flush the system. Refer to Chapter 8 - SETUP PART 6 - Initialization 
Utilities for instructions on executing the Power Cleaning Utility.

Make sure that the Print Head docks securely on to the Capping Station with no visible gaps.3.	

Power OFF the printer from the User Interface, flip the Breaker Switch to the OFF position and 4.	
unplug the printer from its AC source. 
 

9 Days or More Downtime
If the T-Jet will sit for 9 days or more, please call our technical support department for instructions.
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Additional Utilities 
A typical print problem that can occur is when lines are missing in the final image. This is called banding 
and can happen for a variety of reasons. The most common reasons for banding are a dirty or clogged 
Print Head, or dirty Encoder Strip.

If your prints are unexpectedly light, or dots or lines are missing, you may need to clean the Print Head. If 
you allow one of the ink bottles on the bulk ink system to run dry or if your printer has been sitting for a 
few days without use, you will need to clean the Print Head.

In addition to the Utilities mentioned in this Chapter, refer to Chapter 8 - SETUP 
PART 6: Initialization Utilities, for instructions on performing Power Cleanings, 
Nozzle Checks, Leveling the Shirt Board and Shirt Board Height Adjustments. 
Also see Chapter 9 - SETUP PART7: Print Head Alignment.

Regular Head Cleaning
You can execute a regular head cleaning by simply holding down the RIGHT ARROW button on the LCD 
Control Panel for 3 seconds. In addition, you should always turn your printer OFF when not in use to 
allow it to go through a regular head cleaning cycle on start-up.

 
 

Auto Head Cleaning Function (Optional from FastRIP)
A new feature of FastRIP 9.0 is the ability to schedule an Auto Head Cleaning session. One of the most 
common problems with printing white ink is the ink’s tendency to clog the Print Heads. The ink must 
also be agitated on a regular basis to keep its pigments from settling within the bottle. The Auto Head 
Cleaning function tells the printer to perform a Head Cleaning during the night, helping to prevent 
ink settling and head clogging leaving your T-Jet Blazer Series Printer ready to print first thing in the 
morning.

To utilize the Auto Head Cleaning function, you must set it up within the FastRIP interface on your 
computer. For the scheduled session to take place, DO NOT turn OFF your printer when you have 
completed your day. 

1.	 Set the Printer to READY Status

From PAPER OUT ROLL/CUT Mode (print •	
status), press the LEFT/PAPER button once.

Open FastRIP 9.02.	  

READY
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Setup in FastRIP3.	

•	 Click on the Queue pull down menu and select properties.

Select Printer status from the •	
left of the Queue Properties 
Window.

Put a check mark in the Head •	
Clean check box.

Type •	 in 8 in the first box, 
representing hours. This will 
set the printer to run a head 
cleaning every 8 hours.

Click OK.•	

 
 
 

4.	 Verify that the FastRIP Queue is running

The FastRIP Queue must be running in order for the Auto Head Cleaning Function to run. 

The easiest way •	 to verify this 
is to make sure that the Stop 
Queue icon is lit up. This 
is the icon that looks like a 
stack of papers with a stop 
sign over it.

 
 
 

Setup Computer to Allow the Auto Head Cleaning Function 5.	

Make sure that your computer is NOT setup to go into •	 Sleep Mode. If your computer goes into 
sleep mode, it will disrupt the Auto Clean process. 
 
To make adjustments or to check, right click on your desktop to get the Display Properties 
window. Next, select the Screen Saver Tab and press the Power button towards the bottom of 
the window. The Power Options Properties window opens and displays a list of several options. 
Click the Power Schemes tab at the top if it is not selected already. You can make your preferred 
selections below under the settings section and then click Save As to save as a custom scheme or 
you can click the Schemes drop-down arrow and select Always On. Notice that in the settings area, 
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everything is set to Never be turned off except for the monitor; your monitor may still be set to turn 
off whenever you would like. 

Make sure you leave the printer and computer turned on and that  •	 FastRIP is open at all times.

Setting your computer to perform the Auto Head Cleaning Function does change the fact that you 
still need to follow all other ink care procedures and practices, such as rotating.

Print Head Replacement
In the event that the Print Head strikes a garment, Shirt Board or other object, the Print Head may need to 
be replaced. If you leave the printer unattended for long periods of time, a serious clog may result and the 
Print Head will probably need to be replaced.

Replacing the Print Head takes less than 30 minutes and there is an instructional video available online 
at www.screenprinters.net. You can also download an Installation Guide in PDF format for reference. 
Replacement Print Heads are available from U.S. Screen Print and Inkjet Technology or possibly your 
dealer and come with the installation guide.

If you are dependent upon your T-Jet Blazer Series Printer and cannot afford to be down for a few days, 
we recommend keeping a replacement Print Head in stock.

See the instructional video online on replacing a print head. Refer to Chapter 17 
- Product Support for information on logging on to our support site.



149

Chapter 16

Troubleshooting
This chapter was written to help you find solutions for what has been considered common problems.  
Through years of research and development, there is still common concerns and areas that may be 
difficult to resolve especially with inkjet-to-garment being such a new technology. Although we have the 
best technical support in the industry, we recommend skimming through this chapter with any problems 
or concerns you may have. It is likely that the answer to your concern is located in this chapter. We have 
not only included the cause of the particular problem, but also ways to prevent it from happening  in the 
future. Note: the topics listed in this chapter are numbered in random order. Also in this chapter is a 
list of popular Error Codes that may show on the LCD Control Panel. If you have any questions, doubts 
or concerns contact our friendly support staff.
 

To view videos of some popular issues, log on to www.myt-jet.com and visit the 
supports section for the latest videos, tutorials and top ten answers to common 
questions. Refer to Chapter 17 - Product Support for instructions on logging on to 
the support site and viewing videos and accessing technical documents. 
  

Common Problems 
1. Curing the Garment Makes the Print Dull 

After printing an image, the color looks great, but after 
curing, the print looks dull.

Causes:
The temperature is set too high on the Heat Press•	  
Test the temperature using a “touchless” infrared 
thermometer or heat testing strip. If the temperature is too hot, it could scorch the shirts and ink 
leaving a dull look.

There is too much pressure being applied to the shirt during curing•	  
When curing your shirts, make sure you do not apply too much 
pressure. Apply a medium amount of pressure.

The wrong type of paper was used•	  
Make sure the paper that is used for curing is either a Teflon pad or silicone treated paper. Also, the 
paper will need to be replaced after several uses. 

Prevention:
Get to know your Heat Press or dryer. Every make and model has its own “personality.” Frequently test 
the output temperature to confirm that it matches your desired settings. Refer to Chapter 11 Printing 
Basics - Curing Your Garments, for curing times and details.

BEFORE AFTER
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2. Underbase and Color Do Not Line Up for Subsequent Images 
The first printed image is great, but the Underbase and Top Color registration is off for either the 
second and third Shirt Board for the PRO or images on the next run for the Express.

Causes:
You are using a Page Size greater than the maximum printable area•	  
Make sure you are using the pre-made templates within FastARTIST.

You have pressed the •	 Green button(s) on the UI to early 
The job must be spooled and read Printing in the RIP window BEFORE pressing the Green print 
button(s) on the User Interface.

The printer is in the wrong mode.•	  
Make sure that you are in print status on the LCD screen. PAPER OUT/ROLL CUT MODE.

The “SERVICE ONLY” button has been pressed on the LCD.•	  
Depress the button and restart the printer.

Solution: 
You must do a complete shutdown and reboot of the printer twice to clear the error. Turn OFF your printer 
completely. Reboot and allow it to perform a complete Start-up Cycle. Completely shut down the printer a 
second time. After it has completed another Start-up Cycle, the error will be cleared.

Prevention: 
Use the FastARTIST templates provided with your FastARTIST software package. If printing other items, 
pay attention to your print area versus your art size (pasteboard). Refer to Chapters 10 and 12 for more 
information.

Be patient. Only press the Green “send print” button when the job in the FastRIP  queue reads “Printing”.

 

3. There Are Drops of Ink on Garments 	
The Print Head is leaking/ dripping ink on garments.

 
Causes 1:

The Print Head is saturated with ink•	  
Thoroughly clean the Capping Station. The Capping Station can become dirty with garment lint or 
fibers as well as dried ink. This will prevent it from adequately cleaning the Print Head.

Debris or shirt fibers have collected on the Print Head and Print Head Carriage•	  
Gently clean the bottom of the Print Head Area to remove any debris, dried ink and fibers. Also 
check the Capping Station to ensure it is clean and free of debris and lint. Refer to Chapter 14 - 
Daily, Weekly and Montly Maintenance - Daily Maintenance - Cleaning the Print Head Area.

Too much ink is coming through the Print Head•	  
If you filled the Bulk Ink Cartridges past the Full Line there could be too much pressure in the bulk 
ink system ink lines, forcing ink out of the Print Head.
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The Print Head may need special cleaning if not damaged.•	  
Order a replacement Print Head and replace following the instructions.

Preventions:
Clean the Capping Station on a regular basis.•	
Clean debris from the Print Head daily.•	
Do not overfill the Bulk Ink Cartridges. •	
 
 

Cause 2: 
The Print Head may need special cleaning if not permanently clogged. 

Solution:
Follow the instructions in Chapter 13 on releasing the print carriage. Check the print head for excess ink 
drops or lint. If so, with an Isopropyl Alcohol wipe, carefully, in one direction, wipe the print head using 
little pressure. You can easily damage the nozzle by pressing too hard. Doing this may prevent you from 
replacing the print head. Repeat once or twice if necessary by flipping or replacing the alcohol pad. 

Prevention:
Refer to •	 Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a section. 
 

Cause 3: 
The Print Head has been damaged by a collision. 

Solution: Order a replacement Print Head and replace following the instructions. 

View the video online covering the steps in replacing a print head. Refer to 
Chapter 17 - Product Support for instructions on logging on to the support site 
and viewing videos and accessing technical documents. 
 

Prevention: Always check the Platen to Print Head Clearance prior to printing. 

4. The Print is Wiping Off, Washing Out, or Fading/Bleeding	
The printed image, after curing, is wiping off, washing out, fading badly or bleeding.

Causes:
The garment was improperly cured•	  
Textile ink requires a temperature of 330 degrees F. to cure properly. Apply this heat for at least 
60-90 seconds for Light garments and for at least 180-240 seconds for Dark garments.

Too much or too little pressure was applied using a Heat Press•	  
When pressing the garment, the Heat Press should rest on the silicone or Teflon paper with medium 
to heavy pressure. This allows the moisture within the inks to escape and properly cure without 
scorching the shirt.
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The temperature of the Heat Press was not correct•	  
Make sure the Heat Press is heating up evenly and reaching the correct temperature of 330º F. You 
can test this with a touch-less infrared thermometer or heat testing strip. 

Too much Pretreatment was applied•	  
Avoid soaking the garment with Pretreatment. Do not print on shirts where the Pretreatment may 
still be wet.

An insufficient amount of Pretreatment may have been applied•	   
Apply more Pretreatment on successive shirts and cure again.

An incorrect type of fabric was used for printing•	   
For best results print onto 100% cotton. For 50/50 blends of cotton and polyester, the ink needs 
to be cured quickly to reduce possible bleeding. FastINK Textile Ink will NOT work on most 
synthetic materials such as waterproof Nylon.

The garment was washed improperly•	  
Wash in cold water and dry on a delicate dryer setting.

Preventions:
Make sure your Heat Press is heating up evenly and reaching the correct temperature.•	

Pretreat evenly and away from the printer.•	

Cure Pretreatment properly. Refer to •	 Chapter 11 - Printing Basics for curing times and details.

5. Colors Don’t Look Correct 	
Printed colors appear different from what you see on the 
computer monitor prior to printing.

Causes:
Your nozzles could be clogged.•	  
	 ► Perform a Nozzle Check on a piece of clear film.  
	 ► Clean the Capping Station. 
	 ► Run a Head Cleaning and a Nozzle Check in succession. 
	 ► Use cleaning cartridges and run several Head 		
		  Cleaning Cycles consecutively to see improvement. DO NOT perform a Nozzle Check with 		
		  cleaning cartridges.

The image has an attached ICC Profile•	  
FastARTIST uses its own ICC Profile- make sure you do not apply one from your preferred 
graphics program. Refer to your graphics application’s User’s Manual on ICC profiles.

You have an ICC profile checked in CorelDRAW•	  
Go to File > Print and select the Misc. Tab. Deselect the Apply ICC Profile check box.

The Capping Station has build-up of ink•	  
Clean the Capping Station regularly.

Your imported image is not RGB or has multiple layers•	  
Convert the art to RGB and flatten the image.
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Preventions:
Usually when a color prints with an incorrect hue, it is because a Nozzle is clogged. If you are •	
trying to print an Orange image but it appears more Yellow, that means the Magenta is clogged 
and the pigments can’t mix to produce Orange.

One of the most important parts of your •	 Blazer Series Printer is the Capping Station. Make sure 
this ALWAYS stays clean. The Print Head “docks” here when not in use to ensure it does not dry 
out. The Capping Station is also used during Head Cleaning cycles. If the Capping Station is dirty, 
the printer cannot do a proper Head Cleaning and fix a clogged nozzle.

Note: When building any image inside any software program, make sure you always use RGB color 
mode because this is how your monitor displays colors. Never apply an ICC profile.

6. Print Has Large Gaps or Unaligned Areas 	
Prints are out of alignment or have large gaps.

 
Causes: 

Different Print Modes are being used•	  
Double-check your settings in the FastRIP Setup screen and 
make sure all Print Modes are of the same type. If using 
an HS Print Mode for the color then the same Mode must 
be used for the Underbase (i.e. CMYK Photo 720 HS Print 
Mode along with Underbase Photo 1440 HS).

The Encoder Strip is dirty•	  
Clean the Encoder Strip.

If using an Underbase and/or Underbase Wizard, the black and white versions of images may •	
be different sizes. 
Double check the images’ heights and widths to make sure they are identical. This process is 
outlined in the FastARTIST User’s Manual.

The Print Carriage is jumping around causing a misread of the Encoder Strip.•	  
Clean the Drive Belt Gear/Roller.

There is a communication error between your printer and your computer.•	   
	 ► Make sure you don’t have any jobs in the FastRIP Queue or Windows Print Manager. If you 		
		  do, delete them. Power down your printer, unplug the power cord and leave it unplugged for 		
		  about 30 seconds. Power back ON and try again. 
 
	 ►  Make sure you are using the correct port. Open FastRIP and select Printers/Manage Printers. 	
		  The Epson Stylus port Control Panel box has must be checked. 
 
	 ►  You may also be using insufficient or incorrect cables. We highly recommend using a USB 		
		  cable for the best connection such as the one included with your printer. DO NOT use a long 		
		  cable, switch boxes, hubs or even wireless USB connections.	
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Preventions:
Double check the settings in FastRIP prior to sending a •	 Print command.

Clean the Encoder Strip more often.•	

Always make sure images are the same size when using the Underbase Wizard in FastARTIST.•	

Test the communication between the computer and printer.•	

7. Fonts Are Not Printing Correctly 	
Fonts are not printing in the correct font, size or not printing at all.

 
Cause: 
Sometimes fonts, especially script fonts, may not print correctly or at all. 
This tends to happen when using Vector Programs. The printer driver may not download or recognize the 
font. To fix this, change the font to a graphic image. Depending on the graphics program, it may be called 
Convert to Curves, Create Outlines or Rasterize Type. You may also need to do this if you are printing 
vector fonts along with a bitmap image. 

Solution: Try importing or printing a different file to see if the problem continues.
 
 

8. The Printer Stops in the Middle of a Print Job 	
The printer stops in the middle of a print routine and stops communicating with the computer.

Causes:
Print drivers may need to be re-installed.•	  
Print drivers are prone to occasional communication problems with the Windows XP operating 
system. The only solution is to re-install the driver. 

Too many USB items may be connected to your computer.•	 	  
The USB bus on your computer has a limited amount of power and can be “overloaded”. If you 
have any additional items connected to your USB ports other than your FastARTIST/RIP dongle, 
mouse and printer, unplug them. 

The image file may be corrupt.•	  
The file being printed may be corrupt. Try another file.

The USB cable may be too long.•	  
Your USB cable should not be MORE than six feet in length. The longer the cable is, the harder it 
is for the computer to communicate with the printer.

The Kill Switch has been activated (PRO only).•	  
If the printer sits too far on either end of the bed rail, the kill switch is engaged. This could happen 
from a wrong page size or printer mode. Manually push the printer assembly towards the center of 
the span of the machine about 4 inches. Power back on.
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Preventions:
Keep it simple. Do not overload the printer port.•	

When in doubt first try turning everything off and unplugging things such as the USB cable from •	
the computer to the printer.

Pay close attention to page sizes and LCD display modes.•	

9. When Printing with White, No Ink Prints/No Underbase Settings Available	

Cause and Solution:
You do not have the correct printer selected in FastRIP.  
Open FastRIP and navigate to Printers/Manage Printers and make sure your printer is setup as the correct 
model printer. FastRIP needs to know that your are printing to a T-Jet and the corresponding model in 
order to print White ink.

10. After Sending a Print, Nothing Happens 
When you send a print job to the printer nothing happens.

Causes:
The computer is not communicating with the printer.•	  
Check the port settings in FastRIP. In the FastRIP window go to Printers>Manage Printers. The 
port should be set to Epson stylus pro 4800_usb00* or 488-_usb00*. Check the Control Panel box 
on the right. Make sure there are no other jobs already in the print queue.

The printer is not ready to print the job.•	

Solutions:
Check to see if any of the ink cartridges are showing empty.•	

The Waste Tank may be full. Check the LCD Display.•	

You many not be in •	 Print status. Refer to Chapter 8 - Initialization Utilities.

 

11. The Underbase White is Weak
The color of the shirt is showing through the Underbase or the 
underbase is weak.

 
Cause 1: 
There is not enough Pretreatment applied to the shirt. 

Solutions:
Use a good spray gun such as the Wagner Control 	Sprayer to lay down an even coat of 		   •	
Pretreatment or invest in an AutoTREAT Pretreatment Center.
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If the white ink is uneven, be sure to pretreat the entire printable area evenly.•	

Use 100% Pretreatment. Try not diluting it with water to see if prints improve.•	

Preventions:
Practice is the only way to master the art of pretreating a shirt. Eventually you will develop your •	
own style for applying Pretreatment. 
 

Cause 2:  
The Underbase settings in FastARTIST are not strong enough or not set up correctly. 

Solution: Check your Underbase settings and compare them to the default settings listed in Chapter 9 of 
the FastARTIST Manual. Keep in mind, every image will vary; we can only suggest a starting point. 
 

Cause 3: 
The White Nozzles are clogged. 

Solutions:
Perform Head Cleanings and Nozzle Checks until the problem is resolved.•	

Use a cleaning cartridge and run Head Cleaning Cycles until the problem is resolved.•	

If the two previous steps did not resolve the problem, Perform a Power Cleaning with the cleaning •	
cartridges still installed.

Prevention: Refer to Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a day, a week 
or a month. Use the Maintenance Tracking Schedule provided.  
 
If your printer will experience down time, refer to Chapter 15 - Tips and Utilities to Maximize Print 
Quality for instructions that will prevent ink clogs etc. 
 
 
Cause 4:
The Print Head may need special cleaning if not permanently clogged. 

Solution: The following may prevent you from replacing the clogged print head. Follow the instructions 
in Chapter 13 on releasing the print carriage. Check the print head for excess ink drops or lint. If the print 
head is visibly dirty, with an Isopropyl Alcohol wipe, carefully, in one direction, wipe the print head using 
little pressure. You can easily damage the nozzles by pressing too hard. Repeat once or twice if necessary 
by flipping or replacing the alcohol pad. 

Prevention: Refer to Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a section. 

Cause 5:
Your Print Head is Permanently Clogged or Damaged. 
The Print Head is a sensitive and expensive piece of equipment and requires regular maintenance and 
care.  
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Solution: Replace the Print Head. In the event that you find your Print Head permanently clogged or 
damaged, follow the instructions on replacing the print head included with a Print Head purchase. 

View the video online covering the steps in replacing a print head. Refer to 
Chapter 17 - Product Support for instructions on logging on to the support site 
and viewing videos and accessing technical documents. 
 

Preventions:
Refer to •	 Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a day, a week or a 
month. Use the Maintenance Tracking Schedule provided.

Always check the Platen to Print Head Clearance prior to printing.•	   

If your printer will experience down time, refer to •	 Chapter 15 - Tips and Utilities to Maximize 
Print Quality for instructions that will prevent ink clogs etc. 

12. The Print Has Horizontal Banding	
There is horizontal banding across the print (in one or all 
colors). 

Cause 1:
Ink in the Nozzle(s) has dried out. •	
There are a number of reasons why the ink nozzles can dry 
out from not performing the required maintenance, ignoring 
maintenance requirements for down time as well as ink drying out or bubbling in the lines from 
lack of ink. 

Solutions:
Perform Head Cleaning Cycles and Nozzle Checks until the problem is resolved.•	

Use a cleaning cartridge and run Head Cleaning Cycles until the problem is resolved.•	

If the two previous steps did not resolve the problem, Perform a Power Cleaning with the cleaning •	
cartridges still installed. 

Cause 2:
The Capping Station is not cleaning the Print Head. 
If the Capping Station is dirty, it will just add more debris to the Print Head, causing it to become clogged. 

Solution: Thoroughly clean the Capping Station. It can be cleaned with swabs included in the 
maintenance kit and a glass cleaner like Windex. Be sure to clean the rubber seal around the Capping 
Station as well as the rubber wiper blade. 
 

Cause 4:
The Print Head may need special cleaning if not permanently clogged. 
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Solution: The following may prevent you from replacing the clogged print head. Follow the instructions 
in Chapter 13 on releasing the print carriage. Check the print head for excess ink drops or lint. If the print 
head is visibly dirty, with an Isopropyl Alcohol wipe, carefully, in one direction, wipe the print head using 
little pressure. You can easily damage the nozzles by pressing too hard. Repeat once or twice if necessary 
by flipping or replacing the alcohol pad. 

Prevention:
Refer to Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a section.
 

Cause 5:
Your Print Head is Permanently Clogged or Damaged. 
The Print Head is a sensitive and expensive piece of equipment and requires regular maintenance and 
care.  

Solution: Replace the Print Head. In the event that you find your Print Head permanently clogged or 
damaged, follow the instructions on replacing the print head included with a Print Head purchase. 

View the video online covering the steps in replacing a print head. Refer to 
Chapter 17 - Product Support for instructions on logging on to the support site 
and viewing videos and accessing technical documents. 
 

Preventions:
Refer to •	 Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a day, a week or a 
month. Use the Maintenance Tracking Schedule provided.

Always check the Platen to Print Head Clearance prior to printing.•	   

If your printer will experience down time, refer to •	 Chapter 15 - Tips and Utilities to Maximize 
Print Quality for instructions that will prevent ink clogs etc. 

13. Files Take a Long Time to Print in Corel Draw

Causes/Solutions 1:
Printing from CorelDRAW is causing large spool files.•	   
Printing from any version of CorelDRAW can create extremely large spool files. This happens 
when one or more copies of a file are sent to the printer while you are trying to print a number of 
images that require a second pass. It can also happen if bitmap images are placed in the document. 
If the spool files are larger than your physical memory, the file may not print or may take a long 
time processing. Ways to reduce this include exporting the file in a JPEG format, then bringing 
the file back into CorelDRAW using the Import function. If the bitmap was created with a high 
resolution, try lowering the resolution to around 200 DPI. Save this file and Import it back into 
CorelDRAW. Try to print from a different program like Adobe Photoshop or Adobe Illustrator. 
These graphic programs do not create as large spool files as Corel Draw.
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File resolution is too high.	•	  
A resolution of 150 to 300 DPI (at the final print size) is all that is necessary for inkjet-to-garment 
printing. If you receive a larger file resolution, resample the file to a lower resolution. Doing this 
will speed up ripping and printing times.

Prevention 1: 
Keep file sizes small, if possible, and don’t send too many print commands at once. 
 

Cause/Solution 2: 
Respooling files over and over wastes time 
Use the “archive job file” feature in FastRIP. This will allow you to save spooled files for later printing 
and prevent wasted time re-spooling. This feature is also perfect for repeat orders. Refer to Chapter 11 - 
Printing Basics - Saving a Spooled Print File for procedures. 

14. Printing Large Bands of Color/Vertical Lines/Partial Images 	
The printer is printing large bands of color, vertical colored 
lines or printing partial images.

Cause 1:
You have a dirty Encoder Strip or Encoder Sensor 
The Encoder Strip is the heart of the machine and behind the 
Print Head lies an Encoder Strip Sensor. The Encoder Strip has 
information on it that the Encoder Strip Sensor reads as the Print 
Head moves back and forth. If there is ANY contamination, 
Pretreatment, dirt, ink or debris on the Encoder Strip or on the 
Encoder Strip Sensor, the printer will be VERY CONFUSED. This is the #1 cause of abnormal printing 
problems. Clean the Encoder Strip with Glass Cleaner. 

Solution 1:
Clean the Encoder Strip 
 

Cause 2:
The Gear for the Print Carriage Drive Belt may be filled with lint and slipping. 

Solution 2: Clean the Drive Belt Gear and Roller	  

Preventions:
Refer to •	 Chapter 14 - Daily, Weekly and Monthly Maintenance. Do not skip a day, a week or a 
month. Use the Maintenance Tracking Schedule provided. 

Keep the printing area clean, the machine lid closed and pretreat shirts away from the printer.•	

Shake shirts before you print onto them to remove excess lint that may get on the Encoder Strip.•	
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When printing a large volume run, clean the Encoder Strip often to prevent communication errors •	
from ruining shirts during a printing cycle. 

 
 

15. White Underbase Box Over Entire Image
When you print a White Underbase you get a White box over the entire image.

 
Cause: 
Check your Underbase setup within FastARTIST. 
Within FastARTIST go to File > FastRIP Setup > 
Underbase Setup tab.  
 
Solution 1: Make sure the top checkbox that says 
Underbase All Items with this Underbase Color is checked. 
Make sure the bottom check box that says Highlight All 
Objects with This Color is NOT checked. 
 
Solution 2: Make sure to view the image in FastRIP’s View 
Raw Data window to see if it looks correct BEFORE 
printing.

Please note: If you choose a 1440 DPI White Print Mode 
you will not have the View Raw Data option.

16. Poor Print Quality When Printing Bitmaps 	
The quality of the printed output is unacceptable when printing bitmap images. The images seem 
soft and are not clean and sharp. 

 
Cause:
The resolution of the image is too low. 
Resolution at 72 DPI is for viewing the image on a computer monitor only. Images intended for printing 
need to be between 150 and 300 DPI to maintain a clean and sharp image. You can try upsampling the 
image to a larger resolution, but the image will still be “soft” when printed.
17. Print Head Moves, But Doesn’t Print 	

When sending a print command, the Print Head moves like it is printing but no ink is dispensed

Causes:
Ink is not flowing from the Bulk System.•	  
Make sure that the breather hole in the cap of each ink cartridge has not become clogged or closed. 
The cartridges need to breathe as ink flows through the lines. Refer to Chapter 12- Advanced 
Printing With White for proper steps.

The Capping Station is Clogged.•	  
The Capping Station may need cleaning. If the Print Head did not seat properly, ALL of the nozzles 
could be clogged. 
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The Ribbon Cable to the Print Head is damaged.•	  
If you accidentally splash/drip ink or cleaning fluid on the gray ribbon cable that connects to the 
Print Head, it can short out. Check for burn marks on the ribbon cable connectors. Check to make 
sure it hasn’t been crimped or pinched.

The Motherboard is bad.•	  
There is a chance the motherboard is bad. Under serious conditions the ink or cleaning fluid 
may have run down the ribbon cable, dripping into the print bed, coming in contact with the 
motherboard. This can short out the motherboard. Call Tech Support.

18. Wrong Print Location 	
The image is printing outside of the Shirt Board or in the wrong location. 

Cause:
You have a mismatch in the software settings.•	  
Make sure your working Page Size matches the final print page size. A common error is working 
on one Page Size in a graphics program but printing to a different Page Size in FastRIP.

 

19. Problems Modifying The Factory Default Printer Settings: 	
Modifying Factory Default printer settings.

 
Causes:

The printer’s default settings have been configured by U.S. Screen prior to shipping, however, here •	
is a list of the Printer Setup Menu Modes. DO NOT deviate from these settings. 

If you find an incorrect setting, you MUST contact Customer Support BEFORE making any 
changes. 

20. I Only Print on Weekends and the Nozzles are Always Clogged: 	
I only use my printer on weekends and many times when I go to use it, the nozzles are clogged. 

Cause:
Ink is drying within the Print Head due to lack of use. 

Platen Gap- STD

INIT Settings- EXEC

Auto Cleaning-  OFF

Auto NZL CK- OFF

Sheet Size CK- OFF

Cut Adj- EXEC

Time Out- OFF

PAPER ALGN- OFF

PPR Margin- Default

Code Page- PC437

INTERFACE- Auto

Page Line- OFF

Refresh MRGN- OFF
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If you are NOT using your printer on a regular basis, the ink may partially dry within the Print Head, 
causing a clog.

Solution 1: We have found the best solution to this issue is to turn your printer ON everyday, even 
if you don’t intend to print anything. When the printer is turned ON, it primes the Print Head during 
startup. This process is sufficient to prevent head clogs if done regularly. You DO NOT have to do a 
Head Cleaning unless you want to. After your printer has gone through its startup procedures, turn it 
OFF to ensure the Print Head seats within the Capping Station. 

Solution 2: Use the Auto Head Clean Function. This function allows the printer to perform a Head 
Cleaning Cycle automatically. Refer to Chapter 15 - Tips and Utilities to Maximize Print Quality for 
directions 

Solution 3: Purchase a second Bulk Ink System and reserve it for HD Cleaning fluid. Switch the Ink 
System out at the end of the shift (week) and run 2-3 Power Cleaning Cycles to clear the ink out of the 
lines and Print Head. At the beginning of the next shift, swap the ink system back and run 1 - 2 Power 
Cleaning Cycles to get the ink flowing again for production.

Solution 4: Refer to Chapter 15 - Tips and Utilities to Maximize Print Quality for instructions on 
preparing your T-Jet for Downtime.

21. Vector Images Print Wrong Colors 	
When printing vector graphics, the printed colors do not match the previews in my graphics application. 
 
Cause:

FastRIP•	  is a bitmap based image processor. 
When rasterizing a vector image, FastRIPTM must convert vector graphics into bitmapped graphics. 
The translation of color profiles are not always exact, resulting in a difference in output.

Prevention: For consistent color reproduction, save your image as a high quality JPEG and send this 
image to the RIP for printing. 
 

22. The Shirt Board is Far from Being Level 	
If a Shirt Board is too far from being level and the screws at the bottom of the Shirt Board cannot be 
adjusted to make up the difference try using a shim underneath the X part of the Shirt Board. This can 
correct any problems in the leveling procedure. NOTE: If you use shims on a particular corner and need 
to switch to another Shirt Board, mark down where you put the shims so that when the next time you need 
to use that particular Shirt Board, you may not have to re-measure. 



Chapter 16 - Troubleshooting 

163
Version 5.5  Revised January, 2009

LCD Error Warnings and Codes
The following section of this Troubleshooting chapter will cover popular Error Messages and codes that 
may appear in the LCD Display and ways to correct them. For a complete list of Error Codes, visit our 
support site. Refer to Chapter 17 -Product Support for information on accessing these files. The topics 
listed are in random order. 
 
NOTE: Each Error Code will be displayed  as  “SRVC REQD 000    - error code name -      In most 
cases, after completing the correction, you must perform a complete shutdown of the T-Jet in order to 
resume printing.  
 

Error: NON-GENUINE EPSON CARTRIDGE	
The LCD display screen reads “Non Genuine Epson Cartridge” and will not let me print after installing 
ink cartridge. 
 
Cause:
The printer does not recognize the ink cartridges.  
The ink system installed is a continuous flow system and each cartridge has been equipped with a new 
smart chip. After installing the cartridge, you may get this message.

Solution: Follow these steps.

After accepting the Epson LCD screen will go back 
to the ink levels� menu.  The ink cartridge that was 
reset with the non-genuine �instructions will have a 
different icon then the other ink cartridges. �The 
non-genuine ink cartridge will have an icon of an 
empty box. 

1.  Press down arrow button

2.  Press down arrow button

3.  Press down arrow button

4.  Press down arrow button

5.  Press down arrow button

6.  Press left arrow button for Yes

7.  Press down arrow button

8.  Press down arrow button

9.  Press down arrow button

10.  Press down arrow button

11.  Press left arrow button to Accept
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Error Code: 10000
The fuse is blown (Express model) causing the print bed to sit on the index sensor. 

Solution: You will need to replace the 5 amp fuse on the DC Motor Control Board. Follow the 
instructions below.
 
Error Code 10000 Solution for the Blazer Express:
Replacing the DC Motor Control Board Fuse

What you will need
4 mm Allen Wrench•	

Phillips Screwdriver•	

5 amp fuse (supplied with printer)•	

1.	 Remove the 6 screws on the left side access panel. 

Caution: The side panel is not secured without the screws in place. The panel will fall if not 
supported.

2.	 Locate the 5 amp fuse on the DC Motor Control Board. 
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In most cases, you can visibly determine if the fuse is bad. This may require removing it first.

Replace the fuse. Be sure the clips are pressed securely around the fuse after replacement. 3.	

Put the side panel back on. 4.	
Note: It is a good idea to put all the screws in place before tightening. 

If you have questions, or your problem persists after completing these instructions, please call 
Technical Support at 888-698-5387 or send an e-mail to support@usscreen.com. Remember to 
include your serial number and repair record(s) when emailing or have them ready when calling. 
 

Error Code: 10001
Cause 1: The printer has been shutdown improperly.  

Solution:
Perform a “correct” and complete shutdown and startup cycle. Refer to Chapters 4 and 5 for proper •	
startup and shutdown steps.

During start-up, watch the Epson Panel - in the start-up procedure, the panel will read “PLEASE •	
WAIT” and should have the ROLL and SCISSORS icons present. If not present, when the Display 
reads “PRESS PAUSE BUTTON”, press the left arrow button until the display has the ROLL and 
SCISSORS icons present. This will clear the Error.

Cause 2: The Print Bed is binding. 
 
You can check both the Blazer EXPRESS and PRO for binding issues. A binding issue will interrupt the 
printers communication with it’s sensor resulting in this error. 
 
To check for a binding issue, while still in the error mode, gently press the printer unit approximately 
¼ inch towards it’s index position (to the front for the PRO and to the back for the Express). This will 
manually force the printer to communicate with the sensor. If the printer resumes normal printing 
functions there is a binding issue. Follow the steps below. If no binding issue is detected, call our support 
department. 

Solutions:
EXPRESS: Adjust the Main Belt tension. Follow the instructions beginning on the following page. 
PRO: Adjust the Lead Screw Bracket. Follow the instructions in the next section following the Blazer 
Express instructions. 

Binding Solution for the Express:
Adjusting the Main Belt Tension
The following describes the procedure for adjusting the main belt tension of the Blazer Express drive 
assembly. Binding can result if the belt is too tight. The red circles in the photos indicate screw locations.

Tools needed:
4 mm Allen Wrench 
5 mm Allen Wrench 
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1.	 Using the 4 mm Allen Wrench, unscrew the two 

screws holding the front plate to the upper back 
plate. 
 
 
 
 
 
 
 
 
 

2.	 Next remove the four screws holding in the upper 
back plate.

	  
 
 

3.	 Pull out the upper back plate.  
 
 
 
 
 
 
 
 

4.	 Remove the four screws on the back plate. 
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5.	 Lean the back plate back. Be careful not to unplug 
or damage any of the wiring to the breaker switch. 
 
 
 
 
 
 
 

6.	 The Belt Tension Roller is mounted on a shaft 
with two screws on either end. Using the 5 mm 
Allen Wrench, loosen the screws slightly. 
 
 
 
 

7.	 Push down on the belt going to the large gear to test the 
tension. Raise the roller 1/16” and test the tension again. If 
the tension has loosened perceptibly, tighten the roller 
shaft screws.  
 
Pull up on the belt to make sure it does not pull away from 
the gear. If it does, you will need to tighten the roller down 
again.  
 
(Note: Be sure that the roller shaft is as evenly horizontal 
as possible. If it is skewed, it can cause uneven wearing 
and drive noise.)

Follow Steps 1-4 in reverse order to reinstall the panels. Note that there is a lip where the upper back 8.	
plate connects to the front plate. You will need to angle the front plate and slide the upper back plate 
underneath. 
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Binding Solution for the PRO:
Adjusting the Lead Screw Bracket
The Lead Screw Bracket (or front Drive Screw Mount) should be 
vertical, not at an angle.

If the Lead Screw Bracket is only slightly angled, gently tap it to 1.	
straighten. Doing this can eliminate binding issues. If this did not 
help the level of the Lead Screw Bracket, continue on with step 2. 

In the event that the block is severely angled, remove the 3 hex 2.	
screws that secure it in place.

Pull the Drive Screw downward to facilitate removing the block.  Put 3.	
the block back on the drive, checking for true verticality.

Reattach the block using the 3 hex screws, but only tighten to “finger 4.	
tight.”

Move the Print Assembly forward until it sits about 5” from the Limit Switch.  This will ensure the 5.	
Drive Screw is level and in the correct position.

Tighten the 3 screws and send the printer back to 6.	 Home position.  Set the passes to 2 or more and 
press the 2 Green buttons on the User Interface.

Make sure the printer goes forward and back without binding. 7.	

If you have questions, or your problem persists after completing these instructions, please call 
Technical Support at 888-698-5387 or send an e-mail to support@usscreen.com. Remember to 
include your serial number and repair record(s) when emailing or have them ready when calling. 
 
 

Error Code: 10004
The Encoder Strip is not being read properly. 

Solution 1: Clean the Encoder Strip. Refer to Chapter 15 - Daily, Weekly and Montly Maintenance.
Prevention 1: Follow Daily Maintenance Routines 
 

Solution 2: Make sure the Encoder Strip is seated properly in the sensor. The sensor is located in the 
center of the Encoder Strip. If it’s crooked or is not securely in place, GENTLY position it back into place. 
Prevention 2: Be extra careful of the Encoder Strip when performing any maintenance routines.

Lead Screw 
Bracket

Drive 
Screw
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Error Code: 1001D
Print Carriage Obstruction. Something is preventing the Print Carriage from moving correctly. 

Solution:
A 1001D error code typically denotes an obstruction of carriage movement. The two most common 
causes are the capping pad and the carriage home sensor.

Capping Pad
The capping pad should freely move to the right, however, dried ink can build up in the rails that guide 
the pad. If the pad is having difficulty moving, it will obstruct the carriage movement.  Use WD40 or a 
cleaner to clean the rails that the pad slides on.  

 

Carriage Home Sensor
There is a sensor on the frame of the printer that tells the carriage when it has arrived at the home 
position.  

If the sensor, or the sensor tab are dirty, this can cause the sensor to misread. Clean the sensor tab and the 
sensor with an alcohol pad.



Chapter 16 - Troubleshooting 

170
T-Jet Blazer Series User’s Manual

If you have questions, or your problem persists after completing these instructions, please call 
Technical Support at 888-698-5387 or send an e-mail to support@usscreen.com. Remember to 
include your serial number and repair record(s) when emailing or have them ready when calling. 
 

Error Code: 1001E  Blazer Express 

Cause 1:
The Height Sensor has been tripped too many times.

Solution: Lower the Shirt Board (Increase the Platen to Head Clearance).
Prevention: Pay attention to the MINIMUM clearance of 3mm between the Print Head and Shirt Board 
(Platen).  
 
 

Cause 2:
The Page Size is too big.

Solution: Decrease the Page Size to a maximum of 17” x 30”
Prevention: Practice working in FastARTIST using the supplied Art Layout Templates. See Chapter 
11 - Printing Basics as well as the Art Layout Chapter in your FastARTIST User’s Manual. 
 

Error Code: 1001E  Blazer PRO
The Page Size is too big. 

Solution: Decrease the Page Size to a maximum of 17” x 45”
Prevention: Practice working in FastARTIST using the supplied Art Layout Templates. See Chapter 
10 - Printing Basics as well as the Art Layout Chapter in your FastARTIST User’s Manual.
 
 
 

Error Code: 10031
The printer is not in the correct print mode 

Solution: If performing maintenance such as a Nozzle Check, make sure you follow the directions in this 
manual when changing and switching print modes. Refer to Chapter 8 - SETUP PART 6: Initialization 
Utilities.
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Error: TOP COVER OPEN
The Height Sensor has been tripped too many times. 
 

Solutions:
Lower the Shirt Board (Increase the Platen to Head Clearance) •	
 

 

Error: RELOAD PAPER
The Epson settings on the main circuit board have been changed or reset. 

The point in which you get the SERVICE ERROR should be right after the machine has finished the start 
up process and returned to Home Position. At this point the LCD screen will read SERVICE ERROR 
“RELOAD PAPER”.

The following steps cover how to clear the error and correct it so that it does not happen again. 
 

First, power down the Blazer unit and make sure the power switch located at the back of the machine 1.	
is turned off.

Next, make sure you have a shirt board loaded on the Blazer and it meets the standard of being about 2.	
3mm-5mm away from the print head.

Prepare a sheet of normal, white paper and place it at the upper left side of the shirt board next to the 3.	
capping station. Let the sheet of paper hang over the edge toward the capping station. Leave about a 
quarter inch of room between the paper and the edge of the inside of the Blazer. 
 
The top edge of the paper must be aligned to the Scissor and Arrow on the side of the capping station 
when bed is at index position (viewable by looking through the top window). 

Next, perform a complete startup cycle. Refer to 4.	 Chapter 4 or 5 (depending on your model). After 
the startup process has completed, the unit will move the carriage out and will check for the paper. 
A white light will turn on and off. If you have the paper setup right it will read the paper and finish 
registering. 
 
The “RELOAD PAPER” error should now be gone and the printer should be ready to print.

Next, change the settings back to the default so that the printer won’t look for the paper during 5.	
startup.

Left arrow on the LCD screen until you get to READY status.•	
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Press the far right button or MENU button to get into the menu.•	

The very first option on the screen should be PRINTER SETUP. Press MENU again to enter into •	
the PRINTER SETUP configuration.

The screen will read PLATEN GAP. Use the up and down arrows to browse all of the settings that •	
can be changed. Press MENU to enter a topic and use the up and down arrows to find the setting 
you want. Once you have selected a setting, press MENU again to select that option. Browse 
through the entire list and verify that all of the settings are set to the list below. 
 
PLATEN GAP -- *STD 
PAGE LINE -- *OFF 
INTERFACE -- *AUTO 
CODE PAGE -- *PC437 
PPR MARGIN -- *DEFAULT 
PPR SIZE CHK -- *OFF 
CUTTER ADJ -- DO NOT USE OR CHANGE 
REFRESH MRGN -- *OFF 
AUTO NZL CHECK -- *OFF 
AUTO CLEANING -- *OFF 
QUIET CUT -- *OFF 
INIT SETTING – DO NOT USE – WILL RESET EVERYTHING 
 
 

After completing the settings routine in the previous step, turn off the printer and remove the paper 6.	
from the shirt board. 

The last step in the process is to turn the printer back on, allow it to complete the startup cycle and 7.	
continue printing shirts.

If you have questions, or your problem persists after completing these instructions, please call 
Technical Support at 888-698-5387 or send an e-mail to support@usscreen.com. Remember to 
include your serial number and repair records when emailing or have them ready when calling.
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Product Support

Support Policy
T-Jet Blazer Series Printer support is free. Since the machines are designed to be intuitive and very 
easy to use, most support questions have to do with using FastARTIST, FastRIP or printing from specific 
graphics applications. 

For the quickest support, Email your question to support@usscreen.com. Be very specific and include 
your serial number and any repair/problem history.

IMPORTANT POINT:
If you purchased the printer from a dealer in the USA, you DO NOT have to go 
back to the dealer for support. Simply call or E-mail our support center. If you 
purchased the printer from a dealer outside the USA, you will need to contact your 
dealer for support.

Support Information and Hours

Toll Free 			   +1 888-MYTJETS (698-5387)
Technical Support 		  +1 480-929-2937 
Corporate Office	     	 +1 480-929-0640 
Fax	 	     		  +1 480-929-0766 
E-mail: 			   support@usscreen.com
Internet: 			   www.screenprinters.net. Click on the Support tab. 

Support hours: 		  7:00am to 6:00pm Monday through Friday  
                			    
               			   (Mountain Standard Time) USA
 
Emergency Support is available

Note: Arizona does not observe “Daylight Savings Time.”  
In the summer months, Arizona is on the same time as California.
 
 
Phone Support
We have an excellent staff of Support Specialists who will gladly walk you through many of the 
procedures. When calling for support, please have your serial number handy and be prepared to give 
a detailed explanation of the problem. If you have received an error message, please include the error 
number. It is often easier if you fax or E-mail a support question before calling for help. Calls to our 
Support Center are toll free from within the US. Calls from outside the US are NOT toll free.
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Emergency Support
In the event that you must have support and cannot wait until our normal support schedule, an Emergency 
24-Hour Support Technician can be reached. Call our toll free 1-888-MYTJETS support line and follow 
the prompts. A technician will be paged and he will return your call as soon as possible.

Please include your full company name, contact name, phone number, address, serial number and a 
detailed description of the problem. 
 
 

Support on the Web 
U.S. Screen Print & Inkjet Technology maintains a comprehensive support site for owners of our 
products. The site includes videos, tutorials, helpful hints, manual updates and more. This site is restricted 
to product owners and requires creation of an account. To create your account, 

Open an internet browser.1.	

Navigate to 2.	 http://www.myt-jet.com  or  www.screenprinters.net.

3.	 Click on the ‘Sign In’ link in the 
top right-hand corner of the 
webpage. 
 
 
 

4.	 Click on ‘Create New Acount.’
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5.	 On this page, enter your information in the spaces provided, then click “Sign Up”. 

6.	 On the next page, enter your product information, then click ‘Add Products.’ 
 
Note: All printer serial 
numbers can be found on a 
sticker on the back of the 
printer near the power cord. 
FastRIP and FastARTIST 
information is found on the 
purple USB dongle. 
FastFILMS information can be 
found on the box, on the CD, 
and in the manual. 
 
If there are any issues entering 
your product information, 
please call Technical Support 
at 888-698-5387, or send an 
e-mail to support@usscreen.
com.
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7.	 On the left-hand navigation bar, click ‘My Support Home.’ 
 
You will now see several gray 
boxes, each of which pertains to a 
product that you own. Note: this 
photo shows all of the products US 
Screen supports. You will not see 
all these products in your account. 
 
In this space, you will be able to 
access Support Videos, updated 
Manuals, Support Applications, 
and other product information and 
upgrades.  

 
 
 
 
 
 

Webcam Video Support 
You can purchase an inexpensive web cam for your computer and talk LIVE to one 
of our support technicians. More information about how to use this amazing support 
technology is on the T-Jet Blazer PRO and Express Support page at 
www.myt-jet.com.

 
 

EPSON® Support
The T-Jet Blazer Express and PRO are highly modified versions the Epson 4880 with hundreds of 
additional parts not provided by Epson. As a result, your printer is NOT supported by Epson. Additionally, 
we provide the Epson 4880 Printer Driver and LFP Remote Panel (for Utilities) as a convenience, 
however Epson will not support these applications. All support for Epson drivers, applications and 
internal Epson components will come from U.S. Screen. 
 
 
 

Third Party Software Support
We will make every attempt to help with printing from programs like 
CorelDRAW, Photoshop, Illustrator, etc., but we do not offer free support or 
training on these programs.
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Show off Your Work  
 
If you want to brag about the things you’ve 
printed on your T-Jet Blazer Series Printer, or are 
looking for some inspiration, we have a Gallery 
where you can view or upload pictures of jobs 
completed with these remarkable printers. Check 
it out at www.myt-jet.com or 
www.screenprinters.net.

 
 
 
 
 

 
 
 
 

Transporting Your Printer
You MUST be very careful moving and transporting your T-Jet printer. It is a very heavy and delicate 
piece of equipment. If you move it to a different location in your shop, keep in mind the dimensions of the 
printer. The T-Jet will not easily fit through a standard doorway. Follow the instructions in the next section 
of this chapter covering how to re-crate your particular model T-Jet Blazer. Series printer.

WARNING:
Remove the Bulk Ink Cartridges, the Shirt Board and the Waste Tank BEFORE 
moving your machine. Ink from the cartridges and Waste tank can easily spill and 
damage internal components. A Shirt Board is heavy and only held in place by its 
weight. Should it fall from the Print Bed, seriously bodily injury could result. 

If shipping for repair, you MUST call Technical Support for specific instructions.
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Re-crating the Blazer EXPRESS
Follow these instructions to re-crate your Blazer EXPRESS for any time the machine will need to travel 
or be shipped. If you have any questions or problems, call our support department for assistance.

Preparations:
For this procedure you will need all of the original crate supplies, a power drill equipped with a phillips-
head drill bit, 2 1/2” wood screws and an assistants to help lift from crate. Make sure that you follow all 
instructions on transporting your printer including installing cleaning cartridges and locking the Print 
Head in place. NOTE: The red indications on the illustrations symbolize where a screw is needed.

Step 1:  Place the Blazer EXPRESS on the Crate Bottom 

The Blazer Express needs to sit on the crate 
bottom as shown. 
 
Make sure it sits correctly or the printer may 
move around while shipping or transporting.

Also, make sure that you follow all 
instructions on transporting your printer 
including installing cleaning cartridges and 
locking the Print Head in place. 

 
 

Step 2:  Lower the walls of the crate.
If removed properly, you should be able to 
drop the walls with the braces in tact as 
shown.  

NOTE: The braces only fit one way.
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Step 3:  Fasten the walls of the crate.
You should have 6 long wood 
screws that hold the walls to 
the crate.  
 
There will be 3 screws for each 
of the longer sides of the crate. 
 
Do not over tighten or you may 
strip the wood out. 

Step 4:  Lower the crate lid and fasten.
You will need 8 wood screws to 
secure the lid to the crate.  
 
 
Do not over tighten or you may 
strip the wood out. 

 
 

IF YOU HAVE ANY PROBLEMS IN CRATING YOUR BLAZER PRO, CALL OUR SUPPORT LINE 
AT 1-888-MYT-JETS AND WE WILL GLADLY WALK YOU THROUGH ANDY TROUBLES OR 
CONCERNS. HAVE YOUR SERIAL # AND HISTORY READY.
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Re-crating the Blazer PRO
Follow these instructions to re-crate your Blazer PRO for any time the machine will need to travel or be 
shipped. If you have any questions or problems re-crating, call our support department for assistance. 

Preparations:
For this procedure you will need all of the original crate supplies and bracers, 3 assistants to help lift, 
long 2 1/2” wood screws and a power drill equipped with a phillips-head drill bit. This procedure may 
take up to 1 hour to complete correctly. Make sure that you follow all instructions on transporting your 
printer including installing cleaning cartridges and locking the Print Head in place. The Printer Assembly 
needs to be positioned directly in the middle of the unit. NOTE: The red indications on the illustrations 
symbolize where a screw is needed. 

Step 1: Place the Blazer PRO on the 
Crate Bottom 
The printer needs to sit on the crate bottom in between the supports. The 
crate bottom has blue foam material on it to protect the frame 

of the Blazer PRO. 
 
Make sure the printer 
sits correctly or the 
printer may move 
around while 
shipping or 
transporting. 
 
 
 

Step 2:  Attach Bottom Bracers.
There are 2 sets of bracers that attach to the crate bottom 
and hold the Blazer PRO down to prevent movement.

The first set (56” in length) will lay down length-wise 
along each side of the machine and will need to be 
fastened using wood screws into the crate frame guides.
 

NOTE: Try to use 
the original screw 
holes if possible. 
Too many holes 
in the wood will 
weaken or even 
break the wood.
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After the first set of bracers are fastened, a 
second set of bracers (30” in length) will go right over 
the top of them. These will hold the printer from moving 
front to back. 

 
 
 
NOTE: If you have 
the protective plastic 
cover, place it over the Blazer PRO.  
 
 

Step 3: Attach Vertical Bracers.
Next, fasten the vertical bracers (4 total) to the crate 
frame guides, towards the middle of each side of the 

crate as shown. 
 
Each vertical 
bracer is 46 1/2” 
in height and 
requires 2 wood 
screws each. 

 
 

Step 4: Attach Upper Bracers.
The upper bracers (42 1/2” in length) will hold the 
vertical bracers together and will help make them 
sturdy. They will also be fastened to the wall plates in 
a later step.

Attach the 2 bracers with to outside edge of the the 
vertical bracers.

 
 
One screw 
should be 
enough per 
side, per 
bracer. 
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Step 5: Attach the first side plate wall.
Attach the first wall using 4 screws that will fasten 
into the bottom of the crate and 2 screws that will 
fasten to each vertical bracer.

NOTE: It 
will help 
to have an 
assistant 
hold the 
side plate 
wall in 
place while 
fastening.

 
 
 

 
 

Step 6: Attach the front/ back plate wall.
Attach the front/back plate to the side plate using 3 screws. 

 

Next, fasten the bottom left side of the front/back 
wall with a screw going directly into the crate 
bottom. 
 
NOTE: Keep this screw at least 3 - 4 inches from the edge so that the screws will not hit the other in later steps.
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Step 7: Attach the remaining front/ back plate. 

Use the same steps and methods used for the first 
front/back plate wall.

 
 
 
 
 

Step 8: Attach the remaining side plate wall.
Attach the last wall. 4 screws will fasten to the bottom plate, 3 screws on each vertical end plus the 2 to 
hold the vertical bracers (shown below).
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Step 9: Attach the padded bracers to the top of the PRO.
Attach the 2 padded bracers to the top of the PRO. 
 
A padded bracer will sit on the front and back side 
of the printer assembly and will fasten from the 
outside of each side plate wall. 
One screw on each side for each bracer will hold 
them in place.

 

Step 10: Fasten the crate lid.
Fasten the crate lid to the top of the nearly 
completed crate. 

 

Use a total of 10 screws as shown, and fasten to 
the top of each crate wall plate. 
 
 
IF YOU HAVE ANY PROBLEMS IN CRATING YOUR BLAZER PRO, CALL OUR SUPPORT LINE 
AT 1-888-MYT-JETS AND WE WILL GLADLY WALK YOU THROUGH ANDY TROUBLES OR 
CONCERNS. HAVE YOUR SERIAL # AND HISTORY READY.
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Appendix A

Operational Guide

Notice
The material in this Manual is believed to be accurate and complete with respect to the normal and 
intended operation of the Fast T-Jet Blazer Express Inkjet-to-Garment printer. U.S. Screen makes no 
warranties or other representations, express or implied, with respect to the material in this Manual. 
Neither U.S. Screen nor any other party involved in the design, manufacture or distribution of the T-Jet 
Blazer Express and the T-Jet Blazer PRO Inkjet-to-Garment printer, or any portion thereof, shall be liable 
for any loss relating to errors or omissions in this Manual or the accuracy of the information contained 
therein.
 
U.S. Screen has attempted to ensure, so far as is reasonably practical, that the company’s products are 
designed and constructed to be safe when properly used and when the safety precautions contained in this 
document and the other documents supplied with the T-Jet Blazer Series printers are fully observed.

U.S. Screen reserves the right to make changes to the information contained in this Manual without prior 
notice. The User of this Manual should consult with a U.S. Screen representative to determine if any such 
changes have been made. 
 

Standards Compliance
The T-Jet Blazer Express and PRO printers have been tested and verified to conform to the appropriate 
European Directives and, as such, bears the CE marking. 

 
 

Radio Frequency Emissions Compliance
The Fast T-Jet Blazer Express and Pro printers have both been tested and found to comply with the 
limits for a Class A digital device pursuant to Part 15 of FCC rules. These limits are designed to provide 
reasonable protection against harmful interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which case the 
User will be required to correct the interference at their expense. 

 

Federal, State and Local Laws- Regulations and Standards
It is the User’s responsibility to research and ensure they are in compliance with Federal, State and local 
laws, regulations and standards regarding the setup and operation of the T-Jet Blazer Express and PRO 
Inkjet-to-Garment printer. U.S. Screen makes no representation to have researched, or to have knowledge 
of, individual Federal, State or local regulations or standards and, as such, cannot accept any liability for 



Appendix A - Operational Guide 

186
T-Jet Blazer Series User’s Manual

lack of compliance with such Federal, State and local laws, regulations and standards on the part of a 
Customer.

It is the Customer’s responsibility to ensure that the room and equipment 
exhaust, makeup air supply, flooring, air, water, waste and electrical services meet all applicable codes 
and ordinances. The User should not assume that all necessary procedures, warnings and precautionary 
measures are discussed or that additional measures may not be required or desirable because of the 
particular or exceptional conditions or circumstances present in the User’s work area or because of the 
requirements of applicable Federal, State and local laws, regulations and standards.
 
Any questions regarding these instructions should be brought to the attention of a U.S. Screen 
Representative.
 
 

Summary of Customer Responsibilities
The Customer must: 

1. Provide an area that meets the requirements described in this Manual. 
 
The Blazer Express model requires a minimum area of 3.5 ft x 5.25 ft (1 m x 1.6 m) for the printer and 
surrounding work space.

The Blazer PRO model requires a minimum area of 12 ft x 10 ft (3.65 m x 3 m) for the printer and 
surrounding work space. 
 
Additional areas/rooms are required for drying, pretreating garments, garment staging and garment 
storage.
 

2. Employ qualified, skilled trades persons (i.e., electricians, carpenters, riggers) for any site modifications 
or new construction and installation of all utilities.

 
3. Provide any additional equipment that may not be supplied by U.S. Screen, but will be essential to the 
use of the Fast T-Jet Blazer Express and the printing process. 
Examples of this equipment are:

A Windows compatible PC computer with at least 1MB of RAM, a •	
Pentium 4- 1.8 GHz processor and USB2 connectivity

A Pretreatment application area that is not near the printer•	

A Heat Press or conveyor dryer for shirt Pretreatment and curing. A Heat Press is preferable for •	
Pretreatment application and drying when printing on Dark shirts with White ink.
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4. Receive the equipment properly. Use appropriate personnel and equipment to off-load and move the 
shipping containers to a storage area or directly to a staging area. The printer ships in a single crate that 
is large and must be handled with the use of a forklift, lift gate or pallet jack. The crated printer and 
components weigh over 300 pounds (227 kg).

Before moving shipping containers from the receiving area, check corridors and doorways for clearance 
and remove any obstacles. The Express model must have a doorway clearance of a minimum of 36 inches 
(92 cm). 

5. Make sure the preparations for the system set up are complete. It is essential to have all utilities (HVAC 
and electrical) available at the time of installation. Use trained personnel to assist with the installation in 
each of these areas. Both the T-Jet Blazer EXPRESS and PRO printers must be on a dedicated power line 
that has at least 15 amps. It can be hooked up to 110v or 240v service. It is dual voltage.

6. Agree to perform simple Daily and Weekly Maintenance procedures outlined in the User’s Manual, 
including keeping the Print Head and Capping Station cleaned.
 
 

Room Preparation 
The first step in preparing the workspace is to plan the location of each system component. Make a 
complete list of all equipment and supplies to be accommodated in your garment printing area and define 
the workflow between this equipment. Identify efficient operational techniques.

Environment
The printer will operate best in a clean, dust-free room at a steady temperature between 68° F and 85° F 
(20° C and 29° C) with a relative humidity between 40% and 60% (non-condensing). 

Operation of the printer at a relative humidity below 40% or above or below the recommended 
temperature range will result in poor nozzle print performance and poor print image quality. This may 
result in the User voiding the warranty.

The workspace floor should be easily cleaned and should not generate dust or static electricity. It should 
be noted that decorating the room in neutral gray colors and using pure white (“daylight”) lights would 
aid operators and clients in judging color accuracy. 

Ideally, the Fast T-Jet Blazer printers should not be installed in the same room as other equipment that 
can potentially cause an ink mist or excessive dust. This includes, but is not limited to, the Pretreatment 
used when printing with White ink. If this is unavoidable, the printer should be isolated, either by efficient 
extraction of mist and fumes or by partitioning. Heavy dust and ink mist can cause reliability problems 
with the printer.

It MUST not be placed in an open warehouse that is hot, dry, dusty or has excessive floor vibration. If you 
must place it in an open room that is not environmentally controlled, you can build a temporary enclosure 
out of plastic and building materials. This enclosure must comply with local building codes. 
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Exceeding the environmental specifications can cause the printing of 
substandard images due to misfiring of Print Nozzles and ink prematurely drying on the surface of the 
Print Head. This misuse may void the warranty. 

Exhaust Ventilation Requirements
Exhaust ventilation and air-conditioning of your T-Jet Blazer Series printer is REQUIRED for proper 
machine function. This machine does not produce odors and the ink is non-toxic, however adequate 
ventilation is required for the use of Pretreatment. When curing shirts, chemicals released from the shirt 
are non-toxic but may be eye irritants.

Room Conditions
Temperature: 68 to 85°F (20 to 29°C)
Relative Humidity: 40% to 60% (non-condensing)
Platform (Blazer Express only): strong enough to support equipment weighing up 200 lbs. 
	 Flat and level (allowable variation: 1/8” in. 40-in. run (3 mm in 1000 mm run). Minimize 			
	 vibration from surrounding equipment.
Ambient light level: general office environment (700–1000 lux)
	 Type: white, indirect fluorescent light
Room: at least 5 air changes per hour with a minimum of 20% fresh air coming in through air return is 		
	 recommended (for operator comfort).
Heat Load: 4000 watts
Air Quality: clean and dust free with no heavy air-flow blowing across the machine.
Room Access: 36 inch (92 cm) minimum doorway 

Electrical Requirements
A dedicated circuit for your  printer and PC computer is strongly recommended. This circuit should be 
110V minimum to 240V maximum, 50/60 Hz, 15A load, single phase and ground with a 6.6KW GFCI 
Circuit Breaker.

A separate dedicated circuit should be used for the heat curing machine, such as a heat transfer press or 
small conveyor dryer. Consult the manufacturer of the equipment for circuit specifications.

The AC power must be supplied with an independent GFCI circuit breaker with the circuit ground 
isolated from other equipment. It is recommended the circuit include a breaker that can be “locked out” 
for maintenance purposes. The ground circuit must be a computer grade isolated ground. The power 
should be constant and not susceptible to voltage fluctuations. Fluctuations in line voltage will adversely 
affect the unit performance.

Supplying a voltage to the printer that is outside of this range will likely result in intermittent data and 
print corruption. If line voltages are outside this range, U.S. Screen recommends the use of a buck/boost 
transformer to bring the printer supply voltage within this range. No warranty, express or implied, will be 
honored for equipment operated on voltages beyond the stated range.

For convenience during setup and normal maintenance, have electrical outlets at local voltage located 
near the intended area of operation.
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Main Operator
Both the T-Jet Blazer Express and PRO model printers require one main operator who will be responsible 
for the operation and routine maintenance of the printer. In order to fulfill this job, the candidate chosen 
will need certain skills. The main operator will be crucial to the performance of the printer and should be 
selected accordingly.

All operators of the printer must be 18 years of age or older.

The following skills are recommended for the main operator:

Windows PC experience. This includes a basic understanding of computer graphics programs like •	
CorelDRAW, Adobe Illustrator or Adobe Photoshop
Technical background involving electronics and mechanics•	
Color aptitude•	

 
The following are desirable, but not essential:

Printing experience•	
Color theory experience•	
Formal electronics education •	
 
 

Printer  Specifications 
Method of Printing: Inkjet-to-Garment

Size: 
Blazer Express: 34”W x 20”H x 56”L (87 x 51 x 142 cm) Length includes an additional 6” clearance 
requirement for Print Bed at Index position.
Blazer PRO: 35”W x 46”H x 77”L (89 x 117 x 196 cm) Height with the User Interface attached is 61” at 
maximum point. 

Weight: 
Blazer Express: 200 pounds (91 kg)
Blazer PRO: 400 pounds (182kg)

Inkjet Print Engine: 8 color (4-CMYK 4-White) 180 nozzles per color

Crate dimensions: 
Blazer Express: 42”W x 33”H x 55”L (107 x 84 x 140 cm)
Blazer PRO: 45”W x 58”H x 86”L (115 x 148 x 219 cm) 

Both models ship on their own crate and will not ship via UPS or FedEx. It must be shipped via common 
carrier or truck. NOTE: Additional cartons may be included with the shipment for accessories, inks and 
software.
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Electrical: 110 - 240v AC 60/cycle 4 amps.

Computer Connection: USB 2.0

Additional Machinery:	 Heat press/dryer, powerful PC computer for FastARTIST and FastRIP

Print Resolutions: 2880 x 1440dpi; 1440 x 720dpi; 720 x 720dpi;  360 x 360dpi 

Maximum Printable Surface: 
Blazer Express: 16” x 20” (41 x 51cm)
Blazer PRO:  17” x 45” (43 x 119cm)

Room Conditions: The printer requires a clean, dust-free room at constant temperature between 68° F 
and 85° F (20°C and 29°C), with a relative humidity between 40% to 80% (non-condensing). Operation 
of the printer at humidity below 40% or at above or below the recommended temperature range will result 
in poor Print Nozzle performance and poor image quality.

Noise level of the equipment:  Average 72 dBA; peak 78 dBA.

Equipment transportation and storage range: 40° F to 120°  F (5° C to 55° C).
Unit is mounted on lockable, leveling casters to facilitate location placement. 
 

Miscellaneous Information
 
Shipping and Receiving
U.S. Screen will ship the machines and components via a common ground carrier of their choice unless 
otherwise specified by the Customer. Shipment will be FOB Tempe, Arizona. This means the Customer 
will pay for all freight charges, insurance, special delivery needs (home delivery) and the unloading of the 
machine upon delivery.

Receiving Inspection
Inspect the crates and cartons for any damage. If possible, do this with the delivery carrier’s agent present. 
Photograph any damage and immediately file a claim with the carrier. Carriers cannot be held legally 
responsible for shipping damage unless they are notified within 15 days of delivery.

Shipment Movement
Use appropriate personnel and equipment to move the equipment from the transportation truck to the 
receiving area to the staging area. The Fast T-Jet Blazer Express cannot pass unobstructed through 
doorways or passages of less then 60”(153 cm). Movement through narrower portals will require tilting 
or re-orientation of the printer. Ensure all loose product, materials and accessories are securely packed or 
transported separately. Verify that elevators or other lifting devices will hold the weight of the equipment 
(300 lb./ 136 kg crated). For Re-crating, follow the instructions in Chapter 17 - Product Support.
 
Common carriers are NOT required to unload shipments over 100 lb. (45 kg). You must be prepared to 
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remove your printer from the truck with a forklift. If possible, request a truck with a lift gate so you can 
use a pallet jack to move the equipment securely.

Staging Area
Provide a sheltered area for receipt of the shipment. This area should be close to the intended area of 
operation to facilitate unpacking and preparation of the equipment for set up.

Uncrating
Blazer Express:  The Blazer Express weighs over 200 pounds (91 kg) and requires two or more people to 
remove the unit from the crate. Four lift points with handles are provided for transport. DO NOT lift from 
any other points on the machine or operation may be severely impaired. You may also use an alternate 
lifting system with an overhead crane.

Blazer PRO: The Blazer PRO weighs over 400 pounds (182 kg) and requires at least four people to 
remove the unit from the crate. The printer base has wheels to facilitate transport on a level, hard floor. 
You may also use an alternate lifting system with an overhead crane.

Retain ALL packaging material, crates, cartons, straps, etc., for use should you ever need to transport or 
re-ship the machine.
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Appendix B

Requirements and Notices

Windows Operating System 
Requirements 

Minimum:
PC with a Pentium 4 - 1.8 GHz  and Windows XP, 2000 or Vista Operating System (Windows ME •	
is not supported)

A minimum of 2 GB of RAM.•	

A minimum of 10 GB of free disk space on your hard disk. You will also need at least an additional •	
50 GB for saved files.

A display monitor with high resolution. (1280 x 1024)•	

CD-ROM or DVD drives for installing the software.•	

A dedicated USB port (2.0)•	

The connection of a mouse and Dongle will require additional free USB ports•	

Recommended:
PC with an Intel Dual-Core Processor or AMD Athlon X2 and Windows XP, 2000 or Vista •	
Operating System (Windows ME is not supported)

3 GB of RAM and a dedicated graphics card with 512 MB of onboard memory•	

A minimum of 10 GB of free disk space on your hard disk for program •	
installation and 100 GB for saved files

A display monitor with high resolution (1280 x 1024)•	

CD R/W or DVD R/W drive(s) for installing software and burning back-up copies•	

A dedicated USB port (2.0)•	

The connection of a mouse and Dongle will require additional free USB ports•	

FCC Compliance
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy, and if not installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which 
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can be determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

Reorient or relocate the receiving antenna.•	

Increase the separation between the equipment and receiver.•	

Connect the equipment into an outlet on a circuit different from that to which the receiver is •	
connected.

Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels, which exceed the limits 
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded 
equipment interface cable with this device. If this equipment has more than one interface connector, do 
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the 
manufacturer could void the authority to operate the equipment.

For Canadian Users
This Class B digital apparatus complies with Canadian ICES-003.

 

Declaration of Conformity
According to 47CFR, Part 15 for Class B Personal Computers and Peripherals; and or CPU Boards and 
Power Supplies used with Class B Personal Computers:
We: U.S. Screen Print & Inkjet Technology a division of U.S. Graphic Arts, Inc.
Located at: 1901 East 5th Street Tempe, AZ 85043 Telephone: (480) 929-2937
Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 
of the FCC rules as a Class B digital device. Each product marketed is identical to the representative Unit 
tested and found to be compliant with the standards. Records maintained continue to reflect the equipment 
being produced can be expected to be within the variation accepted, due to quantity production and testing 
on a statistical basis as required by 47CFR 2.909. Operation is subject to the following two conditions: (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation.

Trade Name: U.S. Screen Print & Inkjet Technology

Type of Product: Inkjet Printer

Models: 
T-Jet Blazer Express TJBEX-1620
T-Jet Blazer PRO TJB-1650
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European Union Declaration of Conformity - CE
A sample of this equipment has been tested against the Essential Health and Safety 
Requirements of the Machinery Directive. Based on conformity with the Machinery 
Directive, the Equipment Under Test - Fast T-Jet Blazer Express from U.S. Graphic 
Arts, Inc., dba U.S. Screen Print & Inkjet Technology in Tempe, Arizona USA is 
deemed in compliance with the Machinery Directive (98/37/EC) and the Council 

Directives amending the Machinery Directive (91/368/EEC) and 93/44/EEC). In addition, the Equipment 
Under Test complies with the requirements of the Low Voltage Directive (73/23/EEC) and the 
EMC Directive (89/336/EEC).
 

Limited Warranty
U.S. Screen Print & Inkjet Technology (“U.S. Screen”) warrants the T-Jet Blazer Express and the T-Jet Blazer PRO 
(“Unit”) direct-to-garment inkjet printer to be free from defects in workmanship and materials (warranty does not 
include printing head, dampers, or expendable parts such as fuses) for a period of one year from date of purchase for 
parts and labor provided that the Unit is properly maintained and operated under normal use. This warranty does not 
authorize any On-site repair and is considered to be a “depot” warranty which requires that the Unit or defective part 
be returned freight prepaid to U.S. Screen in Tempe, Arizona USA or to an authorized service center for repair. This 
limited warranty does not include the print head. Replacement print heads are available from U.S. Screen. All prices 
and design specifications subject to change.

The Fast T-Jet Blazer Express and PRO both must be shipped by a freight company. You MUST insure returned 
printer for the full retail value. If you need assistance with finding a freight company, contact U.S. Screen Print 
& Inkjet Technology. We can assist with pickup and delivery of the T-Jet Blazer Express and PRO by a freight 
company to U.S. Screen for diagnosis and/or repair. If the T-Jet is shipped by a non-freight company or is not on a 
pallet, U.S. Screen Print & Inkjet Technology reserves the right to refuse the T-Jet Blazer Express or PRO shipment. 
Examples of non-freight companies are Federal Express, UPS, US Postal Service and Airborne Express. These steps 
eliminate potential for damage in shipping.

Although every effort has been made to provide accurate specifications, U.S. Screen does not assume any liability 
for damages, whether consequential or incidental, that may result from the use or misuse of this product or from 
damage caused by Unit modifications made by the user. U.S. Screen reserves the right to alter specifications in the 
manufacture of its products.

It is understood and agreed that U.S. Screen’s liability in contract, in tort, under any warranty, in negligence, in 
strict liability or otherwise shall not exceed the return of the amount of the purchased price paid by Buyer. Not 
withstanding the foregoing provision, under no circumstances shall U.S. Screen be liable for special, indirect or 
consequential damages (including loss of profit). The price stated for the equipment is a consideration in limiting 
U.S. Screen’s liability. No action regardless of form, arising out of the transactions under this Agreement may 
be brought by Buyer more than one (1) year after the cause of action has occurred. Our warranty, as specified, is 
exclusive and no other warranty, whether written or oral, is expressed or implied. U.S. Screen specifically disclaims 
the implied warranties of merchantability and fitness for a particular purpose. This warranty initiates from date of 
shipment to original customer. It is transferable but will only be honored if proof of purchase is provided and a valid 
serial number is attached to the machine.
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This warranty does not extend to the Print Head, dampers or expendable parts such as fuses. This warranty does not 
cover a Unit that has been subject to misuse, neglect, negligence, accident, or Unit that has been operated in any way 
contrary to the operating procedures specified in this manual. This warranty does not apply to damage resulting from 
improper maintenance, lack of proof of maintenance as outlines in the Owner’s Manual, improper shipping, damage 
caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with 
non- U.S. Screen products, or service other than by a U.S. Screen Authorized Services.

Written authorization must be obtained from U.S. Screen before any Unit or part will be accepted. Replacement 
parts are sent out freight collect. Parts sent out prior to receiving defective part will be sent C.O.D., cost plus freight. 
Upon return of defective part, if it is deemed that the part was not damaged by customer but failed, the cost of the 
replacement part will be 
refunded.

THE GUARANTEE AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER 
EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN 
ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER 
PERSON OR FIRM ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, U.S. SCREEN’S ENTIRE 
LIABILITY SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE PRODUCT COVERED 
BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER 
U.S. SCREEN NOR ITS AGENTS SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, 
INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM 
THE USE OR INABILITY TO USE THIS PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not 
allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions 
may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from 
jurisdiction to jurisdiction.

For this Limited Warranty to take effect you must return the completed Limited 
Warranty Registration Card and mail or fax it to U.S. Screen within 10 days of 
receipt of your printer.

MAIL TO: 	 U.S. Screen Print & Inkjet Technology
		  ATTN: Warranty Department
		  1901 East 5th Street
		  Tempe, Arizona  85281 USA

FAX TO:	 1-480-929-0766
		  ATTN: Warranty Department


